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1 Introduction

Dartfish software provides advanced video tools to enhance your training programs and improve
athletic performance. The system works both during workout and afterward when time allows for a
more in-depth analysis of a performance.

During the workout

Using Dartfish InTheAction*, you will be able to provide instant visual feedback to your athletes.
This feedback will supplement your personal coaching and allow you to maximize the benefits of
using the muscle memory (proprioceptive) of your athletes and students. Thanks to a wide variety
of customizable play modes, the use of video can be fully integrated into your usual activities with
athletes on the field.

After the workout

Dartfish software's set of video analysis features allow you to create new perspectives and
innovative views of your athletes' performances:

» You are able to compare and view performances as never before to highlight areas needing
improvement.

> You can annotate video with text and drawings to aid and communicate analysis

» Dartfish's video management system helps you manage all your training videos with ease and
efficiency.

Share your analysis

You can share your analysis with anyone, anywhere to continue the communication and learning
experience. You can send video clips via e-mail, create enhanced CD/DVDs or even publish
interactive analysis on the Internet.

Make sense of competition footage

Tagging* is Dartfish's notational analysis tool. Use it to create a descriptive index of the key
events in a game or other long video. Tagging has tools to turn your index into a focussed team
feedback presentation and also display frequency statistics of each event. Tags are created by
clicking a set of fully customizable buttons, or by import from your sports own statistical tools, or
even from the Dartfish Note app.

Display data on video

For those working quantitatively, measurements of time, distance and angle can be made on video
and recorded in a Data Table. The Data Table can even record changes in measurement or
changes in position of tracked* objects.

Using the Data Readers*, you can link to data from any device or software that can create a CSV
(character separated value) file and relate the output to what the video shows.

Dartfish is also capable of simultaneously recording video and data using InTheAction*. This
allows data to be displayed or graphed on video immediately after capture. Dartfish has developed
links to several force platforms but also makes its SDK (software developer kit) available to you to
develop your own links.

Use Dartfish special effects for unique analysis opportunities

Stromotion* and Simulcam* are tools used by sports broadcasters world-wide to analyze and
explain movement to their audience. Users of Dartfish can also benefit from these tools.
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Simulcam is the only way to get a realistic comparison of video when the camcorder is panning.
Stromotion and ball tails* give an understanding of how performers and objects move from one
position to another.

! *asterisked features are not available in all Dartfish editions

1.1  Support and help to use your software

This manual provides help to learn the range of Dartfish software features but it isn't the only
source of help available to you.

Start with the video demonstrations on the Start page, which guide you through getting started with
the basic features. Then, increase your understanding by reading these help chapters or using the
more comprehensive video based tutorials available online.

The Dartfish Customer Care Portal

In addition to this help, a wide range of support is available to you and the easiest way to access all
of this is by following the links on the Start Page of your Dartfish software. This is your gateway
to:

» Training Resources: Learn at your own pace with tutorials, comprehensive guides, instructor-
led online seminars or arrange tailored training courses.

» Technical Support: Search the Dartfish knowledge base and find answers to your questions or
contact our experienced team directly.

» Download Section: Get your products, updates, drivers and release notes online.

» Product Information: Get an overview of your previously registered products, retrieve your
license key at any time or register another product.

@ An alternative way to access the Customer Care Portal is to use your browser to take you to
http://support.dartfish.com

Registering your software

Your first step in getting support is to register your software because the possibilities available to
you vary according to the support package supplied. In the case where you have multiple users of
the same software, each user can register and create their own sign-in because the support
package is linked to the software and not to its users.

Note that registering your software is not the same as providing the licence key during installation
or activating it after installation. Registration is the process that identifies you as a user of your
software and it is highly recommended that all users should register in order to benefit from
Dartfish support.

The easiest way to register is via the Help menu of your software Help > Product Registration.
Otherwise the registration code is required. This can be found at the bottom of the product key
used to install the software.

Talk to us

Dartfish has evolved and developed thanks to a continuous dialogue with users, we look forward to
your comments and suggestions to help enhance future versions. Our continuing goal is to make
every software release better to fit the needs of our users.
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2 Getting familiar with Dartfish

Whether you are new to Dartfish or looking to improve your knowledge, this chapter is essential
reading. It covers all the basic information and skills that you will need in order to be able to use
Dartfish effectively.

You will become familiar with:

The Dartfish workspace and the Start Page

Video playback

The basics of the Video Library

Saving projects and videos

Sharing video clips between Dartfish's different modules and with other athletes or coaches.
Remote controlling Dartfish software.

YV VYV VYV

After getting familiar with Dartfish you will be well on your way to using the broad range of analysis,
instructional and video sharing features that comprise this complete Sports coaching tool.

2.1 The Dartfish workspace

Dartfish workspace is designed so you can navigate through the video analysis and sharing
processes easily. Following, is an illustration of the Dartfish workspace.
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1. The Menu bar to access different Dartfish views and functions. Click a menu at the top of the
program window to see the related menu commands.

2. The Toolbar buttons control what appears on the workspace such as the library and each
module (e.g. Analyzer)

3. The Library allows you to manage, locate and share video clips and Dartfish projects. The
library includes:

» Folder View and Keyword View (on the left) to locate the files.
» Items List (on the right) which lists the located files.
» Tray (at the bottom) is a working area for storing video clips that you want to work with.
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4. The module window is to carry out your tasks such as video capture, replay, comparison and
drawings.

! Context menus are also available throughout the program. Place the mouse pointer in the pane
in which you want to work. Press the right mouse button, and select a command from the menu.

Displaying Dartfish Modules

Dartfish is composed of modules - each with individual functions for analysis, instruction, sharing
etc. A module is displayed in two ways:

1. by clicking the appropriate Toolbar button.
2. by selecting the module from the Tools menu in the Menu bar

You do not need to close a module to open a new one - clicking on a module button automatically
replaces the old one with your selection. Only the Library can be simultaneously displayed next to
another module.

The core modules are listed below. Other modules may be available based on the Dartfish
software edition you purchased. Read the relevant help chapters to learn how to use them.

i;g Importer | = . . . . . .
Importer - import video files from a range of video devices and drives.

Eja, Player

Player - playback and trimming of video clips

-
;ﬁ Analyzer

Analyzer - comparison of clips, drawing tools, key position analysis and publishing.

The Library

The Library allows you to locate, load, manage and share video clips. It is displayed and hidden
using the Library button on Dartfish's toolbar.

Library

@ Fs keyboard shortcut - closes/opens the library; it has the same function as clicking the library
button.

The library module is shown below with its four main parts labeled:
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1. The Library Toolbar contains buttons used to control the appearance and content of the Items
List.

2. The Keywords View is used to locate video clips matching categories and values selected
(see link). When this area displays its Folders View, the content of selected windows folders
will be displayed in the Items List.

3. The ltems List is a list of video, image and project files that can be used by Dartfish.

4. The Tray gives you immediate access to recently imported or used video clips. It is also used to
share video clips between Dartfish modules and also share by email, CD ROM and Internet.

2.1.3 Resizing panels

The windows can be resized both vertically or horizontally as follows:

1. Place your cursor over the boundary between two panels.

2. Once the cursor shape changes to a double-headed arrow, click and hold down the left button
of your mouse. Then you can move the cursor until the window is at your desired size.

! When you close the software, the new layout is saved.
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2.1.4 Repositioning panels

To make most efficient use of the screen, panels can be relocated to different positions around the
workspace.

Unlocking/locking the workspace
Before panels can be repositioned, the workspace must be unlocked:

1. Select Window menu > Lock Workspace

2. After repositioning panels, repeat (1) to relock the workspace to prevent accidental changes to
the layout

Docking panels around the workspace

When the workspace is unlocked, the title bar of each panel is visible. Panels are moved by
dragging the title bar with the mouse:

1. Unlock the workspace

2. Click and drag the title bar of the panel to be repositioned

3. While still dragging the panel, move the mouse to one of the position guides found in the middle
of the top, bottom, left or right of the workspace (alternatively similar guides are found in the
center of the workspace.

[E]

4. When the mouse is correctly positioned, orange shading will highlight the final position of the
panel

-
[ e

PR T [ T SR S [ e SR

5. Release the mouse
6. Lock the workspace

Floating panels

Panels can also be left floating above the workspace. To do this, proceed as for docking the panel
around the workspace but release the mouse at any position on the workspace outside a position
guide.
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Docking panels with other panels

Modules such as Tagging comprise of multiple panels. These can be docked together

1. Unlock the workspace

2. Click and drag the title bar of the panel to be repositioned

3. While still dragging the panel, move the mouse over another panel. A position guide appears.

Table -l x
7 Edit
Action vs. Team i
‘ Team4 Tﬂrand Total ‘
Aerial Challanna Lnct | 12| 77 i 22 |

Aerial cha Keywords | X
Search keywords '/- %

4 i A
She Action 158

Tackle Won 40
She Aerial Challenge Lost 32
Tackle Lost 32
Aerial challenge won 30

1 v
Frunil 14

4. Position the mouse over one part of the position guide, orange shading will highlight the final
position of the panel

5. When the mouse is correctly positioned, orange shading will highlight the final position of the
panel

Release the mouse
Lock the workspace

N o

Resetting the workspace
To return each panel to its original position in the workspace:
1.Select Window menu > Reset Workspace

2.2 Video playback

The ability to control playback (play, pause, play frame-by-frame, modifying playback speed, etc.)
is one of the simplest benefits of using video analysis software.

2.2.1 Opening & closing clips

Open a single video

> Double clicking the corresponding file name in the Items List of the Library OR
» Drag & drop your chosen clip onto the video display

To open multiple clips:
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1. Select the clips (usual Windows selection methods apply)

2. Drag & Drop the selection into the Tray (Player, InTheAction, Tagging) or the Storyboard
(Analyzer)

Clip selection

Once open, clips in the Tray or Storyboard can be selected by a double click or by clicking the
Next Clip or Previous Clip buttons on the Player control:

Alternative clip selection methods

» Keyboard commands: CTRL+N and CTRL+P
» Remote control

Closing clips
Clips aren't really closed, instead they are removed from the Tray or project.
To remove a clip from the Tray:

» Click the Clear button on the Tray's toolbar
» Tap the DELETE key
» Right-click the clip and select Remove from Tray from the quick menu

To remove a clip from a Storyboard:

» Right-click the clip and select Delete from the quick menu
» Drag another clip onto the video display (replaces the current clip)
» From the menus select File > New (begins a new project with empty Storyboard)

2.2.2 Video panel controls

All the different modules have some control over how video is played. The video panel controls for
the Player module are shown below. Most modules will have some of these features although not
all controls will always be available according to that module's specific needs. Some buttons have
an alternative function activated using the right mouse click

Alternative function (right-click

Feature Description or CTRL-+click)

Play/Pause Play becomes a pause button
when the video is playing
(keyboard shortcut: SPACE)

Stop The quickest way to return to the
start of the clip (SHIFT+S)

Play speed Each click cycles through the slow- Returns to '1' full speed
motion speed possibilities
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1!’{1'
Fast Each click cycles through the fast  Returns to the previous play
backward/ forward/backward speeds speed
forward
Frame Plays the video one frame at a time Moves the video by the Jump
backward/ (CTRL+ LEFT, CTRL+RIGHT) Length defined in the Dartfish
forward Options (default 10 frames)

Previous/Next Move to the next or previous clip in

clip the Tray/Storyboard/Events list
depending on the current context
(CTRL+P, CTRL+N)

Cue In/Out Set the start point and end point of Reset Cue In/Out to the
the video. Used to prevent replay of beginning/end of the clip
unwanted footage at the beginning
or end of the clip

Replay Controls whether the current clip
options plays, then stops at the end or one
of these alternatives:

- Loop play current clip

- Play playlist of Tray/Storyboard/
Events List

- Loop play playlist

Snapshot Saves an image of the current Saves an image of the current
frame to the clipboard frame as a file

Full Screen Displays video full-screen (F11) Select a secondary monitor on
which to display the full-screen
view

B [J [EE €S FAIS EAE K20 K20

Slow motion
Control over slow motion replay is given in the following ways:
» By using the Speed control
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-
etc

» By using the frame backward/forward buttons

» By using the jog wheel

Gentle dragging of the jog wheel gives fine control over movement

Fast seek
Rapid movement through a video is given in the following ways:

» Using the Fast backward/forward buttons

On arrival at the desired position, right-click (or CTRL + CLICK) these buttons or the Pause
button to return to the previous replay speed

» By using the Jog Wheel

Rapid dragging of the jog wheel scrolls quickly through a video
» By dragging the Playhead

Legacy controls

The controls described above arrived with Dartfish 9. These have not been implemented in all
modules and are most notably absent from the Analyzer and InTheAction. In these modules you'll
find set of controls which are broadly similar:

b = <|l|> H (M

Fast forward and slow motion are integrated into a speed control, shown below. Clicking a number
will set the speed cursor accordingly (e.g. 0.5). You can also click and drag the cursor to select a
precise speed (e.g. 0.35 as illustrated above).
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If preferred, you may use the legacy controls throughout Dartfish by selecting this option from the
menus Tools > Options > General then select Legacy from the Video control section.

Displaying and hiding buttons

1. From the menus, select Tools > Options > General then click the Customize link in the Video
control section.

2. Choose the buttons which you want on your play control:

Customize Video Control Bar *

[|Rewind/Fast forward
Previous Frame/MextFrame
[«]Set Cue In/Set Cue Out
[]Previous Clip/Next Clip
[«]Playback Made

[+]Snap Shot

[«]Mute Audio

[]Full Screen

2.2.3 Trimming video clips

Trimming video clips, that is setting new cue in/out points, is often necessary. Perhaps because
unnecessary footage has been captured at the start or end of the clip. Perhaps because you can
analyze or coach more effectively if the clip is shortened to show only specific actions.

Setting cue in/out points

1. Position the Playhead at the point where the video is to start playing
2. Click the Set Cue In button

3. Position the Playhead at the point where the video is to stop playing
4. Click the Set Cue Out button

5. The trimmed section is now highlighted with yellow shading on the timeline. This is the part of
the video which will play.
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Alternative method

Position the Playhead at the point where the video is to start playing
SHIFT + CLICK the Playhead
Position the Playhead at the point where the video is to stop playing
CTRL + CLICK the Playhead

P wDNh PR

Reset cue in/out
Right click the Cue in and Cue Out buttons

Saving the trimmed video
Once the new in and out points are set Dartfish will use them each time the video is opened.

You also have the choice of saving the trimmed video clip as a new file (see Saving a new video to
learn how to do this).

Setting cue in/out points using legacy controls

Certain modules, notably the Analyzer, continue to use the legacy controls (see Video Panel
Contrals). Here, the buttons to set Cue In/Out are found on the let side of the Timeline (see below)

and the Cue In and Out points are represented on the Timeline by cue in/out markers ( B/ K ).

| . - an . " N

In addition to using the buttons, Cue In/Out markers can be dragged into position.

Reset cue in/out points using legacy controls

1. Right-click on either the cue in/out markers or the Playhead.
2. Select Reset In/Out Points from the quick menu

-
| Set Reference

Bl setin
pom | M etou

Reset InfOut Painks

2.3  Saving projects and videos

When working with many Dartfish modules you will have the choice of saving a project or saving
the video file resulting from the project.

Saving a project

When you save a project you are saving all the information that relates to the creation of that
project; the video files used, the settings chosen etc. Generally you will save projects if you wish to
make changes to the project to get a better result or because you wish to base a new project on
the settings used previously.
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!itis important to note that projects do not actually include the video files used by the project. For
example, saving a project using two 5Mb video clips will not end up in a project file somewhere
over 10Mb. It also means that if sharing projects with other Dartfish users, you will also need to
give them the video files used by that project.

Saving a video clip

When you save a video clip you are creating a new video file that can be used by other Dartfish
modules or shared with others - even those who do not have the Dartfish software will be able to
play back video clips on their own computers.

2.3.1 Saving a project

Select File > Save (or File > Save As...) from the Menu bar to save a project. The type of project
(and project file icon) depends on the module currently in use when saving:

E - Analyzer project

ﬁ - SimulCam project

E - StroMotion project

Vifa project is saved in a Monitored folder of your Library (see section Defining your library in the
Library chapter), it will be displayed in the Items List.

Vs you did not save a project when changing modules, you will be prompted to do so. Select Yes
to save a project.

Save ﬂ

You have made changes to your project.
Do you want to save your changes?

Yes Mo Cancel

To open a saved project

¢ Double-click on the project icon in the Items List
¢ Select File > Open from the Menu Bar.

To start a new project

Select File > New from the Menu Bar. If you did not save the current project, you will be prompted
to do so (see above). Starting a new project will also clear the Storyboard of the Analyzer.
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2.3.2 Saving a new video

Select File>Save Movie... from the Menu bar to save a new video. A wizard will guide you through
the saving steps. Different wizards are shown based on the module currently opened.

Video Trimming Wizard

The Video Trimming Wizard will launch when the Player module is open. Complete the wizard to
save a trimmed version of the clip currently loaded in the Player (see Trimming video clips to learn
how to set the cue in/out values). This simple wizard only offers the opportunity to choose where
the trimmed clip will be saved and not to rename it or convert it.

Video Saving Wizard

The Video Saving Wizard will launch when the Analyzer module is open. Complete the wizard to
save a montage of the analysis contained in the Storyboard (read the chapter on the Analyzer).
The main steps of the wizard are:

1. Selecting the video settings (see Converting video)

2. Entering the file information, i.e. a file name and the category/values to classify the new video
(see Organizing your library to learn more about the file name and categories)

3. Selecting the destination folder

2.4  Sharing video files

Dartfish offers many ways of sharing videos with athletes or other coaches. The Video Sharing
Wizard guides you through the process of selecting and compressing video before exporting it to
the appropriate media. The choices of sharing destination are:

» Dartfish.tv - Dartfish's online analysis sharing website. You can upload to your organization's
channel if you have been given upload rights or to your own myDartfish Cloud.
» My Computer - copy your video to a folder, to an external drive or to a network server.

» Email - the video clip is compressed and attached to an email in your default email program
(see note below).

» Recordable CD or DVD - burn video to CD or data DVD directly from Dartfish.

» Enhanced Recordable CD or DVD - creates a CD with an easy-to-use interface customized
with your branding and contact information.

> Internet - send video to a FTP location.

! The share by email option works for any MAPI email software such as MS Outlook or Outlook
Express. For other email software or web-based email like Hotmail you will have to attach video
files through the software or website itself.

2.4.1 Video Sharing Wizard

Loading clips for sharing

The Video Sharing Wizard is a feature of the Tray. Start by loading the video clips you wish to
share into the Tray. To do this, drag-and-drop video files from the Items List to the Tray. Hold
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down the [Ctrl] key while clicking on the files to select multiple files.

L= rayar
| Soccer
O Swimming W

Tray = » Clear &Share

Golf swing side PAL Golf swing front PAL

Once video clips are loaded, click the tray's Share button.

The Video Sharing Wizard

The process of sharing is guided by the Video Sharing Wizard. Three steps are common to all

sharing destinations.
1. Select the sharing Destination - Click on a destination then on the Next> button (at the bottom

of the window) to proceed.

Share Video
Destination s
How do you want to share your video? ’

Dartfish tv
v Publish video clips to dartfish tv

. k My Computer
’ Copy your video to your computer or network server.

E-mail
Send video as email attachment using your default email program.

m

FTP
Upload video to a FTP server.

< Back Next >

Select which videos you wish to share. "Check" those to be shared as shown below or click the
Select All button:

ol

Iniaki_030S(... new clip(2)(1) Iniaki Iron 7

-version9- DARTFISH=S
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3. Choose the video settings (encoding profile) appropriate for the selected destination (see Video
settings for information on the different encoding profiles).

Specific additional information may be entered according to the selected destination. Read the
information displayed in the wizard to complete these information (also see the Outputs from
Dartfish - Publishing & Sharing chapter).

2.4.2 Converting video

When sharing or storing video, there are two important considerations:

1. File Size: video file sizes can be very large which can be a problem when storage space or the
distribution method have limited capacity.

2. Video streaming: unless video files will be played from a local drive there are likely to be limits
on the rate at which data can be streamed. The amount of video data streamed per second is
expressed as its bit rate. Most obviously, video played from the internet needs to have a lower
bit rate than that produced by a typical video camcorder. Networks and optical drives also
impose limits on the maximum bit rate of video which can be played from them.

These considerations are addressed by compressing video by means of encoding and any Dartfish
process which results in the creation of new video offers a range of suitable encoding profiles.

About video encoding

The subject of video encoding is a difficult one involving many variables but to enable the best
choice for encoding video with Dartfish it is useful to have a basic understanding of the following:

Image quality: Compression results in a loss of image quality — for any video format, the
greater the compression the lower the image quality. Direct comparison between formats
based purely on bit-rate is difficult because more recent codecs such as Windows Media 9 and
H.264 achieve greater compression (smaller file size and a lower bit rate) for the same
perceived image quality as older codecs such as MPEG-2 and AVI (DV).

HD versus SD: High definition (HD) video images appear sharper than standard definition (SD)
because they have higher resolution (more pixels). When Dartfish encodes video it almost always
retains the resolution of the source video; so when an encoding profile name refers to HD or SD
this is a reflection of the resulting bit-rate and perceived image quality and does not indicate a
change in resolution.

Intended use: This, more than any other factor, will influence the encoding profile chosen. For
Dartfish analysis one of the Windows Media profiles is generally the best choice but if the video is
being created for playback on an iPhone or upload to Dartfish.tv, one of those specific profiles
might be used. If video is being created for use on the internet your web master may have a
preferred video format.

Encoding versus re-encoding: Dartfish processes such as Save Movie (Player), Convert, Share
and Publish Events (tagging) re-encode the source video using the selected profile. Changing the
video format can result in a loss of quality, although this won't be noticeable unless repeated. This
is not an issue for Dartfish processes which create new video; Save Movie (Analyzer),
Simulcam/Stromotion, Analysis recorder.

Dartfish encoding profiles

A complete list of Dartfish encoding profiles, their bit rates and suggested use can be found in the
Options (Tools menu > Options > Encoding Profiles). The different formats available are
summarized below

Format Intended use

Windows Media \Windows media encoding offers a good quality to compression ratio
and is the preferred option for producing video from Dartfish when the
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output will be played on a computer's media player or in Dartfish.

\Windows media video can also be used for internet but your website
administrator may prefer another format.

Windows Media for
Analysis Recorder

Highly compressed and reduced frame rate WMV used by the
Dartfish Analysis Recorder to encode video (Pro and TeamPro
editions)

MPEG-2

IMPEG-2 video is produced by many camcorders and is also the
encoding used for DVDs.

These profiles will be the preferred encoding for users who wish to
maintain a library of MPEG-2 video or who produce DVDs.

To carry out analysis tasks Dartfish needs to create an index for each
IMPEG-2 file. Encoding by Dartfish creates the index but if the file is
moved or shared with other Dartfish users the index needs to
recreated, which delays access to the file. This may be a reason for
some users to avoid MPEG-2.

MPEG-4 (H.264)

The MPEG-4 encoding profiles are used to produce H.264 encoded
video for playback on mobile devices and YouTube.

AVI (DV)

AVI (DV) is the video format created from camcorders using DV tape.
AVI (DV) is an old format which is less compressed than WMV or
IMPEG and this encoding will be primarily used by tape camcorder
users who wish to maintain a library of DV video.

Dartfish.tv encoding
profiles

Contributors to Dartfish.tv can download the encoding profiles used to
produce video for their channel. Use of these profiles offers the
possibility to create video which is already encoded, thereby speeding
up the publication process.

These profiles can be exported/imported to distribute within an
organization.

SWF (Flash)

Flash encoding is only used by Dartfish to create video for Analyzer
|Mediabooks.

Video Settings in the Sharing Wizard

The Video Sharing Wizard includes a Video Settings step in which you can choose to share the
original video, or re-encode it.

Share Video
Video Settings
Select an encoding profie. The selected setting determines the gualty and file size of the new video. @
Keep the original size and quality of the videos:
@ Convert the videos
Windows Media HD ' Edit profiles
Windows Media profile recornmmended for users wishing to retain the quality of typical HD (high
definition) video. Resolution, frame rate and interlacing of the source video is retained.
Size before conversion: 14.2 VB
Estimated size after conversion:  10.0 MB (70 %)
< Back | Mext = Cancel |
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Video Conversion Wizard

Existing Video files on your hard drive can be converted to a range of other video formats with the
Video Conversion Wizard. The process is as follows:

1. Select files from the Items List or from the Tray. Multiple files can be selected by holding down
the ctrl key and clicking each file.

2. Point at one of the selected files and click the right hand mouse button

3. Select Convert from the context menu that appears.

The subsequent process of choosing file format and location is the same as that for saving new

movies but you are reminded to pay special attention to whether you want to replace the existing
file or create a new file with a different name.

Conflicting file options

If & file with the game name already exizts in the destination folder;

Rename the converted file “

Rename the corverted file |
Dwenwite the original file

2.5 Remote controlling Dartfish

Many of Dartfish's buttons and controls can be activated by remote control. This powerful option
allows you to record or present without the restriction of having to stand next to the the computer.
There are three types of remote control:

Jumi wifi remote

Jumi is an app for iOS which allows the creation of custom remote controls which function on a
WiFi network. Its range is therefore only limited by network access but it requires the presence of a
WiFi network which allows the communication between the app and the computer.

Streamzap remote and IR receiver

The Streamzap shipped with Pro and Live editions of Dartfish prior to Dartfish 6. If you have one it
may still be used with more recent versions. It uses its own Infrared receiver and has a range of
around 25 meters.

Windows Media Centre remotes

Any remote control device supporting Windows Media Centre commands can be used to remote
control Dartfish. Buttons on these devices can be configured to better meet the needs of a Dartfish
user.

More on this

> Jumi remote control
> Streamzap remote control
» Windows Media Centre remote control
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2.5.1 Jumi remote control

Jumi is a remote control app for mobile devices for which Dartfish have created a customized
remote control. It communicates using WiFi

PC Installation

1. From the menu bar choose Help > Technical Support (if you have not yet registered on our
Customer Care site, choose Help > Product Registration first)

2. Select the Downloads page

3. Run InstallJumi.exe and follow the on-screen instruction to install the controller software (Jumi
Controller’s icon should appear in the Windows system tray)

4. The first time Jumi Controller runs, you are required to supply a master password: any
password can be entered — the same password will later be used to connect your iPhone to
your PC.

5. Click Save to finalize the controller configuration.

6. Run Dartfish6_Remote.zip.JumiTAP.jumi. A ‘file imported successfully’ message should appear
confirming that Jumi is now customized for Dartfish.

Installation on mobile devices

1. Download jumiremotes from the App Store or Google Play

2. Make sure your computer and your mobile device are connected to the same wireless network
3. Launch the Jumi remotes app, you should see your PC listed
4

. If your PC is not found automatically, tap Add then enter the same IP addresses and port
number that are displayed by the Jumi Controller on your PC

5. Enter the master password you created previously, and select Login or Login & Save if you
want to save the password for future logins
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Using the Jumi Remote control

The Jumi remote controls many of the functions in different Dartfish modules. We recommend that
you start by becoming familiar with the buttons that control replay and learn the rest as you find you
need them. The icon on each button matches those found in Dartfish.

Troubleshooting the Jumi Remote control

An installation and troubleshooting guide can be downloaded from the Dartfish Customer care site.

Streamzap remote control

The Streamzap remote control is no longer provided by Dartfish but if you have one, it can still be
used with the latest versions. It communicates with Dartfish via an Infrared receiver provided with
the control.

This device will not function without the installation of drivers. Be careful to install the correct
drivers depending on whether your computer is running Windows 32-bit or 64-bit.

To install the remote control drivers on 32-bit Windows:

1. From the menu bar choose Help > Technical Support (if you have not yet registered on our
Customer Care site, choose Help > Product Registration first)

2. Select the Downloads page

3. Find RemoteControl_32bit.exe in the list of downloads for your product and click the
Download button

4. Double click the downloaded file to run the installation program
5. Connect the receiver

When the receiver is connected for first time Windows will detect it and install the drivers for
that USB port. Depending on your Windows setup this is a two step process:

In the first step, Windows asks whether you want to go online to search for drivers. The answer
to this is No, not this time.

In the second step you are asked if you want to install manually or automatically. The answer is
Automatic [Recommended].

6. Windows should successfully install drivers software for the infra red receiver.

To install the remote control drivers on 64-bit Windows:

1. From the menu bar choose Help > Technical Support (if you have not yet registered on our
Customer Care site, choose Help > Product Registration first)

2. Select the Downloads page

3. Find RemoteControl_64bit.zip in the list of downloads for your product and click the
Download button

4. Right-click the downloaded file and choose the Extract All option from the menu
5. Now, complete steps 1-4 to install the 32-bit Windows driver but DO NOT CONNECT THE
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8.

9.

RECIEVER
Now plug in your USB infrared reciever.

Open Windows Device manager and choose Hardware and Sound > Devices and Printers >
Unspecified, you will find Streamzap Remote Control.

Right-click the option and choose Properties then select the Hardware tab. Click Properties
and click Change Settings.

Select Update Driver, then select Browse my computer for driver software.

10.Browse your computer for the files you extracted in step 4.
11.Select the folder x64 and click the Next button
12.Click the Install button

Trouble shooting installation

Look for the Dartfish Remote icon in the system tray area of the Windows taskbar:

If it is red: B The remote control is installed and functional. Ensure that the receiver is pointed
towards the remote control, batteries are fresh, the receiver is within range and there aren't
other sources of infra red interference - the flashing red light on the receiver confirms when an
IR signal is received but not whether it is strong enough or from which source.

If it is grey: M The remote control software is installed but the IR receiver is not connected. If it
is connected to a USB port the likelihood is that drivers are not installed for that USB port
correctly. Try removing the receiver and connecting it to a different USB port.

If it is not present: In a small number of cases the Streamzap software does not automatically
start after installation. In this case you can force it to start by restarting the computer or
manually activating its executable file at /program files/Streamzap/Remote/zremote.exe.

Using the Streamzap

The Streamzap remote controls many of the functions in different Dartfish modules. We
recommend that you become familiar with these buttons and how they can help you coach more
effectively. If this looks like too much to remember how about starting with the group of six buttons
under Play and Pause. You can learn the rest as you find you need them.
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2.5.3

Full Screen Switch View
Set as reference Feed Switch
Togagle Grid Toggle Delay

Togqgle Mirror
Increase Speed Reference Replay
Decrease Speed

Simple Replay -
Start Capture

Blank Live
Comparison
Set Synch Points Keep
: Stop
Play S
? Pause

Step Backward
Step Forward
Play Previous

Start Capture
Play Mext

Picture-in-picture
Basic Blend

Single Mode
Split Mode

@ Now that you can use Dartfish remotely you should be able to display video in full screen. Type
[F11] or look for the Full Screen button at the top of the remote.

Windows Media Centre remote control

Many manufacturers produce remote controls, keyboards and other devices designed to control
the media applications in Windows. You can use these to remote control Dartfish.

Installation and use

Install the device receiver according to the manufacturer's instructions. Usually this will be a simple
case of 'plug-and-play'

Customization

Because your device is not specifically intended for Dartfish, it may lack buttons for functions which
you require. Dartfish can be configured to reassign commands sent from the remote to alternative
functions in the software. For example, you may wish to reassign a remote control button to trigger
recording. To do this:

1. Click Tools menu > Customize...
2. Select the Remote control tab
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Customize

Commands Toolbars Keyboard Menu Remote Control Qptions
Remote Controls:
StreamZap™ Stream Zap™
@@ Mulimedia Com... Multimedia Commands

] k Sound Trigger Sound Trigger

3. Select the command to be assigned to a remote control button.
You may first select a category to make the search for a command easier. For example, the
Start Capture command is found in the Control category:

Command Mapping:
Categary:
Control w

Commands: Current Keys:

Set SynchPoint for all clips ~ Assign
Set SynchPoint for current clip -
Simple Replay

Single mode :
Split mode Last key received:

L |LQPPCOMMAND_LAUNCH_APP2
Start Capture with SynchPoint autom

Step Backward

Step Forward w

Remove

Reset All

Description:
fStart Capture

4. Press a button on the remote control.

5. Confirm that a valid command has been received by checking that a corresponding entry
appears in the Last key received field

6. Click the Assign button

2.6 The next steps

In this chapter, you learned the basics of Dartfish software.

Your next step is to learn how to get video from your digital camera onto your computer so that you
can experiment with your own video straight away. Read the Capturing Video chapter.

You can learn more about how Dartfish can help you find relevant video files with the Organizing
your library chapter. It will explain in detail the advantages of using categories to classify and find
your video clips.
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3 Video Library

The Video Library is a complete set of features used to locate and manage the files you wish to
analyze or share:

>

>

The video library is "built" from the Windows folders containing those files that are relevant for
use with Dartfish.

Because you are likely to analyze many video files, Dartfish helps you locate relevant content
using a flexible video content management system called Keywords which allow you to
describe the content of video clips more comprehensively than relying on organizing video into
different Windows folders.

Dartfish uses a Library module which offers rapid access to your content as well as a variety
of tools to help you locate relevant video files.

The Library module has a powerful sharing feature called the Tray. It provides a workspace
containing files which are being worked with. This not only makes them readily accessible for
use in Dartfish but also allows you to share content by a variety of media including email,
Internet and CD ROM.

In this chapter you will learn how to:

>

YV V V VYV

Define your library. Learn how to include the content you wish to see in the Dartfish Library.
Organize your library using Dartfish's Keywords.

Locate video files using Dartfish's array of search tools.

Create Playlists from the contents of the library.

Share video files by email, CD/DVD or Internet.

Convert video clips

Correct video errors such as incorrect interlacing, aspect ratio or orientation.

3.1  Defining your library

The library is the collection of ALL the video files that you want to use with Dartfish. These files
can be stored on several folders on your hard drive.

To define the library you must tell Dartfish which folders to monitor. Only the video clips found in
these folders will show in the Library module. The default monitored folder is the windows 'Videos'
folder

To add the contents of a folder to the library

1.
2.

From the menu bar, select Tools > Options (or keyboard F3)
Click on the Library option
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[ “ Options n
£l & T o &£ # ® [E B

General | Library | Encoding Profiles Analysis InTheAction SimulCam  StroMotion Metwork Cameras  Add-ins  Advanced

vy Add or remave folders monitored by the Dartfish lbeary, The lbeary shows media content of these folders when they are

,.4" accessible,
Library locations: Add...
| C:\sers\ed\Mideos\captured video [ Remove

I

Sub folders are automatically monitored, For best performance, minimize the number of folders monitored, avoid using root folders or
shared folders on a netwark.

Clear Source Cache | The source cache manages metadata about media files as well as thumbnail images for quick access.

3. Click on the Add... button. A browser window will open.

4. Choose a folder and click on OK. The sub folders of this folder will also be included in the
library.

5. Repeat steps 3 and 4 to add additional folders.
6. To remove a folder from the list, click the folder in the list and click on the Remove button.

3.2 The Library workspace

The Library module is your route to accessing the content of the library. It is displayed and hidden
using the Library button on Dartfish's toolbar.

= Library

The library module is shown below with its four main parts labeled:
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0 Back &3 ‘ Keywords L Folders v 1

O~ X 7 b Show All | golf : x |
Abl'lty level Mame Size

Athlete 2] Putt Strike 3

Camera angle
DCT tasks
Season 2
Skill /
Sport

Basketball

Canoe

Golf

Hand touches

. ]

Kayak

Soccer

Oo00dwRon

Swirnming v < >

Tray v < Clear :&Share =

H

Golf swing side PAL Golf swing front PAL

1. The Library Toolbar contains buttons used to control the appearance and content of the Iltems
List.

2. The Keywords view is used to filter the Items List for video clips matching categories and
keywords selected. When this area displays its Folders view, the content of selected windows
folders will be displayed in the Items List.

3. The ltems List is a list of video, image and project files that can be used by Dartfish.

4. The Tray contains thumbnails of recently created or opened videos. Think of it as giving you
quick access to the files you are currently using.

3.2.1 The Library Toolbar

The function of the Library Toolbar's buttons is to help you locate the items you wish to use from
the Items List. These buttons have the following functions:

» Keywords button - to display a list of categories and values by which the Items List can be
filtered. To learn more about doing this see the topic Locating video files.

Keywords ‘

» Folders button - this displays a list of Windows folders. The Items List will show the contents
of the folder selected from this list
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L__ Folders

> View Type button - to control how items are represented in the Items List. Items can be
displayed in a simple list or showing details such as file size and category/values used. The
thumbnail views show an image of the first frame of video.

E‘ lcons

List
Details

Thumbnail Details

Thumbnails

» Back/forward navigation buttons - As different categories and folders are selected from the
Folders view or Categories view the Back and forward buttons become available to navigate
between them.

o Back 0

The Items List

The Items List is a list of items that Dartfish is able to use. This includes video clips, images and
Dartfish projects, each represented by its own icon examples of which are shown below:

> @l - Video clips (exact image will vary according to default video application on your system)

> [ - Picture files (exact image will vary according to default picture viewing application on your
system)

> |- Analyzer projects

> - SimulCam projects
> - StroMotion projects

File management using the Items List

File management functions such as file renaming, deletion and copying can be carried out from the
Items List. Display the range of options as follows:

1. Point the mouse at the item(s) you wish to edit.
2. Click the right mouse button. A context based "Quick menu" appears.
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Open
Add to Tray

Copy

Rename

Mave ko Recydle Bin
Link, Tkems

Open Containing Folder
Refresh Thurmbnail

Select all
Canvert

Properties

3. Left click the function you wish to use.

@ The use of the Convert function is explained in the topic Converting video clips.

Opening video clips
There are three methods of opening a video file from the Items List:

1. Point at the item and double click the mouse.

2. Drag and drop the item from the Items List on to the video display. This method offers more
flexibility when there is more than one video display to choose from.

3. Drag and drop the item onto the Tray section of the Library module. From here it can be added
to the video display as needed.

Opening Projects

Projects must be opened using the relevant Dartfish module. Either the appropriate module is
opened first or, if a project item is double clicked (method 1 above), the appropriate module will
start, closing the current module if necessary.

Opening Images

Image files can be opened by double clicking them however they will not be opened into Dartfish,
instead the default image viewing software on your computer will be used.

3.2.3 Item Properties

Further information about items can be revealed by using the Details view or the properties
window.

Details View

Details view is selected by clicking the View Type button on the Library Toolbar. The details view
reveals additional file and categorization information about each item as shown below.

Marne Size Type Created Club
(23] Tniaki Iron 7 6,39 Mo Clip vwidéo 18.04.2005,,, Drive
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@ These details can be exported as a CSV file see the topic Exporting keyword data.

The Properties window
To display an item's properties:

1. Point the mouse at the item.
2. Click the right mouse button. A context based "Quick menu" appears.

Open
Add to Tray

Copy

Rename

Mave ko Recydle Bin
Link, Tkems

Open Containing Folder
Refresh Thurmbnail

Select all
Canvert

Properties

3. Select the Properties... option. The properties window appears for the selected item as shown
below.

Gereral | Categaries
Mame: Goll 4
Type:
Locatione C\DartfishiWideo\Gok 4,09
See 543MB
] Read-onky
(_Open Contring Fokde |
Tithe | Gioll 4
Comment: | Byriker shol showing comect use of .

Although much of the properties information is similar to that displayed in Details view, there are
two useful pieces of additional information:

1. File location - the folder on your hard drive where this file is located. The Open Containing
Folder button allows you to open this location to see other content of this folder.

2. Comment - comments can be edited in the properties window and can be used to provide
additional information about the file. This is particularly useful if you intend to share the file (see
Sharing video files) as your comments will be included with the video (depending of media
chosen).

The Properties window - source info tab
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The properties window also shows information about the video source. Some of these properties
can be modified to correct errors in the video. See Correcting video property errors

3.2.4 The Tray

The Tray is a working area for the collection of video files currently being used. It allows you rapid
access to files you want to analyze and provides a method for taking files from one module to

another.
| |\.ﬂ}‘ﬂn.
[l Soccer
] Swirmming .
Tray = > Clear :& Share = |

Golf swing side PAL Golf swing front PAL

Additionally, organizing items into the Tray is the first step for sharing video files (see Sharing
video files).

Adding clips to the Tray
Items will appear in the Tray when:

» Video clips are opened from the Items List.
» New clips are captured from a video camera.
» Video clips are added by drag & drop from the Items List.

Clearing the Tray

Selected items are removed from the Tray by clicking the Clear button.
> Clear

If no files are selected the entire content of the Tray is cleared.

File management using the Tray

The items appearing in the Tray are a representation of the original file so unsurprisingly, the file
management functions available to items in the Items List (see The Items List) are also available
to items in the Tray.

1. Point the mouse at the item(s) you wish to edit.
2. Click the right mouse button. A context based "Quick menu" appears.
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Open
Rermave From Tray

Copy

Rename

Maove ko Recydle Bin
Zipen Containing Folder
Refresh Thurmbnail

Select Al
Corvert

Properties

3. Left click the function you wish to use.

3.3 Organizing your library

Your Dartfish software includes a versatile video management system called Keywords. The
Keywords are used to describe the contents of your video clips in a simple and clear manner. For
example, you can define categories such as the name of the athlete, discipline, location of the
filming, assessment of performance etc and each video clip can be classified and easily located by
using Keywords in any or all of these categories.

Continuing this example, it becomes very easy to locate videos containing "John Smith" doing
"Bench press”, "Incorrectly" and distinguish these from video of other athletes or even of "John
Smith" throwing the "Javelin”.

3.3.1 Understanding Keywords

To understand the Keywords system, you must be able to distinguish between the following
elements:

» The File Name that is defined for each video clip physically stored on your hard drive. A video
clip is identified with the icon illustrated below, with the file name displayed underneath (as you
can see in Windows Explorer).

Q Q
Arnaud F-lavi  Arnaud F-2.avi

» The Keywords that represent the details of each clip. For example "Swing" and "Front" can be
used to describe a video clip containing a swing filmed from the front in golf.

» The process of classifying consists of assigning keywords to your video clips, i.e. labeling them.

i Swmg ]_u :::I Front

® I:E

Front
Arnaud F-1.avi

» The Categories that group the Keywords of the same kind.

DARTEISH:=% - Version 9 - © Dartfish. All rights reserved.



E Dartfish User Guide

3.3.2 Defining your categories

To help you decide what categories and keywords you need, imagine you have several hundred
video clips on your computer. How would you label each one to identify it? When you look for these
video clips one year from now, what might you be looking for?

» Perhaps you film different sports or different disciplines within a sport. For this create a Sport
category or a Discipline category with values for each sport or discipline that you work with.

» Perhaps you will want to compare video clips filmed from the same angle. That will be much
easier if you are able to distinguish clips filmed from the front and ignore those filmed from the
side. In this case, you may use the category Camera Angle.

» So, what else might you look for? Age group perhaps if you want to compare athletes of a
similar age; An Assessment category if you want to be able to distinguish video where a skill is
performed well from where it is performed badly.

Once you have replied to these questions, you can create the nomenclature that will allow you to
classify and locate your video clips.

3.3.3 Editing categories and keywords

To create a new Category

1. Click on the New button at the top of the library and select New category... from the menu that
appears.

i X e » Show Al
MNew Keyword...
MNew Category...

Import Keywerd Set...
Export Keyword Set...

Import Keywords from dartfish.tv...

Add Felder to Library...
Remove Unused Keywords

2. Enter the name of your new category (e.g. Camera angle) and click OK.
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Edit Category

Category: Camera angle

Ion: o/ Browse...

OK Cancel

The new category will appear in the Library Categories list.

To rename a category:

1. Right-click on a category label and select Edit... from the context menu
2. Type the new name and press the enter key on the keyboard.

To delete a category:

1. Click your mouse on a category to select it.

2. Click on the Delete category or value button in the category tool bar X.
3. Confirm the action by clicking OK. The category will disappear from the Categories list.

! When a category is deleted all keywords within that category are also deleted. Video clips using
those keywords are not deleted but they will lose the deleted values.

Creating & Editing Keywords

Keywords appear beneath the category headings. If needed, click on the icon to the left of a
category to expand its list of corresponding keywords. In the example below "Event" is the
category and "highjump®”, "javelin"... etc are the keywords used to describe the video clips.

4 7 Event
<& Highjump
| 3 Javelin
| Long jump
(1< Shot

Creating, deleting and renaming keywords is done in the same way as for categories (see Editing
categories) except that you start by selecting the category which contain the keyword.

3.3.4 Classifying video clips

Once your categories and keywords have been defined, you can classify your video clips. This
process consists of assigning keywords to your video clips, i.e. labeling them, in the same way as
you would label your suitcase to help you recognize it.

It is not just video clips that can be classified; any item that Dartfish lists in it's Items List can be
categorized to make it easier to locate.

To add a keyword to an item:
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1. Select the item(s).
2. Drag the item on to the desired keyword.

Remember that you are not limited to adding a single keyword. You can repeat this process as
often as you like BUT only one keyword from each category can be added to each item.

@ You can classify several video clips at once. To do this, press on the Shift or Ctrl button on your
keyboard while left clicking with your mouse on the clips you wish to classify. Then drag and drop
the files to a keyword as described above.

To change the keyword attached to an item:

1. Select the item(s).
2. Drag the item to a different keyword within the same category.

@ Itis often better to add keyword to your video clips as they are captured from your camera. To
find out how to do this, see the topic Setting Clip Properties

3.3.5 Removing keywords from video clips

As seen in the topic, Editing categories and keywords deleting a keyword from the categories list
will also remove that keyword from any items which hold it. However it is also possible to remove a
keyword from a video clip.

To remove a keyword

1. Click the View Type button at the top of the Library module

IZ‘ lcons
List
Detailz

Thumbnail Details
Thumbnails

2. Select Details.

3. Alter the width of the Items List so that you are able to see the headings for each category
(these are only visible in Details or Thumbnail Details views). To do this you will click and drag
the right hand border of the Items List.

4. Find the keyword you want to remove. To do this you may have to make the Items List wider
still or use the scroll bar at the bottom of the Items List.

5. Right click on the value and choose Rename from the context menu. The keyword will enter an
editing mode as shown below:

Mame Club Size
(=4 Iniaki Iron 7 Drive 6,39 Mo
Gj] Iniaki_030S(2)(1) Drive 8.18 Mo
Gj]lniaki_DSDSQ) Drrive| +| 8.18 Ma
(=] Iniaki_0305(3) Drive T 9.28Mo

6. Delete the existing keyword (Backspace key on your keyboard).
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3.3.6 Importing/exporting keyword sets

The category and keyword information for each video clips is stored in a small extra Metadata file
(with a ".dartclip" file extension). Although this is not visible in Dartfish's Items List you can see it
using Windows Explorer as shown below.

Ej] Iniaki_03054), avi 35 Ko Clip vidéo
'-ﬁIniaki_DSDS(S).avi.dartclip 1 ko Darkclip files
(ﬁ] Iniaki_030503), avi 512 Ko  Clip vidéo
'-ﬁIniaki_DSDS(2).avi.dartclip 1 ko Darkclip files

When your video clips are shared, the recipient will also inherit a new set of categories and
keywords provided the metadata file was also shared. All Dartfish's sharing processes include
metadata.

What happens when inherited categories match existing categories?

Provided that the spelling and capitalization is identical, the new video clips will fit neatly into the
existing keyword system. But if, for example, the new video clip has a value of "Front View" and
you use a value "front view" then both keywords will now appear in your library.

When you and your fellow coaches will use the same categorization system (or you have more
than one computer) you can export a set of Category/keywords from one computer to another.

Exporting Categories/keywords

1. Click the Add a new category or keyword button X
2. Select the Export keyword set... option.
3. Save the export file.

! Make sure you know where the export file has been saved as it will be passed (by disk, network
or email) to the other coach or computer.

Importing Categories/keywords

1. Click the Add a new category or keyword button X
2. Select the Import keyword set... option.

3. Locate and open the file to be imported. The new categories and keywords are now visible in
the Keywords view.

3.3.7 Exporting keyword data
Dartfish allows the export of the video library's keyword data in a CSV file that allows the data to be
stored and analyzed in databases and spreadsheets.

keywords associated with video files contain a lot of information that may be of more benefit than

assisting with finding and identifying the content of video files. For example, specialist shoe shops
gather information about the shoes that customers buy as a result of video analysis; researchers

making observations from video may record that information using keywords.

To export Category/keyword data as a CSV file

1. Use the search and filter tools to isolate the video clips with data to be exported.
2. Point the mouse anywhere on the Items List and click the right mouse button.
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3. Choose Export List from the context menu that appears.

O sk © - Keywords - s Folders | [~

o> X 7 s Show All | gait
= 1. Client MName Size Shoe 1. Client Created
| - 2. Body region [T gait analysis comments 513 KB Aana20
O 4 3 View [ Gait Analysis(11) 284 MB S 2
» [0« Ability level B Gait Analysis(12) 284 MB Add to Tray 20
[« Athlete Bl Gait analysis(13) 284 M8 Cony 20
[] < Orthotics H Gait Analysis(15) 284 MB 20
O Prothesis [E Gait Analysis(17) 284 MB Rename 20
O Shoe B Gait Analysis(19) 284 MB Delete 20
n Source [ Gait Analysis(2) 284 Me Open File Location 20
] Speed B Gait Analysis(4) 284 MB 20
e - . Select All
1 Sport [E Gait Analysis(5) 284 M 20
[ & Templates & comments B Gait Analysis(7) 284 MB Corveit 20
[ Gait Analysis(8) 284 MB TN 20
|H Stromo gait demo videos 8.36 MB 20
Properties

4. Save the CSV file. It can be reopened by spreadsheet software such as MS Excel.

It is not necessary, but it may help, to change the library view to one of the details views. This will
allow you to see what data is held for each file prior to export. To do this:

1. Click the View button at the top of the library.

EH
SiE
IZ‘ lcons

List
| Details

Thumbnail Details
Thumbnails

2. Select Details or Thumbnail Details view.

3.4 Locating video files

Dartfish's Library module offers three methods for helping you to locate specific video files from the
Items List.

» Keywords view - displays a list of categories and keywords. The content of the Items List is
filtered to reflect files matching categories and keywords selected.

» Search - the search box allows a text based search of filenames, categories and keywords of
the contents of the library.

» Folders view - the typical way of locating files using MS Windows folders. The Items List
displays the content of the selected folder.
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3.4.1 Using Keywords

When using the Keywords system all video clips (and other Dartfish projects) in the Library will
be listed in the Items List. That could amount to a lot of files! You can filter the Items List to show
only relevant clips by selecting the categories or keywords for those clips.

Filtering the Items List by category

1. Display the Library module

2. In the Categories List, click the box next to the category of video you want to search for. A tick
symbol appears in the box and all keywords within that category will also be selected

2 2] Comemonie

Ca
R side
[+ Front
Rear

3. The Items List will display all clips which are labeled with keywords from that category.

Filtering the Items List by keyword

1. Inthe Categories list, click the [+] symbol next to the category containing the keyword you want
to filter by. An expanded list of keyword is displayed.

2. Click the tick box next to the keyword of video you want to search for. The Items List will display
all clips which are labeled with keywords from that category.

e w Show All | Filter o
Athlete ~  Mame Size Created {

Camera angle |E] Handball France WMV 26,9 ME 20/03/201...
Curriculum Subject
cycling events

Data reader video

RO0don

Season

2014

O 2015

Shoe

Skill

Source

Speed

Sport
Baseball
Basketball
BioMech

Canoe

1Y

’OO0Om

Cycling
Golf
Handball
Kayak
Rughy

i o I " I o

Snrcer

3. As we saw when filtering by category, you can select multiple keywords to extend or refine your
search. Where multiple keywords are selected from the same category, videos with any of
those keywords will be displayed. Where multiple keywords are selected from different
categories, the keywords cross-reference each other: in the example above, only Handball
games from the 2014 season are displayed.It is this ability to search for content in different
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ways which makes keywords a more powerful way to organize your videos compared with
Windows folders

Removing filters

1. EITHER: Click the box next to each category or keyword that you want to exclude from the filter
such that the tick symbol disappears.

2. OR: Click the Show All button © ==& gbove the Items List.

3.4.2 Using Search

When using the Keywords view, a search box can be found above the Items List. This can be
used to search for all or part of the text in the file name, keywords and categories of a video clip.
For example a search for "Serve" could yield the following results:

o Back | Keywords L__ Folders i Ev
LEE S G iy ShowAll | serve X
4 [] Sport A Mame ~
Ll Badminton [E| Tennis serve amateur(4) PAL
l Baseball |E Tennis serve amateur(3) PAL
[l Basketball [E| Tennis serve amateur(B) PAL
[ BioMech = |servel
[ Boxing F_L]Donna Wimble analysis
1 Canoe [E| Donna Wimble(1) PAL
] Cricket [E| Donna Wimble(2) PAL
| Cycling & Donna Wimble(d) PAL
| Dance E Donna Wimble(5) PAL
| Diving | Roland Garros(f) PAL
O Equestrian E Tennis serve(1) PAL
0 Foathall ? & Tennis serve(2) PAL .
< o > € >

To use the Search:

1. Type search text.
2. As you type, the corresponding results will be displayed in the Items List

Combining Search and keyword filters

When keywords are used to filter the Items List, search results are based around the selections
made as follows:

» Search first - subsequent category/keyword selections filter the search results only.
> Filter first - subsequent searches are based on filtered results only.

3.4.3 Using Folders

The Folder view creates a way of searching drives and folders on your computer for items.
Although we recommend the use of keywords as a more versatile method for cataloguing your
video library there may be occasions where you prefer to identify video clips by the folder where
they are located. For example if you want to examine the contents of a CD or networked drive
(including these types of location in your video library is not recommended).

© Dartfish. All rights reserved. - Version 9 - DARTEISH=2



Video Library 42

Filtering the Items List by folder content

1. Display the Folders view by clicking the button at the top of the library.
2. In the Folders view, click the folder you want to examine.
3. The Items List will display all clips in the selected folder.

0 Back ] ‘ Keywords L__ Foldersl E"
> | =] Pictures A llartfish video\Buds Swimmingh\Simulcam Praject ¢,
> | B Videos :
; L"-'LOS(C:J Mame Size
4 — Data (DY) \H| Back Start - Dartfish SimulCam - 30 % 5p... 294D
4 | Dartfish video
| Athletics
. Badminton
4 Buds Swimming
. Simulcam Project
J Split Screen Project
, Stromotion Project v
€ > € >

@ Although it is not possible to use Dartfish's Iltems List to move and copy files from one folder to
another, the contents of the Tray can be copied to different folders using the Windows Drag &
Drop methods or by Copy & Paste. This should be understood as a way of distributing content
rather than a full file management tool as Cut & Paste is not available.

3.5 Saving the tray's content

The contents of the Tray can be saved as a Playlist which can be reopened in the future. This is
useful for any situation where you will want to work with a collection of clips; creating a Playlist will
be more efficient than locating the same clips in the items list, for example:

» A set of clips illustrating techniques to be practiced in a coaching session.
» Clips captured during training which you want to keep together for later feedback or editing.
» All video resources used while Tagging a game (TeamPro and ConnectPlus editions).

Creating a Playlist
A Playlist is created by saving the Tray, to do this:

1. Click the Tray button found to the left hand side of the Tray.

Tray | > Clear &Share = ==
Open Playlist...

Save Playlist...

Background Task Manager

Golf swing front PAL Golf swing side PAL

2. Select the Save Playlist... option.
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3. Enter afile name and select a folder location for the Playlist.

@ Playlists can be saved into any folder you like but if you select one of the library folders (see
Defining your library) your Playlist will appear in the items list; allowing you to categorize, search
for and open playlists in the same way as you would with video clips. Playlists appear in the Library
with the following icon:

Reusing a Playlist

A Playlist is used by opening it, to do this either double-click its icon in the Iltems List or proceed
as follows:

1. Click the Tray button found to the left hand side of the Tray.

2. Select the Open Playlist... option.

3. Locate the file on your computer and click the Open button.

When a Playlist is created it does not duplicate the video clips it contains but simply instructs
Dartfish where the original clips can be found. If a clip contained in a Playlist is moved to another
folder, deleted, or the folder containing it is unavailable (for example, a disconnected network

folder or external hard-drive) then Dartfish will be unable to find it. When the Playlist is opened you
will be offered the opportunity to find the clip.

[ Fite Mot Found

> The file "C:\Dartfishl Taekwendolintroductiont Demo Sample-Das<ung Moon.avi is mob avalabls,
-.',J Do you want to browss For k7

Ly JL mo |

If the No button is clicked the Playlist will continue to open the remaining clips (and continue to
warn you if the files are not found).

Modifying a Playlist

Once the Tray's content has been saved as a Playlist, changes made by adding or removing clips
from it are not automatically saved. These modifications must be saved using the same procedure
as creating the original Playlist. You have the choice of saving a new Playlist with a new name or
overwriting the original.

3.6  Sharing video files

The Tray is used to share video to a variety of destinations including network drives, email, CD and
internet. To learn more about all the outputs from Dartfish see the Dartfish outputs - publishing &

sharing chapter
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3.7 Converting video clips

It is possible to use Dartfish to convert video files into other formats. Reasons for doing this may

be:

>
>

>
>

To reduce the space they occupy on your hard drive

To reduce the bit rate (the amount of data per second) to allow smooth streaming across a
network or the internet

To reduce the publishing time to the internet - particularly when using dartfish.tv
To use a preferred format for a specific destination e.g. MPEG-2 for DVD

To convert video

Conversion is guided by the Video Conversion Wizard.

1.

Step 1 - select the files to convert from the Items List or the Tray. To select multiple files, hold
down the CTRL key while clicking on the file names.

Step 2 - Display the Tray or Iltems List context menu by right-clicking on any of the selected
items. Select Convert to launch the Video Conversion Wizard.

Open
Add ko Tray

Copy

Renarne
MMowe to Recycle Bin
Lirk Tkerns

Refresh Thurmbnail
Select Al

Canvert

Step 3 - Video Settings. Select an encoding profile. The profile chosen affects the video
format and the degree of compression. For more on video encoding profiles see Converting
Video in the Getting Familiar chapter.

Step 4 - Destination. Choose a destination folder for the video. The default is to return
converted video back to the same folder as the original files. Converted clips will not replace the
originals and will have a different file name. For example, "Marathon.avi" might become
"Marathon.wmv". However, you are able to choose what action to take if there are other files
with the same name located in the destination folder. You can either overwrite the existing files
or rename the converted files.

Clicking the Next button at this stage starts the conversion. When complete, the new files can
be found in the Iltems List or Tray.

3.8 Video Formats and Dartfish

Dartfish can play a variety of common video formats. This allows the use of video content from a
variety of sources and devices. The following formats are supported.

>

YV V V V

AVI (DV - PAL, NTSC - Type | & I, uncompressed and DivX)
High Definition (HD) in HDV or AVCHD

Windows Media (WMV)

MPEG (MPEG-1, MPEG-2)

MPEG-4 (H.264-AVC)
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This is just a broad guide as the subject of video encoding is not a simple one - some devices and
software encode video files using codecs that cannot be decoded by Dartfish. Others may create
files with a proprietary file extension that is not recognized by Dartfish. Our advice is to try to play it
and you'll soon find out if it works!

@i your device produces video which you think Dartfish ought to support but doesn't, please
contact Dartfish Support for further advice.

HD (high definition) video and Dartfish

The increased resolution of HD video can be highly beneficial for video analysis however it also
has downsides. Four times more pixels can require more storage space and processing power,
although this varies considerably depending on the encoding bit rate used by your camcorder. The
difficulty is not just with image resolution; the complexity of encoding profiles such as MPEG-4
require five times more processing than standard definition MPEG-2. The result may be that
analysis tasks such as split-screen comparison or even frame-by-frame playback require above
average computer resources.

For those using HD it is particularly important to be aware of the recommended computer
specification. See the Customer Care Site for details.

3.9 Correcting video property errors

Some video devices produce video which fails to describe, or describes incorrectly, certain video
features and this can lead to problems with appearance. Dartfish allows you to manually correct
video properties.

To display the video properties

1. Right-click the video item in the Library's Items List or Tray
2. Select Properties from the quick-menu
3. Select the Source Info tab

The following errors can be corrected:

Interlacing errors

Interlacing errors occur when the two fields which comprise each frame of interlaced video are
incorrectly displayed. If interlaced video is incorrectly described as progressive then a
characteristic jagged edge is seen on moving objects, such as shown below.

Where the two fields are displayed in the wrong order, the video will appear to jump back and
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forwards when played frame by frame or in slow motion.

Aspect ratio errors

When a video is displayed in the wrong aspect ratio the image will appear distorted; squashed or
stretched.

Rotation errors

Rotation errors can happen when the camera has been held in portrait orientation so the video
looks like it is on its side when played.

To adjust properties
Only properties with a pencil icon next to them can be edited.

1. Click on the value to edit
2. Select the correct value from the drop down list
3. The corrected value is displayed next to the original value as shown below:

' General | Keywords | Source Info Data Streams

Source Info

% ASF
¥ Video
 Codec: Windows Media Video 9 VC-1
& Format: 720 x 576 @ 30.00i
 Video Stream Rate: 25:1
7 Rotation: 90° (0°)
“# Aspect Ratio: 16:9 (4:3)
«z Interlacing: Interlaced, field 2 first
& Duration: UUIUUTUZ.437
o Bitrate: 8388 kbps
& Audio
& Codec: Windows Media Audio 9
& Channels: 2
& Bits per sample: 16
& Sample rate: 44.100 kHz
 Duration: 00:00:03.437
& Bitrate: 128 kbps

l Refresh Media Info |

Edit | | Reset ‘ |

OK ‘| Cancel || Apply |

3.10 The next steps

This chapter covered the use of the Library and explained how to create a library using Categories
and Keywords to manage video clips. Specifically, you learned to:

» Define folders and drives to be contained in the library.
» Define appropriate Keywords for your needs.
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> Describe the content of your video clips by using categorized keywords.

» Share video by disk, email or Internet.

» Archive and backup video on CD.

We recommend that you take some time now to define the folders and/or drives that you want in

your Library, create categories and keywords suitable for your use of video and then, if you have
existing video clips, assign appropriate values to each.

If continuing your journey through Dartfish Help then you might want to learn how to import video
and capture video 'live' using the InTheAction Module (read chapter Live capture & instant replay
during training).

Dartfish is also able to share video by producing Media Books from the Analyzer module.
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4

Importing video files

The Importer module adds video to the Library by one of three processes; by copying video files,
by recording a video stream or by download from dartfish.tv. Access to these processes is via the
Importer button on the toolbar, which allows you to select an import method from its drop-down

menu.

- H
4’—3 Importer ~

Choose how to import

Copy video to Library
Record Live Video
Download from dartfish.tv

If unsure which tool is correct for you, the Choose how to import option will present a list of video
devices and sources. Dartfish will then start the correct tool according to your choice.

Copy video to Library
Copies files from any disks or folders internal to, or connected to, your computer. This includes:

» Camcorders recording to memory card, hard-drive or internal memory
DVD camcorders

DVDs or CDs in your computer's optical drive

Card readers

Folders on your computer, network or external drive.

YV V V V

Record Live Video

Records a live feed from a device capable of delivering a video stream; this is recorded by Dartfish
to create new video files.

> Video converter devices. These devices are used to convert the video output from devices
which don't provide a digital stream which can be used directly by a computer e.g. the HDMI
output from a camcorder

> |IP Cameras
> Webcams
> DV and HDV camcorders

Other ways of adding files to your library

There are two further modules which record a live video stream, but they are only found in certain
editions of Dartfish:

1. InTheAction facilitates the entire process from live video capture to analysis for those who
want to give immediate feedback.

2. Live tagging has a specialized version of the video recorder which allows an index of video
content to be created while recording.

For the sake of completeness there are three further ways in which files can be added to the
Dartfish library:

3. A new folder is added to the list of folders monitored by Dartfish (see Defining your library).

4. The results of a Dartfish project are saved.

5. Video files are copied or saved into a library folder by a process external to Dartfish, for
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example by using MS Windows file management tools or by using the import software supplied
with many camcorders.

! When new files are added to a monitored folder by an external process they won't automatically
appear in the Library - you must remember to refresh. From the menu bar choose View >
Refresh.

Copy video to Library

The Video File Importer copies files from any device on which Windows is able to recognize a file
structure (for a fuller description see Importing files to the library).

To import video files into the library:

1. Connect the external device or insert media into the appropriate drive. If the device doesn't
simply plug and play you may need to refer to the device's documentation to learn how to do
this. For example, many camcorders require that you select a connection mode.

2. Select Video File Importer from the drop down menu on the Importer button.

H =
4'—3 Importer ~

Choose how to import

Copy video to Library
Record Live Video
Download from dartfish.tv

3. A step-by-step Wizard is launched to guide you through the process of selecting, copying and
categorizing video files. The steps of the wizard are covered in the following topics.

Importing files from Camcorders

Many camcorders permit a maximum file size so when you make long recordings several video
clips are created. For certain types of device (currently AVCHD camcorders and DVD) Dartfish
automatically detects sequential files and creates a single video clip.

Indexing video

Some video formats do not have an index; preventing accurate identification of video time
position. Tasks which rely on this, such as stepping through the video and synchronizing multiple
clips, become unreliable. Dartfish creates an index when these videos are imported or opened.
Access to the video is delayed during indexing, but the index is retained allowing immediate
subsequent access.

Importing from DVD

In addition to importing files from data CDs/DVDs and importing from DVD camcorders via a USB
connection, Video File Import copies video files from a video DVD in a form that can be used in
Dartfish software : the DVD's VOB files will be renamed with an MPG file extension to allow them
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to be played by Dartfish.

» DVD import is not designed to capture a video stream from a DVD player. In order to import
DVDs your computer must have a disc drive capable of reading DVDs or import is direct from
the DVD camcorder connected by USB.

» If your computer's DVD player automatically plays the disc after insertion, stop it and close the
player to allow Dartfish to access the disc.

» Many commercial DVDs are copy protected. Dartfish will be unable to import video files from
copy protected DVDs. Video DVDs that have been created by a home DVD Video Recorder or
a DVD camcorder are usually not copy protected.

More on this

» Video File Importer - selecting files
> Video File Importer - naming and filing videos

4.1.1 Copy video - selecting files

In the first step of the importer you choose the source of your files and then can select or deselect
which files you wish to import.

Select source drive
Select a device or select the Browse... option to select a specific folder.

Even if you made a specific choice of video source from the importer, all connected sources are
listed. When selecting the source, remember it may not always be obvious how your computer
identifies your device; in the example below the camcorder is simply identified as "Removable Disk
(G)"

Select video source

[_ VIDEQS (G:) v] [ Browse
L2 BD-ROM Drive (D:) |

3 meose) |

! Dartfish automatically recognizes the file structure on certain devices and displays the videos
from that device. On other devices it will be necessary to click Browse and select the appropriate
folder.

Browsing only shows folders and not their contents so when confronted with the message, "No
Items Match Your Search" do not assume that the folder is empty.

Select Files
Files are selected by placing a tick in the check box at the top right of the thumbnail.

Proceed to the next step by clicking the Next button at the bottom of the Importer
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Copy video - naming and filing videos

In the final 2 steps of the wizard you will define file name, assign keywords and select a folder for
the imported files.

File name

The title has two roles depending on the source device type:

» For sources from which Dartfish will join concurrent files (AVCHD camcorders and DVD), the
title represents the name of the new file that will be created.

> For other sources, the file name allows you to rename the often meaningless name assigned
by the camcorder. The same filename will be used for all imported files but suffixed with an
index number e.g. filename(1)

Add keywords to video clips

Dartfish keywords can be added to video clips as they are imported. As discussed in the
Organizing vour library topic, keywords are a highly effective way of cataloging video content. To
add keywords you will create a matrix of categories and keywords.

| Rename imported files

Lanzarote camp swimming day2

Leave blank to use original file name

Add keywords to the video clips

Categories Keywords
" Analyst Meil Melville
' Coach Richard H |
" Athlete Victor] v

qe e

> Edit the matrix by clicking to select and then clicking again to edit. Press the Enter key to
confirm your selection.

You can type a new category or keyword or select one already existing in the Library

» The matrix you create will be retained for future imports. You can choose not to use a keyword
simply by editing and deleting it. If a category in the matrix has no keyword, no keyword will be
applied.

\4

Select destination folder

The final step before import allows you to choose the destination for imported files. This is the
Windows folder where your files will be stored.

! Even if you use keywords to organize your library, your files are still stored using the Windows
folder system. It is perhaps best to import to one of your library's monitored folders but any folder
you choose will automatically be monitored by Dartfish.

DARTEISH:=% - Version 9 - © Dartfish. All rights reserved.



E Dartfish User Guide

! Itis recommended that you choose a folder on a local drive, rather than on a network; this will
ensure rapid copying and smooth playback and analysis

The folder structure of the removable media will be maintained after import. For example if my
memory stick contains a file K:\\Videos\file.mpg it will be imported as ..\destination folder
\Videos\file.mpg.

Finish
Your final choice is whether you wish the imported media to be included in the Tray. Regardless of
the choice made all media can be located in the Library Iltems list.

4.2 Video Recorder: capture a video stream

Record Live Video versus Copy Video to Library

These days we have grown used to using devices which record video files which can then be
transferred to a computer. However, an alternative workflow is to have the video device feed video
directly. The computer then creates the video file.

In the case of webcams, IP cameras and older DV/HDV camcorders, streaming is often the only
way to get video onto a computer. For the Dartfish user the advantage of recording versus
importing is that the video is available for analysis almost immediately.

Tape camcorders

A DV/HDV camera is connected to a computer via a firewire cable (also known as IEEE 1394 or i-
link). This requires that your computer has a built-in Firewire port or an Express card slot which
would allow one to be added. There are different types of Firewire so be sure to buy the correct
cable. In general, your camcorder will have a 4 pin connector. Your computer can either have a 4,
6 or a 9 pin connector.

"4" pin connector "6" pin connector

to Firewire port to Express card

To capture recorded video from tape, switch on your camera to its "Play" or "VCR" mode. To
record a live stream, switch it to "Record" mode

Tapeless camcorders plus video converters

Modern camcorders no longer stream video in a form that can be directly recorded by a computer.
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To obtain a live stream it is necessary to use converter hardware to convert the AV output. This
can be analog (usually composite or s-video) or digital (usually HDMI). Digital is the preferred
option and to retain full HD video the HDMI output must be used.

In theory, Dartfish can work with the video produced by a wide range of converters. In practice, it is
hard to predict which will allow Dartfish to manage the recording process. For this reason we
recommend several converters which we know will work:

Device Connection Notes

Blackmagic H.264 Pro HDMI/SDI > USB  Professional quality digital converter. Requires
Recorder power supply.

AVerMedia Live Gamer HDMI > USB A lower price tag that the Blackmagic device
Portable and doesn't require an additional power supply.

No control over output which is 30fps with a
1080p input or 60 fps with a 720p input.

Canopus ADVC 55/ 110 Composite > Professional quality converter but this model
Firewire offers analog, standard definition video only.
Firewire connection needed. Can be powered
via Firewire if 6-pin cable used.

Canopus ADVC HD50 HDMI > Firewire Professional quality converter providing HD
video. Now superseded by the Blackmagic as
laptops with Firewire not readily available.

Terratec G1 Composite > USB A budget solution which uses a USB connection
and does not require any additional power
source.

Webcams

Webcams are suitable for some types of analysis; generally where there is limited camera
movement and where the better image control and larger optical zoom of a camcorder is not
required. Dartfish recommends webcams which offer an MJPEG stream, otherwise the stream will
be relatively uncompressed and require greater processing power, perhaps beyond the capabilities
of lower specification computers. Particularly recommended is the Logitech C920 webcam for the
following reasons:

» Good image quality - the Lifecam has a glass lens and good quality sensor and has some
automatic image improvement features, plus it is possible to have some control over zoom and
exposure

> Fixes to standard tripod
» MJPEG video stream - video is compressed without reducing resolution

I[P cameras

An IP camera is a device which streams video across a network using internet protocols (IP).
There are a wide range of IP cameras offering a wide range of features and although designed for
security or other monitoring purposes, they can offer a practical solution for live video capture
needs with Dartfish.
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4.2.1

IP cameras are ideal for fixed installations: Stadiums, gyms, sports halls, golf driving ranges etc.
The camera and cable infrastructure is fixed and all the user has to do is come with his laptop and
connect to the network. Because that network might even be a wireless network, one can imagine
possibilities that this offers to Dartfish users. Furthermore, multiple cameras can be connected to
the network and the user can pick which he wants to view/record.

Simpler use cases such as bike fitting or gait analysis are also candidates, but only where the
benefits listed above plus better lenses and better zoom capabilities, outweigh the low cost and
easy connection advantages of other solutions.

Cameras complying with the ONVIF standard are supported. Where PTZ (remote controlled pan,
tily, zoom) is required the device must comply with ONVIF version 2.

Setting up the capture device

To activate the video recorder

Select Record Live Video from the drop down menu on the Importer button.

5 H
H H
H

J’—-:-. Importer ~

Choose how to import

Copy video to Library
Record Live Video
Download from dartfish.tv

Selecting a Capture Device

The lower part of the module contains several settings. Clicking the headings expands each
setting to view the details.

In the Capture Device section the video (and optionally audio) devices are selected: Select your
camera from the Camera drop-down list. When a successful connection to a camcorder is
established the Record button will be active (red) and the streamed video is shown in the video
display.

» Clip Properties
» Recording Options
» Recording Folder

* Camera
Y@ [ Logitech HD Pro Webcam cg20 v DE B 69 v v
}_.__ | Do not record audio V|

If the device or camera that you are using does not appear in the capture device list, it is possibly
because of one of the following reasons:
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Camera not switched on

Correct cable not present or disconnected

Camera not properly installed and recognized by Windows
Hardware fault with cable or camera or capture card

V V.V V VY

Device not supported by Dartfish

For more information about the types of device which can be used by the video recorder
see the following topics

> Video Recorder: capture a video stream

» Setting up the Logitech C920 webcam

> Configuring an IP camera

4.2.2 Setting up awebcam

The Logitech C920 is the webcam recommended by Dartfish because of its video quality and
ability to provide a MJPG encoded video stream. To set up the webcam, connect it via its USB
cable, then:

1. Select Record Live Video from the drop down menu on the Importer button.

J’_—g Importer ~

Choose how to import

Copy video to Library
Record Live Video
Download from dartfish.tv

2. The Capture Device settings are found in the settings section below the video display: Select
Microsoft Lifecam Studio from the Select capture device drop-down list.

3. When a successful connection to a camcorder is established the Record button will be active
(red) and the streamed video is displayed in the video display.

» Clip Properties
» Recording Options
» Recording Folder

~ Camera
Tg | Logitech HD Pro Webcam €920 v DE S 169 v ooh o~
:_ | Do not record audio V|

Configure format

Click the ¥ button to the right of the selected device to configure these recommended video
settings:
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Configure Format Properties X

Pin Property

Color Space / Compression

MIPG ~
Output Size

1920 X 1080 e
Frame Rate

30 FPS ~

Cancel

» Frame Rate: 30.000

» Color Space / Compression: MJPG
If this option is unavailable your chosen webcam may not offer compressed video and the
resulting video stream will be ‘heavy'. This will result in large files which less powerful
computers may struggle to play smoothly.

» Output Size: 1280 x 720
You may prefer to use a lower resolution if working with a computer below Dartfish's
recommended specification

Configure device

These features which allow you to improve the image from the webcam:

1. Click the & button to the right of the selected device
2. Click the Camera Control tab

3. Experiment with settings to achieve the best image. Pay particular attention to the Exposure
setting to reduce motion blur.
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= Logitech® Webcam Properties X

Advanced Settings

Image Quality:

() RightLight

Exposure b o)

Yy
i 4 Aut
Gain G ) uto

Brightness.

Contrast

s & &

Color Intensity

White Balance C ] ) f‘/ Auto
J

1A

Anti-flicker: Image orientation:
Off s Normal
NTSC - 60Hz Mirrored

* PAL- 50Hz

-
Logitech

4.2.3 Using Network (IP) cameras

An IP camera is a camera that streams video across a network. In this topic we start from the point
of assuming that your camera is successfully set up on your network and is accessible to the
computer(s) that will record from it.

Who uses IP cameras?

IP cameras are ideal for fixed installations: Stadiums, sports halls, tennis courts, golf driving
ranges, classroom monitoring etc. The camera and cable infrastructure is fixed and all the user
has to do is connect his computer to the network. Because that network might even be a wireless
network, one can imagine possibilities that this offers to Dartfish users. Furthermore, multiple
cameras can be connected to the network and the user can pick which he wants to view/record.

Simpler use cases such as bike fitting or gait analysis are also candidates, but only where the
benefits listed above plus better lenses and better zoom capabilities, outweigh the low cost and
easy connection advantages of other solutions such as the Logitech C920 webcam

Dartfish support for IP cameras

Cameras compliant with the ONVIF standard are supported. Where PTZ is required the device
must comply with ONVIF version 2.

In theory, Dartfish should be able to record from any ONVIF compliant device. In practice, the
implementation of the standard is variable between manufacturers and we are continuing to learn
how to make all function optimally with Dartfish. As we learn more about how ONVIF is
implemented, we can expect a wide range of cameras to function without any need for further
software updates.

There are three parts to configuring an IP camera:
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1. Use the camera's own configuration tools to define some essential parameters as well as other
features of the video

2. Enable and configure ONVIF plugin in Dartfish
3. Select camera and (optionally configure video/audio stream)

4.2.3.1 Configure an IP camera

The initial configuration of the camera is typically done via its web page simply by entering the IP
address of the camera into a browser but a dedicated utility may be provided by the camera
manufacturer. Consult the camera user manual on how to access and configure the device.

Important parameters

Some properties of the video stream can be modified directly from Dartfish later. Among those
which can only be defined from the camera configuration, it is important to check the following:

» Update firmware: There may be a button or link to do this on the configuration page. Otherwise,
the manufacturer’s support website should be checked to discover if there is an update.
Interoperability with Dartfish may depend on this.

» Set date and time of camera: This may be important to ensure correct communication between
the camera and computer.

» Set sensor base frame rate: The sensor frame rate must be set to the frequency of the AC
power of your country e.g. 60 Hz/fps for the US and 50 Hz/fps for Europe. Failure to do this may
result in poor image quality and flickering video.

! The sensor frame rate is not the same as the frame rate of the video received by Dartfish. You
can configure that from Dartfish.

4.2.3.2 IP camera setup in Dartfish

Enable network camera

1. From the Dartfish Tools menu > Options > Network cameras
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[} Options “
Hd &« T B £ | @

General Library Encoding Profiles Analysis InTheAction SimulCam StroMotion | Network Cameras | Add-ins  Advanced

Select the plug-in te configure

MName Status
&) ONVIF IP Camera Enabled

[+] Enable plug-in
[l Use HTTPS when available
[+#] The camera requires a login
oot ....{
End points:

Manually add end points when the camera is on a different subnet
or is being accessed via the internet

Mame Address Pro.. Add

2. From the list of plug-ins, select ONVIF IP Camera then check the Enable plug-in option
3. Enter user name and password (if user profiles defined for camera require login)

! The login relates to user profiles created on the camera. Dartfish does not allow the user to login
to individual cameras but instead offers a global login which gives the user access to all the
cameras with user profiles with those login credentials.

HTTPS or HTTP?

Selecting the Use HTTPS when available option ensures that communication between camera and
computer is secure. However, be aware that:

» Not all devices offer HTTPS encryption. Ticking the box here has no effect.

» HTTPS does not encrypt video, it only provides secure communication between camera and
computer of information such as login.

Device selection

Select Video Recorder from the drop down menu on the Importer button.

E Importer ~

Choose how to import

Copy video to Library
Record Live Video
Download from dartfish.tv
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Any available camera can be selected in the Capture device section of the module.

After selecting a camera, buttons to configure video, audio and (if available) PTZ settings will be
displayed next to the selected device.

i AXIS P5534

*  Clip Properties
}  Recording Options
* Capture Device

fg | Axispssa4 v 28
S | Axispss4 y

}  Recording Folder
}  Encoding Profile

When a successful connection to a camera is established the record button will be active (red) and
the streamed video is displayed in the video display.

Disabling the audio source

Unlike other sources of video, when using an IP camera, it is not possible to use a different audio
source other than the camera. It is possible to disable audio recording:

Lo

Click the Configure audio button

Select the profile that you want to use according to your video requirement
Click the edit button

Choose (None) for the AUDIO SOURCE property

Howbn

! Audio is switched off on this media profile for all users of the camera and not just for the software
where the choice was made, be aware that the change may affect other users.

Configure video properties

It is possible to set some common properties of the video stream using Dartfish software: Click the
configure format icon shown next to the selected device. The optimal/easiest way to define video
settings is to choose one of the camera’s pre-defined profiles. However, to meet the bandwidth
requirements of your network or particular analysis needs, you may want to create or customize a
profile.
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Configure format “

Media profile to use

Profile quality h264 P Edit Create Delete

Device | Video | Audio

Video
Profile name: quality h2e4

Encoder: H.264

Resolution: |1280x720 “
Frame rate, fps: | 25 =
Quality: 100
Bitrate, kbps: 0
Encoding interval: 1]

Encoder profile: |Baseline v

I-Frame interval: 3

Use count: 1

OK Cancel

» Encoder: H.264 and MJPEG are supported. MPEG-4 is not supported
H.264 offers better image quality/compression ratio but may introduce latency (delay in the ‘live’
image appearing on the screen).
MJPEG generally provides lower latency but for any given quality file sizes will be larger

» Frame rate/encoding interval: For technical analysis we often want the highest possible frame
rate so you should be aware that media profiles can use both these properties to define the
effective frame rate i.e. the frame rate at which the device is encoding and delivering frames to
Dartfish. To configure the effective frame rate, some devices use the frame rate parameter,
others the encoding interval and others use both in combination. In the latter case the encoding
interval parameter influences the frame rate parameter
e.g. base frame rate = 60, frame rate parameter = 30, encoding interval = 2, effective frame
rate = 15 fps.

» Resolution: Choose a resolution which allows the level of detail required for analysis.
> Quality: Set between 80-100%. Quality below 80% is usually not suitable for video analysis.

> Bitrate: This property sets a bit rate limit so it is best to configure it to something that is
supported by the network e.g. 5 Mbps for SD video and 8-12 for HD video, then adapt the other
settings to provide the best image quality within the specified bitrate constraint. Frames are
dropped if the bitrate property is exceeded.

This is a generic set of properties defined by the ONVIF standard. Some cameras may not allow
certain properties to be modified by the user e.g. in the image above, encoding interval cannot be
set. Also remember:

» Other video settings (where available) can be modified on the camera’s configuration page

» Some or all settings may be unavailable to you if your user profile does not have administration
rights

» Creating and modifying media profiles affects all other users of the camera
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4.2.3.3

Configure audio properties

Audio encoder: G.711 and G.726 codecs are currently not supported. The audio encoder must be
AAC.

Check if the media profile configuration is appropriate

Just because a video image is seen in Dartfish does not mean that it is a correct video image! The
frames per second (fps) indication shown in the Dartfish status bar provides a good indication
when there are problems with the configuration.

1280720 © 60.00p - 2 ch 16 bits 44.1 kHz 326 fps

e.g. in the above image the bit rate exceeds the capacity of the network - you can see that the
video stream being sent by the camera is 60 fps but video is being displayed at 32.6 fps.

Pan-tilt-zoom control

Configure PTZ (Pan-tilt-zoom)

Some IP cameras allow remote control of the direction and zoom of the camera. Dartfish supports
PTZ by providing a PTZ control

To display the PTZ control, click the PTZ button next to the selected device (or right click the video
display)

Control the camera movement
Press SHIFT for smaller move
Press CTRL for greater move

I, andi

. Dragan workplace

Z Home

Zoom In

- Reception
~ Valentin
~ . Workplace

Zoom Cut

[ Jinvert tilt axis

1024x576 @ 25.00p - 2 ch 16 bits 44.1 kHz 2

On the left of the PTZ control, buttons remote control pan, tilt and zoom and on the right there is a
list of preset positions.
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Create a preset by:

1. Pointing and zooming the camera
2. Click the Save button
3. Enter a name for the preset

@ Users of Dartfish tagging can add a PTZ move button to a tagging panel to integrate camera
control into the tagging workflow.

4.2.4 Setting file properties

Use the Clip Properties to set the File Name and keywords for newly captured clips. This
information defines a Capture Form that will be used to name categorize the video clips during
capture. Read the section Organizing your library to learn more about categories and keywords.

Defining the Capture Form
1. Click the Add a category link. The Add Category dialog will appear.

w | Olip Properties Enter information about the next captured cliplz)

File: name: Untitled
Sport; Goll 'g'v': X,
Camera angle: [+ | X
4dd feqory
Aem Add Category

5 Choose or create a categomy to be added to the form.

() Select from the list of existing categories

I Spart
Camera angle

ar enter the name far a new category

Mew cateqory

[ 0K ] [ Cancel

2. Select a category from the list or create a new one.
3. Click OK. A new category box will appear on your Capture Form.
4. Repeat steps 1-3 until boxes for all the categories you want to use are displayed on your form.

Using the Capture Form
1. Type a file name in the file name text box.

¥ ) Clip Properties Enter information about the nest captured clip

File Mame: Fribourg « Bern

» Each file captured using this file name will be numbered sequentially. For example if you
type "Training Aprl10", each captured clip will be named Training Apr10(1), Training Aprl10
(2) etc.
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4.2.5

» The filename you use must follow MS Windows file naming rules: Max length 256
characters; use of ™", ";", "/" or "\" is not possible.

> If no file name is specified a generic name of Untitled(1) etc will be given.

2. Select the keywords you wish to give the clip by selecting them from the drop down list for each
category box. For example, you might intend to capture all of the men's Giant Slalom
competitors in Chamonix. Your form should look like this

¥ Clip Properties Enter information about the nest captured clip

File M arne: fworld cup round 1 2005

Discipline: Giant Slalam [
Sex: Men w| X
WenLe: Chamanix | X
Skier: e [
Add & cateqony

If a keyword does not already exist, for example a new competitor, you can type that value into
the appropriate box. This new keyword will appear in the Library module's categories list after
clips have been captured.

Vifa category is to remain with no keyword, for example if the name of a competitor is unknown,
the value may be deleted from that category box (select it and use the Backspace key on your
keyboard). Do not use the Clear button * as it will remove the category box from the form.

Using Recording options

A difficulty when recording a video stream is to guess when the action that is to be recorded will
start. It is common to start recording too early and create a file that is longer than necessary.
Worse still, recording is started too late. Recording options are intended to prevent this. There are
two recording options:

Pre-record - constantly stores a defined number of seconds of video in the computer's memory.
When recording is started the stored video is included in the video file created. Setting one or two
seconds of Pre-record compensates for user and computer reaction time or allows you to view the
action and decide whether to record it or not afterwards.

Recording Duration - it is possible to define how long the captured clip will be. Recording will
automatically finish at the end of the defined duration. This simplifies recording to the single button
press that initiates it but it is especially valuable when longer videos are to be recorded,; for
example, start recording a game and return one hour later when it has finished.

To set Recording Options

1. Expand the Recording options section
2. If a fixed Recording Duration is to be used 'check’ the tick box next to the time

3. Set values for Recording Duration by first clicking on the hours, minutes or seconds value
then editing the time by typing a number by using the scroll buttons.

4. Set a value for Pre-Record Duration by typing a number by using the scroll buttons
* Recording Options

) 1 i . 2
", Pre-Record Duration [s] - =

Recording Duration [hhemmess]: | [] 00:00:03
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In the example shown here a 2 second pre-record is being used but the 5 second recording
duration is not and recording will be stopped manually.

More about Pre-Record: Recording after the action has completed

You may witness many performances which are of no value to you. How can you efficiently select
which of these you want to record for use in Dartfish? By setting a larger Pre-record it is possible to
make an assessment of which actions are worthwhile. In the example below, recording is only
started AFTER the jump has completed: A pre-record of 4 seconds allows for decision making
time and by also setting the recording duration to 4 seconds we ensure that it is always the
previous 4 seconds that are recorded.

! The largest possible Pre-Record time is based on the amount of RAM memory available

4.2.6 Selecting arecording location

The Recording folder setting both displays the current Windows folder where video will be stored
and allows you to select a different location. The recording location default is the "Videos" folder on
your computer. To change recording location:

1. Click the Change folder link. A standard Windows Select Folder... window appears
2. Browse for and select a folder or click the New Folder button to create a new folder in the
currently selected folder.

Choosing a recording folder

Apart from organizing your files where it is convenient to find them in the future you must choose a
drive with sufficiently fast write-speed. Video files are large and data-rich so attempting to save to a
location where the file writing speed is too slow is akin to quickly pouring a lot of water down a
narrow pipe! The result is dropped frames and jerky playback. Typically, data transfer to a network
location is too slow to successfully create video files.

@ Record to a local drive and then use the Share function of the Library's Tray to copy the files to
other locations.

4.2.7 Using an encoding profile

Dartfish can encode video as it is recorded.This is used to:

» Reduce video file size.
> Prepare the video for its final destination. For example, video which will be played from an
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optical disc or streamed across a network or the internet must have a appropriate bit rate in
order to achieve smooth play back

» Reduce dartfish.tv publishing time. If the encoding profile of your channel is used while
recording, re-encoding is not necessary during publishing

~ Encoding Profile

1—,, Record video stream AVI Motion-JPEG (Original format) v | Edit profiles
Create converted clip MPEG-4 H.264 SD v
Add converted clip to tray W

Record video stream

Select this option to create a video file using the video encoding provided by the video source. The
original format is displayed next to this option and from some sources it is possible to select from
multiple formats.

Create converted clip

Select this option to create a video file using the selected encoding profile. See Converting video
for further information on the different encoding profiles.

Add to tray options

When both Record video stream and Create converted clip are selected, two video files will be
created. These options allow you to decide which file(s) will be loaded into the Tray after recording
and therefore be immediately available for use.

Creating two files is useful when two formats of video are required for different purposes - for
example, a high quality file for use in Dartfish Software and an internet quality ready to be quickly
uploaded to a website.

Edit profiles
The Edit profiles link takes you to the encoding profile options where you can:

» Learn about the bit rate and file sizes of the encoding profiles provided by Dartfish
» Download the encoding profile for any dartfish.tv channels to which you have access
When a converted clip is created from a video source which already provides encoded video,

background conversion is used. The video stream is always recorded until the conversion is
completed successfully. This has the following implications:

» When recording is stopped there may be a delay before the clip appears in the library.
Conversion progress can be monitored using the background task manager

> If conversion fails, the original recording should be available as a backup - whether or not the
Record video stream option is selected

» Unencoded video streams e.g. RGB or YUV are converted directly without using background
conversion

Q Although encoding during recording offers the convenience of a video file already suitably
encoded/compressed for its final purpose, it is possible to re-encode any video file in the library
simply by right-clicking it and selecting Convert from the context menu. Sharing and publishing
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features also re-encode video.

4.2.8 The background task manager

When an encoding profile is used to encode (convert) video as it is captured, the full quality video
is stored by the computer until sufficient resources are available to complete the conversion. This
may not happen until some time after the capture. The Background Task Manager helps you
keep track of the progress of creation of encoded clips and if necessary allows cancellation of the
process.

To view the background task manager

1. From the Tray section of the Library, click on the Tray button.

Tray | > Clear :&Share
Open Playlist...
Save Playlist...

- Background Task Manager

2. Select Background Task Manager from the menu.

§ Background Tasks — o IEN

Live Conversion X
Converting ‘C:\Documents and

Settings\Neil Melville\My

Documents\My

Videos\Dartfish\Tennis lessons 14...

Done

Live Conversion 3
Converting 'C:\Documents and

Settings\Neil Melville\My

Documents|My

Videos\Darifish\Tennis lessons 14...

L E—

Clear [ |Keep On Top Close

To cancel tasks

If the progress indicator for a task shows that it is not yet complete ™= then the task
can be canceled by clicking its close button . Clicking the same button on completed tasks does
not undo the process, it simply removes the item from the list. All complete tasks can be removed
by clicking the Clear button. This may help in identifying which tasks are still incomplete.
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4.2.9 Capturing video to Library

Once setup, the process of capturing video is a simple one; click a single button to start and then
stop capture at the beginning and end.

Click the record button *® at the start and end of the clip. The second click is unnecessary if the
recording options are set to end recording automatically

The pause recording button allows you to pause capture but create a single video clip

! Pause recording is only available from certain video sources. For more information see the Live
Requirements document on the Customer Care site.

Replaying captured clips

The clips you have captured will now be listed in both the Tray and Items List of the Library
module. Play the video by double-clicking it in either location. Unless another module is manually
chosen, the video clip will open in the Player module

@ Finding footage on tape: if using a DV or HDV tape camcorder, the DV Import module will
display a set of controls that you can use to control the camera when it is in its 'Play’ mode.
|II|II<I|IDI«
camera itself.

» | Alternatively, you can use the equivalent controls on the

4.3 Download from dartfish.tv

Dartfish.tv is Dartfish's video analysis sharing platform. Content from dartfish.tv can be imported
from

» A dartfish.tv channel - if you are subscribed to a collection and have been given download
rights by the channel administrator

» Your Smart Cloud - if you have a myDartfish subscription.

In addition to video, the Importer will bring Key Positions, video and key position descriptions,
events when these have been applied to the source video by Dartfish software. These features will
not be included when the downloaded video has been annotated by the Dartfish Express app.

To download from dartfish.tv

Select Download from dartfish.tv from the drop down menu on the Importer button.

g R
¢—§ Importer ~
Choose how to import

Copy video to Library
Record Live Video
Download from dartfish.tv

Sign-in
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Next, sign-in using a dartfish.tv account.

Dartfish Sign-in

Sign In

Your email ‘ neil.melville@dartfish.com |

Password ‘ sssessne |

Sign in

Can't access your account ?

Cancel

Typically, you will will have created this account when either:
»You received an e-mail invitation to view content on a dartfish.tv channel
»You subscribed to a myDartfish plan

»You accessed subscription content (e.g. pay-to-view) or subscription-only features on a dartfish.
tv channel

Vit you can't recall your password click the 'Can't access your account' link

Download

1. Select the destination folder for the downloaded video

| C\Users\Neil\Videos |
1 : Change folder Open folder

2. Choose the channel (or Smart Cloud) and collection which contains the video(s).

Channel; Neil Melville ~

Collection; |Don Wimble collection ™

3. Select the desired videos then click the Download button
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# Name State

1 Don Wimble ”Downloading

Don Wimble

View Online

Add to Tray Cancel All Clear

4.4  The next steps

This lesson covered ways to import video files or record a video stream.

If continuing your journey through Dartfish Help then you might want to learn how to capture video
'live’ using the InTheAction Module (read chapter Live capture & instant replay during training).

Dartfish is also able to share video by producing Media Books from the Analyzer module.

© Dartfish. All rights reserved.
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5

5.1

Live capture & instant replay during training

The InTheAction module is a combination of Dartfish capture, replay, comparison and analysis
features brought together in a way that allows the delivery of video feedback during training
sessions.

The aim here has been to make the technology easy to use without the presence of a computer
being disruptive to training itself. Some of the key features which allow this to happen are:

» Remote controlled - for complete ease of use, a single button on the remote control can control
both capture and replay.

» Simplified video capture - in automatic mode only trigger capture at the start of the action. A
fixed number of seconds is captured from this point.

» Automatic instant replay - replay happens automatically as soon as capture is complete. Pause
and set replay speed by remote control.

» Comparison - compare captured clips side by side with a reference clip.

» Synchronization - synchronization of clips is based around the moment when you trigger
capture making comparison of 2 clips both easy and quick.

» Drawing/annotation tools - illustrate coaching points using a range of drawing tools

In this chapter

» Preparing InTheAction for use

Instant visual feedback during training
Comparing clips during training

Using drawings in InTheAction

Self coaching with live delay

vV V V V

Preparing InTheAction for use

At the start of your coaching session using InTheAction you will spend a short time preparing it for
use. Of course you'll need to connect the camera, perhaps more than one camera, also in this
section you will learn to adapt the Record and play parameters according to your specific needs.
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5.1.1 Selecting capture device

IMPORTANT NOTE: About using video devices with InTheAction

InTheAction works by establishing a link that allows live images to pass directly from camcorder to
computer. For this reason it only works with camcorders and devices capable of providing a video
stream. Tapeless camcorders do not offer this functionality.

It is still possible to use InTheAction with these camcorders in conjunction with converter hardware:
the camcorder's video output to TV is connected to the converter which creates a digital video
stream which can be used by Dartfish. Converters can be used with analog and HDMI video
sources.

Further advice on sources of video can be found in the topic Video Recorder: capture a video
stream

The latest advice on the use of camcorders and other imaging devices can be found on the
support section of our website.

The information below applies equally to DV camcorders and other video streaming devices.

Setup capture devices

After connecting the camera, the next step is to launch the InTheAction module and select your
camera as its video input. To launch the InTheAction module click on the InTheAction button on
the toolbar:

InTheAction

InTheAction module has two tabs at the top of the module:

E.ﬁ'.‘ Setup Input Devices [ E InTheaction

> Setup Input Devices page - to select the capture device(s); choose the appropriate device
from the drop-down list. Once selected, you should see the images transferred from capture
device (camera).

¥ Capture Device

Tﬁ' Select capiure device \%
%

i
-

If your device is not listed, make sure that your equipment is correctly connected (see Video
Recorder in the Video Library chapter), switched on and has not automatically switched off - many
cameras do this after a fixed interval. Taking the tape out of the camera prevents automatic power
off every few minutes.

Usually input device selection is only required the first time you connect your camera to your
computer. Itis necessary if there is more than one input device or if several different cameras are
used.

> InTheAction page - is where the capture and replay features are found. Click on this tab once
you have selected the capture device.
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5.1.2 Using more than one camera

InTheAction can record from up to two cameras simultaneously, for example, rear and side view of
a runner on a treadmill. InTheAction allows simultaneous replay of both clips.

Choosing multiple video inputs

1. Open the Dartfish options, select Tools > Options from the Menu bar (F3).
L] Options
1] = " o @

General Library Enceding Profiles Analysis | InTheAction | SimulCam  StroMetion  Metwork Cameras  Add-Ins  Advanced

Number of capture devices: 1 (default) L
1 (default
2 (need identical device type)
Synch Point Label: Synch Point
Display information on screen Configure Display
|:| Use a Replay Seguence Configure Replay Sequence

Help Cancel Apply

2. Select the InTheAction options

3. From the Number of capture devices section, select 2 (need identical device type) option -
Identical devices are recommended because it requires much more computing power to
process video from different hardware.

Setting up multiple video inputs

1. Launch the InTheAction module.
2. Select the Setup Input Devices tab.
3. Select the second camera from the corresponding drop-down list
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g Setup Capture Devices ‘ InTheAction

Bl B No device - No device

Camera Mame: | Camera 1 Camera Name: | Camera 2
Synchronize Devices

* Capture Device 1

Tﬁ‘ Select video capture device bt

»

1. | Select audio capture device

* Capture Device 2

T_ﬁ." Select video capture device v

*®

1. | Select audio capture device

¥ Pre-Record Buffer

4. Optionally, a name for each camera can be provided in the Camera Name fields found
immediately below the video display. These names will be included in the file names of

recordings.
5.1.3 Defining recording settings
Recording settings can be found below the video display of the InTheAction module. Here, Clip

properties such as file name, Recording options such as Prerecord and Recording folder can
be defined.

Clip properties

+ (lip Properties

g__l File name: | US champicnships 1968 |

Athlete: Bob Bearmon w|
Sport: Long Jump v X

Add keyword category  Apply to last recorded clip

If you intend to keep the recordings that you make when using InTheAction you should take a

moment to define the Clip properties which will be assigned to the video files that are saved. The
clip properties are:
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File name - Your video files will be saved with the file name entered in the text box.

» Category/Keyword(s) - Keywords are both searchable and filterable in the Dartfish Library
and they add additional description to the video which may be undesirable or impractical to
include in the file name. Click the Add keyword Category link to build a categories form which
can be completed for each recording - either by selecting keywords already in the Library or
typing new ones. See Organizing your library in the Video Library chapter for more information
about the use of keywords.

Y

Once defined, these properties will assigned to all subsequently recorded clips, until a new file
name or keywords are specified. If more than one file is recorded using the same File Name
property, Dartfish will automatically suffix each file name with a number in order to prevent one
recording from over-writing another.

Recording folder

* Recording Folder

& ChUsers\Neil\Videos
] 131 GE free of 372 GB ( 3 min 39 sec)
Change recerding felder  Open recording folder

The default setting is for recordings to be saved in the Windows Videos folder. Click the Change
recording folder link to specify where recordings will be saved on your computer.

Titis highly recommended that the Recording Folder should be on a local drive with sufficiently
fast write speed. For example a folder on a network or a low speed SD card may not be able to

save video data sulfficiently quickly to capture effectively. The result is dropped frames and jerky
video.

Recording duration

* Recording Options

B - . 0 =
i, Live Delay [s]: =

Pre-Record Duration [s]: [ E 5

Recording Duration [hh:mmess]: | ] 00:00:05 :

Recording duration is one of three properties in the Recording options section. Setting a
recording duration allows you to make recordings using a single button click - you start recording
and Dartfish automatically stops after the set time. This is useful when recording closed skill
activities where the duration can be predicted. For example, for a golf swing, a recording duration
of 3-4 seconds might be set. For gait analysis, a recording duration of 6-8 seconds might be set.

To use a fixed recording duration:

1. 'Tick' the box next to the time
2. Click on the hours, minutes or seconds figure that you wish to adjust (most likely seconds!)
3. Type a number or use the scroll buttons to set a time

Pre-record duration

Pre-record forces the computer to continually store a specified amount of video in its memory
(RAM). When recording is started the stored video is included at the beginning of the new clip.
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This is really useful in many situations where it is difficult to predict when a performance will start
or a particular action (e.g. an error) will take place. For example, if you wait until you see a golfer
start to move before starting to record, you may miss the first moments of the swing. If you try to
second-guess when the swing is about to start you may start recording to early. The amount of
prerecord required might be one of these possibilities:

» 0 seconds - if the action is easily predictable or cyclical such as treadmill running, cycling etc

» 1-2 seconds - to account for reaction time (both your's and the computer's) if you start
recording as the action begins

» Equal to, or greater than, the recording duration if you intend to first watch the performance,
assess whether it is worth recording then start to record

» At a useful comparison point, or synch point - The moment when you start recording creates
a synch point on the video. Synch points are used to easily synchronize video clips for
comparison (see Comparing clips during training ). For this reason it may make sense to trigger
capture at an obvious point for comparison e.g. when the club strikes the ball as shown in the
following diagram.

Duration

Preroll
| 2

Start capture

@ The largest amount of Pre-Record that can be set is limited by the amount of available memory
allocated to Dartfish. This can be modified. See the topic About pre-record buffer

! Remember that the recording duration always defines the length of the clip, irrespective of the
pre-record value. If the recording duration is 5 seconds and the pre-record duration is 2 seconds,
the clip will be five seconds long, not seven seconds. Two seconds of recording will take place
before recording started and three seconds afterwards.

Live Delay

See the topic Self coaching with live delay

5.1.4 Defining areplay sequence

Once you have captured a video clip, the InTheAction module will replay it automatically based
on the criteria defined in the Replay Sequence.

By default, no scenario is used for the replay sequence and replay speed is manually controlled by
the user. Defining a scenario automates this.

Creating a replay sequence
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In the following example, an 8 second pause allows the athlete to join the coach at the computer
screen, together they then view the clip once at full speed and then in slow motion. To create such
a scenario:

Display the InTheAction options (Tools menu > Options > InTheAction).

Activate the replay sequence function by clicking the Use a Replay Sequence check box.
Click the Configure Replay Sequence button

Click the Add Pause button and set the Duration.

Click the Add Replay button and set the Speed to x0.25.

The Replay Sequence is ready to use and appears as shown in the following image.

ok wbhpE

] Options

Had @« T[E|&£ # @ 1 E)

General Library Encoding Profiles Analysis | InTheAction | SimulCam  StroMotion Metwork Cameras Add-Ins  Advanced

Number of capture devices: 1 (defandt) b
Synch Point Label: Synich Point

[+] Display information on screen Configure Display

[+] Uise a Replay Sequence Configure Replay Sequence

Configure Scenario

Add items to the Replay Sequence. Set speed for each Replay and duration of Pauses.

Pause 8s Add Replay
Play x1.0

Play x0.25 Add Pause

Remave
Move Down

Duration: | 3 - seconds
Help [ Switch to Live view at scenario end
O Cancel

@ When using a replay sequence it is still possible to control playback (pause, play etc.) by the
other video playback controls and remote control.

5.1.5 About pre-record buffer

By default, Dartfish uses half the available RAM memory to store pre-record. If you are unable to
set enough pre-record it is possible increase the memory buffer reserved for pre-record.

To increase Pre-record buffer

1. Select the Setup Capture Devices screen of InTheAction .
2. Drag the slider to define the size of the buffer.
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¥ [Pre-Record Buffer

A ——

Pre-Record Buffer: 355 MB ¥

The blue section shows the memory being used by other processes, the green section shows
the memory dedictated to pre-record. The green section turning red is an indicator that more
pre-record buffer than is advisable has been set. This is liable to affect the performance of
Dartfish and other functions of your computer.

5.1.6 Advanced InTheAction settings

In addition to the settings defined within the InTheAction module, there are some advanced
settings in the Dartfish Options (Tools menu > Options > Advanced). This topic does not seek to
cover these comprehensively but instead will focus on the Capture Options which may further
enhance how you integrate video feedback into your instruction.

[ Options “
0 & T K £ * @ DIE

General Library Encoding Profiles Analysis InTheAction SimulCam StroMotion Metwork Cameras Add-ins | Advanced

#| Display shortcuts in Tagging Panel (Enabled by default) A
| Automatically check for update (Enabled by default)
| Importer
¥ F’Iayhack the tape when recording is started
Pause the tape when recording is stopped
] InTheaction
V| Persist reference between different sessions
7] Miirror Axes
+| Horzental Flip
Vertical Flio
7] Capture Options
V| Immediate replay after capturing
Automatic switch to blank when capturing
¥ Automatic keep when captured
Metadata suppert Uptions
Recerve, record and save metadata
| Use overlay drawing repository,
| Save embedded drawings

] Analyzer
+| Reset video drawing when opening 2 new video
Start in split-screen mode when creating a new project
¥| Load embedded drawings
4| Add item to tray
< Enable loge in Analyzer Recorder
7] Publishing
| Estract metadata

Help [ ok Cancel

» Immediately replay after capturing - deselect this option if you prefer to make several
recordings before reviewing. Particularly useful if you wish to prevent video distracting the
performer and/or you wish to leave the display blank or showing a reference clip.

» Automatic switch to blank when capturing - select to disable replay during recording. This
may be useful as confirmation that recording is taking place but its main function is to reduce
the processing load on the computer by focussing on recording rather than replay.

» Automatic keep when captured - deselect to prevent video being saved automatically if this is
not required. Videos can be manually saved with the Keep button below the video display or on
the remote control.
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5.2 Instant visual feedback during training

Once you have defined the InTheAction settings (see Preparing InTheAction for use), you can start
using the InTheAction module. These are the steps:

1.

2.

w

If using the remote control (see Remote controlling InTheAction), use full-screen view (type
F11). Recommended to give the largest possible video image.

Capture a video clip.
The clip automatically replays.
Repeat for the next action

5.2.1 Recording and replaying

Recording

1.

The video image from the camera should be visible when using InTheAction's Live view. The
choice of views is controlled by the buttons at the top left of the module:

8 Live view - shows the image from the camera

B Simple Replay view - shows replay of the last captured clip or any clip opened from the
Tray.

2% Blank view - blanks the screen (prevents it being a distraction!).

18 Comparison view - compares the replay clip with the reference clip.

B Reference replay view - shows replay of a reference clip.

It is not necessary to be in Live view to record but for the first recording, it gives guidance that
the camera is pointing in the right direction.

Click on the red Record button or use the equivalent remote control button (see Remote
controlling InTheAction).

During recording, the icon on this button will change to a flashing red square (Stop Recording)

Click the button again to stop recording

This step may not be necessary if a recording duration has been set (see Defining recording
settings ).
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Viewing
Once you have captured a clip, replay will start automatically.

Replay of the clip can be controlled by using the playback control, or by using the equivalent
remote control buttons (see Remote controlling InTheAction). Read the Getting familiar chapter to
learn the functionality of each button.

Lk |

. i = A4 My L i

You are not restricted to replaying the last captured clip. Any of the previously captured clips will be
found in the Items List or Tray of the Library. In fact any clip from your library can be played in
InTheAction, enabling you to show reference clips as well as recordings.

You can also use the Next clip and Previous clip buttons on the playback control to move
through the content of the Tray. This enables the full screen view (F11) of the video to be
retained and can also be remote controlled.

@ At any point you can capture again. It is not necessary to switch from Replay view to Live view
to initiate capture.

5.2.2 Remote controlling InTheAction

Because InTheAction is a tool for use during a training session you shouldn't be a slave to the
computer! Now is the time to install the remote control (see Remote controlling Dartfish in the
Getting familiar chapter) and learn to use its features.

As has been emphasized several times in this chapter already, all commands covered in this
section can be executed by remote control: Either the Streamzap issued with Dartfish prior to
version 6 or the App version for iOS and Android devices:

Steamzap IR remote control Jumi remote for iOS and Android
devices
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Full Sereen Switch Wiew

Set as reference Feed Switch

Toggle Grid Togqgle Delay
Toggle Mirror

Increase Speed Reference Replay

Decrease Speed

Simple Replay B
Start Capture

Blank Live
Comparison
Set Synch Points Keep
Stap

Pause

Start Capture

Play
Step Backward
Step Forward

Play Previous Play Next

Pictura-in-pictura
Basic Blend

Single Mode
Split Mode

5.2.3 Using a sound trigger

A sound trigger can be configured to start recording in reaction to, for example, a club or bat
striking a ball, a starting klaxon or even a voice command.

To use the sound trigger it must be activated and then configured to respond to the correct volume
of sound.

Activating the sound trigger
Before use, the sound trigger must be activated. To do this:
1. Select Tools > Customize... from the Menu bar.

2. Select the Remote Control tab.
3. Tick the box next to sound trigger to activate it.
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Server Contral Device

il |IRkan Remate Device  Philips Universal

k Sound Trigger 5T mapping
fE):, e e
Streams ap Stream Zap

4. Close the Customize window. It is not necessary to configure the trigger at this stage.

Configuring the SoundTrigger

1. From the menus select Tools > Configure SoundTrigger...

Tools  Help
Options... F3
ConFigure SoundTrigget... F4

Customize. ..

» Hardware configuration. The input device will generally be set to "Microphone". Your
computer will need to be equipped with a built-in or external microphone.

» Detection configuration. Select the profile that is a closest match to the type of sound
used as a trigger then adjust the Sensitivity slider to an appropriate level; where incidental
sounds do not trigger capture but the trigger sound does. Both the hit counter and the
Sound Trigger Server Status will help you assess which sounds do and do not trigger.

2. Close the Configure SoundTrigger Properties window. The sound trigger is now active and
can be used as a method of triggering InTheAction capture.

! The sound trigger reacts to the volume, not the words spoken or nature of the sound. Therefore
sound triggers will only work if louder than other incidental noise.

5.3 Comparing clips during training

It may be beneficial to compare the last captured clip to a reference clip when working during
training. You have the choice to display both clips side by side, blended together or in a picture-in-
picture mode.

[ Pl £ e

The steps to compare in InTheAction are to:

1. Define (set) a reference clip.
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2. Activate the Comparison view and capture a clip. The captured clip is automatically compared
to the reference clip

3. If needed, synchronize the last captured clip with the reference

Setting a reference
To set a reference clip, proceed as follows:

1. Load a clip from the Tray or from the Library items into the InTheAction module
2. Click the Set Reference button found below InTheAction playback controls.

<> Set Reference

@ You can also use any other clip already saved on your hard drive as a reference clip.

Viewing the reference clip

The reference clip can be viewed at any time by clicking on the Reference replay button.

To work with comparison view, click on the Comparison view button on the left edge of the
InTheAction module.

The screen display will be split in two, the reference clip on the right and on the left the last
captured clip.

Using Comparison view

1. Capture a video clip.

2. Atthe end of the capture, the clip is automatically displayed next to the reference clip.
3. Use the playback buttons to control the replay

4. Choose a comparison layout:

m Split Screen - where the clips will be displayed side-by-side.

& Basic Blend - both clips will be superimposed on top of each other.

b picture-in-Picture - the reference is displayed in the corner of the replay clip.

5. For Blend view the degree of transparency of each image can be controlled by moving slider

on the blend control ... l from one side to the other

Synchronizing clips InTheAction

In order to effectively compare two clips, they must be showing comparable behaviour, for
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example, you can't compare two divers if one is at a different point in the routine. Synchronizing
clips is often unnecessary with InTheAction because a synchronization point is set when capture is
triggered. Provided that you always trigger at an obvious moment each time you capture, clips will
always be synchronized.

1. Activate the Replay view.
. Find the moment on the clip that is to be the synchronization point.

2
3. Click Y. Set Synch Point '
4

. Repeat for the reference clip if necessary (use the Reference replay button to display the
reference clip).

Alternative synchronization method

It is not always necessary to switch between Reference and Replay views as described above.
Here is an alternative method:

Set up the comparison as described above

Click the first video image (the timeline below the video will be color-coded blue)

Find the synch point position in the video

. ¥ i
Click == Set Synch Point

Click the second video image (timeline color-coded green)
Find the synch point position in the video

. ¥ :
Click == Set Synch Point

© N o0 s~c WDNE

Click Play button

5.4 Using drawings in InTheAction

The drawing toolbar

The right-hand side of the InTheAction module has a range of drawing tools which can be used
to annotate video images, assist with analysis or coaching. The use of these tools is identical to
the Analyzer module's drawing tools and is explained in that chapter.

About drawing overlays

One unique feature of INnTheAction is that it is possible to create up to nine drawing overlays.
These allow you to choose different drawings for use at different points in the video or reuse
drawings from one InTheAction analysis to another.

To create and use a drawing overlay

1. Select one of the overlays from the Overlay button found below the video display
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Manage Overlay Template Repository
Manage Metadata Repository

Overlay #9
Overlay #8
Overlay #7
Overlay #6
Overlay #3
Overlay #4
Overlay £3
Overlay #2
Owverlay #1
IZ‘ Embedded overlay drawings

& Overay

2. Add drawings to the video image
3. Selecting an overlay displays its drawings on the current video

Manage overlays
Overlays can be renamed or deleted. To do this:

1. Click the Overlay button

2. Select the Manage Overlay Template Repository option
3. Select an overlay from the list

4. Click the Rename or Delete buttons

Embedded overlay drawings

The Embedded overlay drawing overlay is a special overlay which only displays drawings used
as the recording was made. Consider this example:

» You add a line to Live view in order to aid observation of an axis of motion of a performer or
the swing plane of a golfer.

» Now you record the performance

» The drawings you added are now automatically stored in the Embedded overlay drawings
overlay

Embedded overlay drawings are special in another way - they form part of the metadata (
dartclip) of the video. This means that when a video recorded in InTheAction is viewed in the
Analyzer, its drawings will be visible

! This feature was actually designed to enable the simultaneous recording and display of data
captured from external devices (TeamPro Data edition required). Although you may find other uses
for it, bear in mind that drawings embedded in this way cannot be modified in the Analyzer. If this
proves to be more of a help than a hindrance, the feature can be disabled in the advanced options:
Tools menu > Options > Advanced > InTheAction > Save embedded drawings (deselect)

@ Remember, drawings can be hidden at any time by clicking the Show/Hide drawing button on
the drawings toolbar
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5.5

5.6

Self coaching with Live Delay

Live Delay provides a completely hands-free way of reviewing video during training which makes it
especially useful for self-coaching. It simply delays the display on the computer screen of the
images that the camera continuously observes. It's like a mirror but one that waits a predefined
number of seconds before showing your reflection. Enough time for the athlete to finish a routine,
drill or exercise then assess how he or she performed.

For example, a coach might explain adjustments required using the range of InTheAction features
explained earlier in this chapter and then leave the athlete to practice, using Live Delay to confirm
the adjustment is being executed correctly.

To use Live Delay

1. The InTheAction module is activated and video input set up as described previously (see
Preparing InTheAction for use).

2. Determine the amount of delay required. For example a golf swing takes, say 2 seconds, add
another couple of seconds as a margin for error, then it might take a further 5 seconds to get to
a position to view the computer display after the swing - the ilve delay requiredis 2 + 2 +5=9
seconds

3. From InTheAction's Recording Options change the Live delay value. The largest amount of
seconds you can set is related to the amount of available RAM memory of your computer. It is
not necessary to change the Pre-record or Recording duration settings as they do not affect
Live Delay

4. Click on the Live Delay view button.

D

5. Press F11 on your keyboard to have a full screen view (press F11 again to leave full screen).

6. That'sit! No button presses, no files recorded, no comparison, no pause or replay. Just a
simple tool to help with self coaching.

@ Using live delay doesn't prevent the use of other InTheAction features. As soon as the capture
button is pressed/clicked, capture begins according to the pre-record and duration settings and
replay commences straight away. However, recordings are made of what is coming through the
camera lens and not what is happening on the screen - always refer to the live action when
triggering recordings.

Next steps

InTheAction allows you to review and compare performance while training takes place but to
review these performances at a later date you should learn how to load, synchronize and compare
clips in the Analyzer module.

The Analyzer module will also allow you to publish your clips into a Mediabook; a remote coaching
tool complete with audio and text guidance (read the chapter on the Analyzer).
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6 Analyzing Performance

Dartfish's Analyzer module is packed full of features to help observation and understanding of
movement. This chapter guides you through these allowing you to:

Compare video - Up to 4 clips can be compared side by side and 2 clips can be blended. lItis
quick to synchronize clips to make the cation contained comparable. You are not limited to just
four clips in your analysis as a project can contain multiple analyses in its Storyboard.

Annotate video - A collection of drawing and note tools help enhance observation, make
measurements of distance, angles and time and add text to video clips. Tools exist to enhance
the effectiveness of drawings such as automatic tracking and fading them in and out at relevant
positions in the vide clip. Text or audio comments can added to an analysis to create a lasting
record of your analysis and to save time, previous comments can be imported from previous
analyses.

Identify important moments - Key Positions can be identified and drawings and comments added
to them. Each key position can also be a synchronization point, allowing more than one
synchronization in each comparison.

In this chapter

> Analyzer workspace

An analyzer project - the Storyboard
Enhancing images

Drawing on the video

Adding written and audio comments
Analyzing key positions

Comparing performances

Key position mosaic

VVVYVYVYVYVY
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6.1 Analyzer workspace

The Analyzer workspace is illustrated below:
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Golfswing side PAL Golf swing front PAL

Storyboard Item Information: Untitled, 7 sec, 2 item(s)
Description: g 9 :
- Sy X
Kepwords A
Video type: PAL v L. Microphone (2- Rode Podcaster) W | | Mast

Its main constituents are:

1. Video display - to display the clip(s).

2. Timeline - for visual identification of the current video position; to control the playhead position
and set the cue in/out points to define the playable part of the video.

3. Play controls - (underneath the timeline) to control the video playback.

4. Display buttons - (top-left) to change the screen display. You can select among Single-screen,
Split-screen, Blend and Mosaic modes. The A, B, C and D buttons show/hide up to four
loaded video clips: In split-screen modes, they are used to select between up to four clips to
display simultaneously.

5. Image Enhancement tools - (underneath the C, D buttons) to align, zoom in/out or flip the
images.

6. Drawing tools - (on the right) to draw on the video.

7. Storyboard - (underneath the play controls) contains the different analysis of an Analyzer
project.

8. Publishing - (on the right of the storyboard) to publish your analysis on different media (CD, e-
mail, printer, Internet) or to create a movie of the Storyboard.
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9. Description - (at the bottom) to add written and audio comments. To see this area it may be
necessary to resize the panel. This is done by click and dragging its top border using the
mouse shape shown in the following illustration.

P = LT

Storvboard | Keyw Positions | Timeline

Analysis panel features

The bottom part of the module consists of a multi-page panel and, depending on which edition of
Dartfish you have the following pages can be seen :

Storyboard | Kew Positions | Timeline | Data Graph | Analvsis Recorder

» Storyboard - An analysis is likely to comprise of several videos, or even several analyses. The
Storyboard allows all to be collected in one place. For example, a Storyboard might contain
videos showing before, then after, instruction and also a split screen comparison of both.

» Key Positions - Much motion analysis in concerned with the static as much as the dynamic.
Key positions bookmark these moments of interest within the video, enabling observation and
annotation. Key Positions can also be published as pictures, complete with any drawings
added.

» Timeline - When one video is loaded, this page offers a more detailed view of its timeline.
When multiple videos are loaded, the timelines of all can be seen together, to aid
understanding of the position of one video relative to others

» Data Graph - used to display a graph of data linked using a Dartfish Data Reader or data
captured from a data stream from devices such as devices such as radar, heartrate monitors,
force platforms etc. Data Reader data is linked to the video and Dartfish TeamProData edition
is required to both link data and view linked data. When a data stream is captured, the data is
stored in the metadata (Dartclip) of the video and, while Dartfish TeamPro Data is needed to
capture the data, all editions can be used to view it in the Data Graph.

» Analysis Recorder (Pro editions) - used to create a new video based on your audio
commentary and on-screen actions. To understand this feature, imagine delivering feedback or
instruction using video; the analysis recorder records everything that you say and do.

6.2 An analyzer project - the Storyboard

The Storyboard can contain multiple videos and analyses that constitute an Analyzer Project.
Each item in the Storyboard corresponds to one analysis. For example, you could analyse swings
of a students captured during a training session, one from the front, one from the side and one
from the front compared to a reference swing, as illustrated below.

Storyboard | Key Positions | Timeline | Data Graph | Analysis Recorder

.

Fromt Side Compare

Each analysis may include drawings and audio commentary. All this is saved in your Analyzer
Project along with the videos.

Your project can be:

» Re-opened later to modify/add analysis elements (e.g. add a fourth swing, modify a drawing,
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6.2.1

etc.)

» Publish to different destinations (e-mail, CD, printer, internet) to be handled out to your student/
athlete (see Publishing Analysis).

Loading clips

Clips can be loaded as multiple clips within a single analysis or as a new analysis.

To load a clips into an analysis

1. Select the mode to be used for the analysis (Single screen, Split-screen etc)

2. Click the A, B, C or D video display buttons to select a video display or to display the required
number video displays in Split-screen mode.

3. Double click a video clip in the Items List or the Tray of the Library to load it into the first
display then repeat for the other displays

@ You can also drag & drop a clip onto any video display. This offers greater flexibility over which
video display is used. This method can also be used to replace a previously loaded clip.

To add a new analysis (i.e. a new Storyboard item)

Drag & drop a video from the Items List or Tray onto a vacant position on the Storyboard.

Storyboard | Key Positions | Timeline | Data Graph | Analysis Recorder

 imenz

To delete an analysis (i.e. delete a Storyboard item)

Right-click on the Storyboard item and select Delete from the quick menu.

Iniaki(Z)

To clear the entire Storyboard

Start a new project (File>New from the menu bar) to clear all items from the Storyboard.
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6.2.2 Playing clips

Once a clip is loaded you have the ability to control the playback (play/pause, stop, frame-by-
frame, etc.). This can be done by using the playback controls buttons and the timeline underneath
the video screen.

K :

!

b = a4 e WA NG o 0.2 g 1

The functions of the buttons are the same as for the Player module except for Play next/previous
clip and the Repeat mode which applies to items of the Storyboard rather than items of the Tray.
Read the Video Playback section in the Getting familiar chapter to learn more.

6.2.3 Saving an analyzer project

Select File menu > Save (or File>Save As...) from the Menu bar to save a project. Analyzer
projects can be identified by the following icon.

@ifa project is saved in a Monitored folder of your Library (see section Defining your library in the
Library chapter), it will be displayed in the Items List.

To open a saved project

» Double-click on the project in the Items List OR...
» Select File>Open from the Menu bar.

To start a new project

Select File > New from the Menu Bar.

! Starting a new project empties the Storyboard. Be sure to save the previous project when
prompted if this work will be required in future.

6.3 Enhancing images

Enlarging the video image (zoom)

Dartfish's Analyzer allows you to zoom in or out on an image to better see the details of a
particular moment. There are several ways to zoom in/out:

» Use the Maximize height of clip button at the bottom of the video display (3rd button in the
illustration below). When selected, the video is enlarged to occupy the available height of the
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display (to do this the left and right edges of the video may be hidden).

00:00.408 / 0002880 @ g T W =

» Use the Display video fullscreen button (right-most in above image). The video is displayed
in full screen (press ESC on your keyboard to return to normal view).

» Click on the Zoom Tool button, position the mouse cursor over the part of the picture that you
want to zoom on and left click (right click to zoom out).

b

» Click anywhere in the Analyzer's screen and use your mouse scroll-wheel. The image will zoom
towards the location pointed by your mouse cursor.

Re-aligning & repositioning video
Once the image has been zoomed in, you can move the zoom focus in two ways:

1. Click on the Move tool button
2%

2. Click and drag the video image using the mouse.

Zoom options

Clicking on the Zoom Tool button displays options at the top of the Analyzer's screen:
W P2 R 1w M
From left to right, the buttons give access to the following function:

» Reset Zoom - resets the zoom factor to 100%

» Zoom In - each click increases the zoom factor by 20%

» Zoom Out - each click decreases the zoom factor by 20%

» Zoom Factor - set the zoom factor by selecting it from a predefined list

» Quick Magnify - changes the mouse cursor to a magnifier to quickly point to details.

! You can change the zoom factor inside the Quick magnify tool by using your wheel mouse. [shift]
+ wheel mouse will modify the radius of the magnifier.

Flip a clip horizontally or vertically

To get a new perspective on a clip, you can flip it horizontally or vertically. To do this, click the
Flip Horizontal or Flip Vertical button.

x|

The button appears as "pushed". You can flip the image horizontally and vertically at the same
time.
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6.4 Drawing on the video

Dartfish allows you to draw objects and add text on top of a clip's images. Use qualitative
drawings (e.g. lines, circles, rectangles, etc.) to highlight details. Quantitative tools (angles,
measurements, etc.) can be used to extract data from the video.

The Drawing Toolbar

Use the following toolbar to draw and write text on the video.

(] rgy Drawing management tools - to select, show/hide, delete, and undo/redo
D l'I'_ drawings.

i)
A B Video Drawing vs. Screen Drawing - two modes to draw on clips.
1. Inthe Video Drawing mode, your drawings are associated with the selected
clip.
2. Use the Screen Drawing mode to draw across the Analyzer's screen or add
drawings which are independent of the video
® Drawing tools - the various tools to draw on the video. Most of these tools are
o self-explained. Read the remaining of this section to learn about the more
T = advanced tools.
Lo
= .
@-n‘ @‘

The tiny black marking on the lower-right of a drawing tool indicates that other tools of the same
type can be accessed by a mouse right-click, as illustrated below:

[ .\l‘: +  Marker
H—H‘ * . Line
@_n ,‘-J Spline

6.4.1 Adding and modifying drawings

To add a drawing

1. Select a drawing tool

2. Position the mouse cursor on the image at the point where you want to start drawing
3. Left click, hold and move the mouse to the end point

4. Release the mouse button

! Although you are drawing on a single frame of video, the drawings will be displayed for the entire
clip. Use the key position analysis (see Analyzing key positions) if you want to apply different
drawings to different frames. It is also possible to fade drawings in and out so that they only appear
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for part of the clip (see Fading drawings in and out).

@ Holding down the [shift] key "constrains" drawing, e.g. to draw a horizontal line, a square, a
circle, a 90 degrees angle, etc...

By default, selecting a drawing tool lets you draw a single object. If you would like to draw the
same object many times (e.g. multiple lines), select the currently selected tool a second time. A
vertical gray mark appears on the tool and indicates that you are in a "repeat drawing" mode.

To leave this mode, click the selected tool a third time or select another one.

To modify a drawing

1. Click the Selection button (top-left of the drawing toolbar).

2. Click on the object you wish to select. White handles appear on the object, as shown in the
image below:

3. If you wish to select multiple objects, hold down the CTRL key as you select additional objects.
4. Once the object(s) is selected, you can:

» Drag a handle to change the size or shape of the object.

» Click and drag the selected object to another location.

To delete drawings
> Use the Delete All button

[3

» Select a drawing and press the [delete] key or use the Delete button
(3

» Use the Undo/Redo buttons to go back to the previous state

i)

6.4.2 Drawing properties

You can change the thickness, color, opacity, size and other properties of the drawings. The
drawing properties bar is displayed at the top-right of the Analyzer screen

EHEE % Ipx = e
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To modify a property:

1. Click on the drawing to select it.
2. Click the button that corresponds to the property you want to modify.
3. Select the different value/color/font.

Using drawing presets

The 1, 2 and 3 buttons correspond to properties presets. Left-click on these buttons to apply a
preset.

To create or change a preset:

1. Draw an object
2. Modify its properties
3. Right-click one of the 1, 2 or 3 buttons.

6.4.3 Clone rectangle

The Clone rectangle tool allows you to “clone" and magnify an area of the image. Play the video to
visualize both the magnified area and the performance in its whole (picture-in-picture effect).

To use this tool, proceed as follows:

1. Select the Clone Rectangle drawing tool

[~

Click, hold and move the mouse cursor to draw a rectangle around the area you want to clone.
Click and drag the cloned area to the location you want

Use the white handles to magnify the cloned area

Click anywhere in the image (except the drawing itself) to deselect the cloned area.

S A
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6.4.4 Picture

You can import a picture and overlay it on top of the video. You can use for example this function
to insert your logo or to compare a key position to a reference image.

To add a picture

1. Select the Image drawing tool. The Open Image dialog opens.
=

2. Browse for the image on your disk and click on the Open button. The image overlays on top of
the video screen.

3. Change the size of the picture by dragging the white handles. Hold down the SHIFT key while
doing this to constrain the proportion of the image. You can also click and drag the image to a
different location.

! If the image width is larger than 360 pixels, it will automatically be resized to this value.
@ Iif you load an image in Screen Drawing mode (see Drawing on the video), it will always be

overlayed at the same location in the video. Use this, for example, if you want your logo to be
displayed always at the same location.

@ Drag and drop an image from the Items List of the Dartfish Library as a quicker way of adding a
drawing

6.4.5 Measuring angles

The image below illustrates the Angle tool.

To add an angle:

1. Right-click on the measurement tools group and select Angle from the context menu.

© Dartfish. All rights reserved. - Version 9 - DARTFISH=%



Analyzing Performance 100

6.
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@_n H¥ Distance

= ﬁj Angle
OG Reverse Angle
E Data Table

Position the cursor on the image exactly where you want the corner of the angle to be.

Left-click, hold and move the mouse cursor (in the image above, click on the club head and
move horizontally). A line draws as you move the mouse.

When the line extends to where you want the angle to open, release the mouse button.

Move the cursor up or down to create the desired angle. The number of degrees of the angle is
shown as you move the mouse.

Click the mouse when the angle is the desired width.

! You can modify the line thickness, colors and font (see Drawings properties).

@ Hold down the [shift] key while drawing to constrain the angle to 0, 45, 90, ... degrees.

6.4.6 Measuring distances

The image below illustrates the Distance tool.

Distances are only precise in a plane perpendicular to the camera. You first have to calibrate this
plane by defining a reference distance. To do this, put an object of known length at the position
where the movement will be performed (the width of the mat in the above example).

To measure distances, proceed as follows:

1. Right-click on the measurement tools group and select Distance from the context menu.

(@]e @ Tine

@_n M Distance

= S Bngle
OG Reverse Angle
E Data Table

2. Click, hold and move the mouse cursor to draw the reference distance (the one with the

dashed line in the image above)

3. Right-click on the reference distance and select Set as reference... from the context menu.

The following dialog opens

DARTFISH== - Version 9 -
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Measure reference

Reference value: 1.00 m

Cancel

4. Enter the size of the reference object.

5. Select the Distance tool again and draw the distance (vertical line in the example above). It will
be computed based on the line length and the reference value.

% The measurement precision relies on many factors such as the distance between the camera
and the performer, the camera zooming factor, the precision of the perpendicularity between the
camera axes and the plane in which the movement is performed, etc... Try to be as precise as
possible when setting the reference distance. For example, use a well defined and distinct marker
on the floor and use zoom tools to enlarge the image when setting the reference distance.

6.4.7 Measuring time

Dartfish allows you to use one or more timers

» to estimate the duration of a performance,
» to measure time in different sections of a performance/race,
» to estimate/compare different time/speeds.

The timer displays the time in minutes:seconds.milliseconds (mm:ss.000). Its precision is function
of the number of frames/sec of the video i.e 0.02 seconds if the frame rate is 50 frames/sec

To add a stopwatch

1. Select the Time drawing tool

)

2. Click anywhere in the image to insert a timer. Use the drawings properties (see Drawings
properties) to modify the color and font.

To reset a stopwatch

The timer displays the current position of the playhead at the moment it is inserted in the image.
To set the time to 00:00.000:

1. Right-click on a stopwatch (that has already been placed in the image)
2. Select Set timecode to 00:00 in the context menu
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6.4.8

To start/stop timimg

You can start and stop counting in a section of a performance/race. For example, you may want to
compute the time from gate 1 to gate 7 in a giant slalom to compare performances in this
particular section. To do this:

1. Position the playhead at the position you want to start counting

Set timecode to 00:00 (optional)

Right-click on a timer and select Start counting

Position the playhead to the end of the section

Right-click on the timer and select Stop counting

o wbd

Tracking objects manually (Spline)

You can draw trajectories by manually tracking object in the video clip. For example, you could
draw the swing plane as illustrated below. The yellow curve represents the up-swing and the
orange one, the down-swing. Dartfish creates the trajectory by joining selected points while
smoothing the curve in between. The trajectory redraws as the video plays (see image on the
right).

To draw a curve, use the Spline tool and proceed as follows:

1. Right-click on the Line button and select Spline from the context menu.

|z +  Marker
@‘ ® . Line
ELI 4—-’* Spline

Position the playhead at the beginning of the performance

Click on the object you want to track. A white square indicates the first point of the curve.
Use the CTRL + LEFT/RIGHT CURSOR keys to move the playhead forward a few frames
Repeat steps 2 and 3 as many times as needed.

Right-click and select Finish from the context menu to terminate the curve.

To modify the trajectory, select it and move any point you have defined. The curve modifies
accordingly.

No oo

! The trajectory draws as illustrated above only if it is deselected (white squares not visible). To do
this, click anywhere in the image but on the curve itself.
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! The curve can be drawn on a single frame. In this case, no tracking takes place.

& The number of points you have to define varies according to the speed of the object. The faster
the object, the more points you have to add to get a smooth curve.

6.4.9 Tracking objects automatically

Dartfish offers you a powerful function: automatic tracking (available in the TeamPro and
ProSuite editions). The principle is the same as for the manual tracking (see previous topic) except
that the computer automatically tracks and optionally draws the trajectory of an object(s). The
automatic tracking function can be used with most of the drawing tools:

» e.g. with the rectangle, oval, clone rectangle to highlight the evolution of an object/performer
throughout the video.

» e.g. with the marker tool, to automatically draw the trajectory of a well defined feature.

» with the spline tool (see Tracking objects manually) to visualize the evolution of the shape of
an object/body over time. In this case, each point of the curve is tracked separately.

» with the angle (see Measuring angles) and distance (see Measuring distances) tools to
measure the evolution of such data.

» with the Data table (see Using data tables) to automatically extract and store statistics from the
image

1% Tracking is a complex process; for Dartfish to successfully track objects they must remain clear
and visible. You can help it by tracking clear features with a high contrast. Try to use markers as
illustrated in the pictures above. Use your camera's focus and exposure features to avoid blurring
of moving objects.

© Dartfish. All rights reserved. - Version 9 - DARTFISH=%



Analyzing Performance 104

To activate the automatic tracking

1. Position the playhead at the video position where you wish tracking to begin.

2. If this is not at the start of the video, you may also wish to fade the drawing in at this point if you
don't want to see it before it starts to track

3. Select a drawing tool and draw on the video
Right-click on the drawn object and select Tracking in the context menu

5. Select the object speed from the context submenu (this defines how far from the last position
Dartfish will search the video image for similarly colored/shaped objects).

E

Slow object (search 5% of image)
MMedium speed object {search 10% of image)
Fast object (search 20% of image)

6. Click the image to deselect the object

Using the automatic tracking

To start tracking, simply play the video. Until you are confident that tracking is succesfull, we
recommend proceeding frame by frame.

The drawing color changes to green indicating that Dartfish has started to track the object. At any
moment, you can pause playing:

> If you observe that the tracking is "lost" (e.g. when the object gets occluded). In this case,
manually reposition the drawing onto the tracked object and continue playing. Tracking
remembers the adjustments you make.

> If the object disappears from the field of view or tracking should be stopped for any other
reason. In this case, right-click on the drawing and select Suspend tracking from the context
menu. Dartfish stops tracking from this position (the drawing color changes to red).

To show the trajectory

Once you have activated automatic tracking (see above), right-click on the drawing and select
Show trajectory from the context menu. The trajectory progressively draws as the video plays.

6.4.10 Fading drawings in and out

In many cases, drawings are valid only for a small portion of a movement. You can use the Fade
in/out function to display a drawing only during such a portion. To do this, proceed as follows:
Position the playhead at the desired position.

Draw an object on the video

Step a few frames backward (using the CTRL + LEFT/RIGHT keys)

Right-click on the object and select Fade in from the context menu.

Select how quickly the drawing appears from the context submenu.

a DN E

Immediate
Mediumm
Slow

6. Step a few frames forward.
Repeat the steps 4. and 5. to set the Fade out.

8. Deselect the drawing and play the video from the beginning. The drawing will only show in the
defined portion.

~
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! Use this function if you want to publish a new video that contains drawings that fade in/out. If you
want to add drawings to a single frame of video, we recommend you use the key positions (see
Analyzing key positions) which can be printed or published in an interactive Dartfish Mediabook.

6.5 Using data tables

The Data Table drawing tool enables you to collect time-dependent data related to the action in
your video. For example, at different time instances you can manually enter the distance an athlete
has run so far, just as you would in an Excel spreadsheet. Then, the data table tool can compute
(and display) automatically the average overall speed or the interval speed of the athlete. It is also
possible to link another drawing tool such as an angle or a measuring tool to a column of a data
table, to display and store the evolution of the corresponding quantity (angle/length) over time. In
the following image you can see a data table containing heights inferred by a measurement
drawing.

An advanced feature is the option to track an object in the video automatically and to display the
corresponding positional data in a data table. Finally, you can export the collected data in CSV
format for further processing and analysis in a spreadsheet such as Microsoft Excel.

6.5.1 Datatable basics

This topic covers the techniques of creating and manipulating a Data table. Then, in subsequent
topics we'll look at different examples. The Data table drawing tool is available in the Analyzer
and InTheAction modules.

Data table features
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Position data recorded
from marker drawing

To create a Data table

1. Right-click the measurement tools group of drawing tools in the drawing toolbar and select
the data table drawing tool

] @ Time
MM Distance
A Bngle

OG Reverse Angle

=& .

2. Draw the Data table in the same way you would draw a rectangle on the video image: by
positioning the mouse crosshair cursor at the top left position of the space that the Data table
will occupy, then...

3. Click & drag downwards and to the right

4. As you drag the Data table will appear one column and row at a time. Release the mouse
when the number of rows and columns meet your need.

& Set the font size BEFORE the table is created. If he font size is too large, the table will take a lot
of space on the video image

To add a column

As the Data table is drawn, columns automatically appear in the order Time, Data, Interval
Speed. But suppose you want two data columns, or you want distance but not Interval speed?
The answer is to manually add the columns that you require:

1. Right-click on any column in the Data table

2. Select Insert column from the quick menu
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3. Choose which type of column to insert:

>
»

YV V.V V V

Timecode - a time stamp based on video position

Data - numerical data derived from other drawings (for example, position and angle) or
manually entered

Interval speed - calculated from distance data

Average speed - a rolling calculation of average speed from the first data point to the last
Interval length - a calculation of distance between two data points

Interval duration - a calculation of the time difference between two data points

Text - a free text field for addition of labels or notes

To remove a column

1. Right-click on any column in the Data table
2. Select Column > Delete column from the quick menu

To add and delete rows

It is not possible to add or delete rows

Linking a Data table to a drawing

By linking a drawing to a Data table, data can be derived from it. For example, Link an angle
drawing to record angle. Link to any drawing (for example Marker or Spline) to record position.

1. Click the Data table to select it

2. Hold down the CTRL key and click the drawing (sizing ‘handles' indicate that both drawings are
selected)

3. Right-click anywhere in a data column of the Data table and select which data will be
recorded:

Display (X,Y) of 2nd drawing in this column

Display X coordinate of 2nd drawing in this column
Display ¥ coordinate of 2nd drawing in this column

Display angle in this column

4. Now the Data Table properties are automatically displayed:

Data Table properties

Automatic mode

Insert a new entry every |2 fields
sec

oo
uus

o]

L]
o
=}
i

5. If Automatic mode is selected, enter a sampling rate expressed as fields. The actual time
interval will depend on the frame rate of the video and whether it is interlaced. For guidance, the
sampling interval is also displayed.

6. Click the OK button to continue
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7. What you do next depends on whether you have chosen to gather data manually or
automatically:

> If using Automatic mode: Simply play the video. Data will be added to the table at each
specified sampling interval

> If not using Automatic mode: At each point where the data from the drawing is to be recorded,
right-click the bottom row of the Data table and select Insert entry in Data Table from the quick
menu

See the following topics for examples of using Data tables for more specific guidance

Calibrating time

1. Position the Playhead at the video position which will be ‘'zero time'
2. Right-click the time in the bottom row of the Data table
3. Select the Set Timecode to 00:00 option from the quick menu

Calibrating distance

Unless manually entering distances, a distance calibration must be made. See the topic Measuring
distances to discover how to do this

Calibrating position (setting an origin)

When linking a data table to a drawing, the X,y coordinates recorded will be based on an origin at
the top left of the video image. If precise coordinates are required, an origin may be set as
follows:

1. Add a marker drawing to the video at the chosen origin

2. Right-click the marker and select Set as origin from the quick menu

3. Choose the direction of the axes depending on your requirements and the direction of
movement of the drawing(s) being used to find position

To manually enter data to the table

1. Click in a cell in the bottom row of the table, then type a number
2. Press the ENTER key to add the data to the table
3. Data entered in this way can be edited by clicking on any cell containing the data

! Only Data and Text columns may be edited in this way and only distance data can be added to a
data column. Remember to use the same units set in the Dartfish Options Tools menu > Options >
Analysis page > Measure Unit

6.5.2 Record times

This first example using the simplest data table; recording only time. We go one step further and
calculate the lap times between splits.

This is an applied example where some steps have been summarized. First read the topic Data
table basics
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‘Timecode |Interval duration |Lap '
00:00.000 [00:00.000 Lap 1
00:36.840 |00:36.840 Lap 2 |

01 02.160 |00:25.320
01:21.000 |00:18.840
01:42.960 |00:21.960

01:42.960 [00:21960 | |

Prepare the table

1. Draw the Data table. Only one column, Timecode, is required

2. Right-click anywhere in this column and select Insert column > Interval duration from the quick
menu

Record the data

Position the play head at zero time. For example at the start of the race

Right-click the time appearing at the bottom left of the Data table

Select Set timecode to 00:00 from the quick menu

Move the video to the first time to be recorded

Right-click the time code at the bottom left of the Data table and select Insert entry in Data table
Repeat for other split times

L A

Labeling splits
1. Right-click anywhere in the Interval duration column and select Insert Column > Text
. Click the label at the top of the new Text column

2
3. Press BACKSPACE to remove the label and type 'Lap time'
4. Click in each cell of the Lap time column and type 'Lap 1', 'Lap2' etc

6.5.3 Record angle and distance from measurement tools

Measurements from angle and distance tools can be recorded directly into a Data table by linking
the measurement drawing to the Data table

In this example, we will choose to manually choose which data to record when a cyclist's leg is in
specific positions. We'll automatically track a knee angle but manually measure and record
displacement of the cyclist's knee from a fixed point

This is an applied example where some steps have been summarized. First read the topic Data
table basics

Prepare the table

1. Draw the Data table. Two columns, the Timecode and Data, are required

2. Insert a second data column: Right-click anywhere in the Data column and select Insert column
> Data from the quick menu

3. Click the heading of the first data column and press the BACKSPACE key to remove it. Type a
new label 'knee angle'

4. Click the heading of the second data column and press the BACKSPACE key to remove it.
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Type a new label 'knee displacement'

5. Draw an angle drawing and a calibrated distance drawing as shown below (see Measuring
angles and Measuring distances topics)

6. Right click the Angle drawing and select Tracking > Medium Speed Object from the quick
menu

00:00.200
_100:00.420 141.35
91.88
T91.88

Link the drawings to the data table

1. Click the Data table to select it
2. Hold down the CTRL key and click the angle drawing

3. Right-click anywhere in the first data column (Knee angle) and select Display angle in this
column

4. Data Table properties: deselect Automatic mode

Data Table properties
Automatic mode
Insert @ new entry every fields
D04 sec

5. Repeat steps 1-4 to link the distance drawing to the Data table

Record the data

1. Position the playhead at the first position to be recorded

2. Adjust the size and position of the distance tool to make the desired measurement. There is no
need to adjust the angle tool in this case as it is automatically tracking the movement

3. Right-click the bottom row of the Data table and select Insert entry in Data table
4. Repeat for other positions
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6.5.4 Manually enter distance to calculate speed

In this example, you will learn how to calculate certain statistics by entering data manually. Imagine
you want to analyze a 100m hurdles women's race by measuring the intermediate times of the
winner at each hurdle, and thus be able to compute the individual interval speeds.

Create the Data table

1.

Select a video clip with a hurdles race from the Iltems List (library) and drop it in the video
display
Select the Data table drawing tool in the drawing toolbar.

Move the crosshair cursor on the video to where you want to have the upper-left corner of the
data table. Now move the mouse while keeping the left mouse button pressed, just as if you
wanted to draw a rectangle. Watch columns and rows being added and removed automatically
as you drag the mouse around.

Note the number of the rows in the data region (for an explanation see below), that shows the
number of data rows. Release the left mouse button when you see two columns (labelled
"Timecode" and "Data") and five rows

The data table, composed of 5x2 cells (as illustrated below), is now created. You are now ready
to enter data.

The data table is divided into three main regions, each covering its entire width:

>
>

>

The first row is the title row containing an editable title for each column.

Rows 2, 3 and 4 are data rows, which display the data that you will enter during your analysis
session. Collectively, these three rows are called the data region.

The fifth (and bottommost) row is the entry row. Usually you will enter your data here, from
where it will be inserted in chronological order into the data region.

Enter data

You are now ready to enter data. To do so, proceed as follows:

1.

~

Move the playhead to the exact frame where the runners jump out of the starting block. Watch
the current timecode in the bottom left cell change as you do this. This will always be the
timecode that belongs to the data you enter in the entry row.

Right-click on the data table and select Set timecode to 00:00 to reset the timecode of the data
table. The time of the start of the race will act as the reference time for our analysis.

Click on the bottom-right cell, that is, the cell belonging to the entry row and the column labelled
"Data". You'll enter the edit mode of this cell: the cell is highlighted and a vertical cursor sign
appears. Now you can type in numbers.

Type "0" to indicate the start of the race ("0" for "zero meters run so far"), then press ENTER.
You'll leave the edit mode, and the contents of the entry row (the timecode and "0") are inserted
into the list. The entry cell (where you entered "0") is cleared.

Move the playhead now to the next frame to where the runner crosses the first hurdle. The
timecode in the bottom left cell now displays something like "00:02.400".

Click again on the bottom right cell. Type "13" since the first hurdle is 13 meters from the start.
Press ENTER to insert the new data as a second entry in the list.

Repeat steps 5 and 6 until you've added entries for all hurdles (each separated by 8.5 meters)
and a last one for the finish line (100 meters).

! The data region is scrollable - entries that are already in the list scroll up and disappear as you
insert more entries. These entries are not lost. Use the scrollbar on the right side to make them
visible again (drag the round yellow anchor on the scrollbar up and down).
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Add computed columns

Suppose you now want to display the interval speed between two hurdles.

1. Right-click on the data table somewhere in the second column. The context menu appears.

2. Select Insert column > Interval speed from the context menu. A new column labelled "Interval
speed" is inserted at the right end of the data table. Each new cell contains the speed of the
corresponding interval.

You can also add more data columns to enter for other athletes. If you want to display the interval
speed of the second data column, you can insert a second interval speed column the first one from
the left displays the speed of the first data column, the second one displaying the speed of the
second data column, and so on.

Add comments to the entries
You can insert a text column to comment on certain events in the video.

1. Insert a text column using the procedure described above

2. If there are already some entries in the list (such as from the hurdles example), click directly in
the text cell where you want to enter your comment. You'll enter the edit mode.

3. Type in your comment, and finish by pressing ENTER
Repeat steps 2 and 3 for comments on other entries

5. If you want to add a comment for a timecode that is not yet in the list, move the playhead to this
timecode, and enter your text in the corresponding cell in the bottommost row. A new entry is
inserted in chronological order in the list when you hit Enter.

E

Update data in the list

Suppose you made a mistake while entering data in the hurdles example. There are two types of
modifications:

» Modification of manual data cells: Let's assume that you entered 31 instead of 30 meters for
the third hurdle. You can correct this mistake easily by clicking directly in the corresponding cell
in the data region, editing the data and pressing ENTER to finish your correction. Note that
computed cells (speed, etc.) that are affected by your modifications are immediately updated
while you type.

» Modification of the timecode: Now let's assume that you typed the correct distance (30) for the
third hurdle, but you made a mistake in the timecode. In this case, things get a little bit more
complicated, since the data you want to change (the timecode) doesn't belong to a manual, but
to a computed column. Follow these steps:

1. Delete the incorrect entry from the list: right-click on a cell belonging to the incorrect entry,
and select Delete entry from the context menu. The entry disappears.

2. Move the timeline to the correct frame, where the athlete crosses the third hurdle. Click on
the corresponding cell of the bottommost row and enter "30", followed by Enter. A new entry
is inserted into the list in the correct chronological order. All computed cells are updated
accordingly.

6.5.5 Estimate golf club speed

Suppose you want to analyze a video of a golfer by displaying the time-dependent speed of the
club head in one column of a data table. Here you face the limitation that Dartfish can only make
measurements in two dimensions so the speed of an object moving through three dimensions,
such as a golf club, cannot be calculated exactly. It can be estimated though, and there will be
moments - such as contact with the ball - where the club speed can be calculated more or less
accurately.
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Create the Data table

1. Open avideo of a golfer.

2. Create areference distance measurement drawing along the golf club (see the topic
Measuring distances). Give it a reference length of 0.95m, for example. Do this preferably in
the ball-hitting frame.

3. Move the playhead to the first frame of the swing.

4. Create a spline drawing to manually track the club head throughout the swing. Its position over
time will be recorded in a data column.

5. Create a data table with three columns (timecode, data, and interval speed).
6. Change the title of the data column to "Position".

7. Select the data table and the spline drawing by clicking them while holding down the CTRL
key

8. Right-click in the "Position" column of the data table.
9. Select Display (X,Y) of 2nd drawing in this column from the quick menu

10.The Data table properties window appears: Leave the Automatic mode checkbox checked.
Set the Insert a new entry every ... fields value to 1. This means that your data table will be
working in automatic mode: it will insert a new entry in the list each time you leave a field. Click
the OK button now. The current position (X,Y) of the cross is displayed in the corresponding
entry cell of the entry row. Note that the units of (X,Y) are the same as the reference measure.
The origin is in the upper left corner of the video.

11.Play the video. In the 3rd column you can see the evolution of the interval speed in m/sec.

6.5.6 Position tracked relative to an origin

This is a similar eaxmple to that of the golfer but this time uses automatic tracking to fill up your
data table automatically. Consider a weightlifting example: this process can be automated to a very
high degree by using the object tracking feature. For this, you will:

> Create a circle shape centered around the barbell bar, and set it to automatically follow the bar
in the video.

» Set an origin at the initial position of the bar, which will serve as a reference point for the
measurement of the vertical displacement of the bar (which is tracked automatically) during the
entire video.

> Finally, create an Data table to record the vertical displacement of the bar for each frame,
while the video is played. So you won't even need to step slowly through the video
Here's a more detailed procedure:

1. Load the a video clip showing a weight lifter from the side.

2. Create a reference distance drawing, perhaps using the diameter of the weight of a taped
marker on the floor.

3. Move the timeline to the first relevant frame, perhaps as the lift begins

4. Create a Marker drawing (at the position of the barbell bar hole) on the floor just beneath the
barbell bar. The cross will serve as the (static) reference point.

5. Right-click the marker drawing and choose the Set as Origin option from the quick menu then
select appropriate origin x/y axis directions based whether the lifter is facing left or right.

6. Create a circle centered at the position of the barbell bar, sized about twice the bar diameter.

7. Right-click on the rectangle and select Tracking > Medium speed object (search 10% of image).
The rectangle will now track automatically the barbell bar for the rest of the video.

8. Each time you advance in the video by stepping through it or playing it, the rectangle will adjust
its position in order to follow the bar.

9. Create a data table with 2 columns (timecode, data).
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10.Change the title of the data column to "Height".

11.Select the data table, and the circle by clicking them while holding down the CTRL key.

12.Right-click in the "Height" column of the data table. A new context menu appears. Select
Display Y coordinate of second drawing in this column

13.The properties window appears: Leave the Automatic mode checkbox checked. Set the Insert
a new entry every ... fields value to 2 (or whatever interval you like).

14.Click OK. The current vertical distance between the rectangle and the cross is displayed in the
data table. Note that the unit is the same as the reference measure.

15.Play the video. Watch how the rectangle follows the barbell bar, and entries are inserted
automatically into the data table list. Note how the data region begins to scroll as soon as there
are more entries than visible rows.

16.Pause the video when the athlete has finished lifting.
17.Right-click the tracked drawing and select Suspend Tracking from the quick menu.

18.Right-click the data table and select Properties, then deselect the Automatic mode option.
These last two actions will prevent further data being added to the data table.

Correct tracking errors

If the drawing should lose track of the bar at some point in the video, pause the video, and move
back in time to the first erroneous frame. There you can adjust the drawing manually to the
position it is supposed to have. Then right-click the data column and select Column > Clear column
downwards to clear the erroneous entries in the data table. Play the video starting at the current
position to continue.

If you're dealing with high speed objects and tracking problems remain, you could try to select
Tracking > Fast object (search 20% of image) in step 7. You could also experiment with the size of
the tracked drawing. If tracking continues to be a problem, perhaps due to motion blur in the video
image, consider stepping through the video frame by frame and making position adjustments as
required. It may ultimately be best to use a Spline drawing as in the golfer example.

6.6 Adding written and audio comments

The Analyzer allows you to produce enriched multimedia content. It gives you the ability to
combine your coaching expertise with images to generate powerful presentations (see Publish
Analysis) that you can share with your athletes/students for use with their daily practice. You
already learned how to add drawings on the video to highlight details or to extract statistics from
the images (see Drawing on the video). In this section you will learn how to add verbal and written
comments which can be used to analyze:

1. a performance in its whole (global comment). In this case, use the lower part of the Storyboard
tab.

2. key positions of a performance (key position specific comment). In this case, use the lower
part of the Key positions tab (see Analyzing key positions).
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6.6.1 Written comments

To add written comments, simply enter your text in the Description box, as illustrated below:

% Storyboard |5 Key Positions | & Timeline |24 Data Graph | @ Analysis Recorder

W Jpwrors

S&C Clean S&C Clean(1)  Incorrectvcored. ..

Storyboard Item Information:
Label: S&C Clean

Description: | Clean:
Shoulder width apart with arms just outside the knees and elbows turned outwards. Hold the chest up
maintaining the torso at 45% but during the lift, hip, knee and ankle are extended simultaneously. At
the top of the lift, shrug shoulders upwards and backwards, Overall, you are attemting to lift the bar
upwards, keeping it close to the body rather than lifting it outwards.

This box is located on the lower-left of the Analyzer module (in the Storyboard or Key positions
tabs).

6.6.2 Audio commentary

To add an audio commentary:

1. Select the audio recording device from the drop-down list of the Recording Device pane. This
pane is located on the lower-right of the Analyzer module (in the Storyboard or Key positions
tabs).

¥ Recording Device Connected to Pérphénque D4 Sony

Select the audio device for recording:

. Périphérnigue 0% Sory V

Périphérnigue 0% Sory
Soundhai Digital Audio

2. If needed, select the input. If you have plugged a microphone in your sound card, select
"Microphone".

3. Click on the Record button it will begin to record your audio input.
® » =

4. Click on the Stop button when you are finished
5. To play back the recorded audio comment, use the Play button.

To remove an audio commentary

Recording another audio comment adds to the previous one. It does not overwrite it. Click the
Delete audio annotation button to remove an audio comment or clear the old one to record a new
one.
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6.7

6.7.1

*

Analyzing key positions

Key position analysis allows you to break down a movement and to analyze its important
moments by using drawings, audio and written comments. Key positions allow you to display
specific moments quickly. You'll also have the ability to publish the key positions in two formats:

» The Mediabook - an interactive multimedia analysis that you can save to a CD-ROM, send via
e-mail, or publish on the Internet (see Producing mediabooks).

» A printed report - the collection of key position images printed in different layouts (see Creating
still images).

To use key positions analysis, select the corresponding tab in the lower part of the Analyzer.

Storvboard  Kew Positions | Timeline | Data Graph | Analysis Recorder | 4 B X
4 %
address  hacksw... top - k
(%] i (2] &
Label: (impact )
- ]
Motes: | . >
»  Recording Device Connecter

Adding key positions

To add a key position, proceed as follows:

1.

2.

Move the Playhead to the position you wish to highlight. Use the Frame buttons (or the
CTRL + LEFT RIGHT keys) to refine the position.

Click on the Add key position button (green 'plus' icon)

7

A new key position appears with its default label underneath (see Editing key positions to
discover how to edit labels)

Storyboard  Kew Positions |

_

4. To add other key positions, repeat the steps above.

! Key positions can be added in any order. Say you analyze a long jump, you can first create the
key position of the landing followed by the one when the jumper hits the board.
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6.7.2 Editing key positions

To edit one key position, select it by clicking the corresponding thumbnail...

: Storyboard  Kew Positions | Tirmeline | Data Graph | Analysis Recon

]{j I |
Position: | 00:03.634 T (e

Label: [backwing
... and do one of the following operations:

» rename the label - type the new label in the Label box (e.g. 'back swing' in the illustration
above)

» change the video position - use the left and right arrows next to the Position box.

4l ir

» change the order - key positions do not need to be listed in a chronological order. You can
change the order by dragging keyposition thumbnails.

» delete - use the Delete key position button or right-click on a thumbnail and select Delete
from the context menu

j(_’\
» You can delete all key positions by clicking on the Display Key Positions Options button and
selecting Delete All Key Positions.

&dd Key Positions Automatically... ol |
Delete All Key Positions i

@ Try to make a consistent use of the labels. You will see in section Synchronizing video clips that
clips can be easily synchronized by matching key positions with the same label. Read next section
to learn how to edit the label.

6.7.3 Analyzing a key position

To analyze a key position:

1. Select the key position by clicking on the corresponding thumbnail (or create a new one, see
Adding key positions).

addrezs  backsw.. r top - impact

2. Add your analysis by using:
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> drawings (see Drawing on the video)
> written comments (see Written comments)
» audio comments (see Audio commentary)

! Your analysis is automatically attached to the selected key position - no need to save it

Vif you add a global drawing (when the Storyboard view is selected), all new key positions will
"inherit" this drawing. The drawing now exist both in the video and the key position independently
and changes in, or deletions from, one will not affect the other.

6.7.4 Importing key positions

You can import an analysis that was performed on a clip and use it as a basis for a new one. Your
library can thus contain a set of reference clips that you already have analysed. Select the one that
could best be used to automatically create the key positions and import the existing annotations.
Once imported, you'll only have to slightly adapt the video position of the key positions and edit the
drawings/text.

To import key positions:

1. Load the clip to analyze.

2. Position the playhead at one of the key positions (e.g. at the impact of the golf club with the
ball).

3. If needed, switch to the Key Positions page.
Find a "reference" clip in your library - one which already has key positions

5. Drag and drop the reference clip from the Library onto the key positions page of the clip to be
analyzed

P

Storvboard  Kew Positions | Ti
il
6. The Insert Key Positions dialog opens.

7. The list of key positions of the reference clip is contained in a drop-down list. Select the one
that best synchronizes to the current playhead position (e.g. impact).

Select the key position that best synchronizes to the current playhead position:

address i

address
backzwing
top

impact

To import keypositions from other clips in the analysis

If keypositions are to be imported from another clip loaded into the A,B,C or D video displays of
the current analysis (Storyboard item), this alternative method can be used:

1. In the clip to be analyzed, position the playhead at one of the key positions (e.g. at the impact
of the golf club with the ball).
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2. Select Add Key Positions Automatically... from the key positions options

Add Key Positions Automatically.. . .E-,_Jv
Delete All Key Positions =

3. Inthe Insert Key Positions dialog, select Import key positions from another clip.

Insert Key Positions
Add key positions automatically E
Import key positions from another clip or add key positions at ficed EI};.\—’_'—\

intervals.

Choose a method to add key positions:

Import key positions from another clip W

Select the clip to import key positions from:

Tommy Haas backhand slomotion

Select the key position that best synchronizes to the playhead position:

Contact W

m

Finish Cancel

4. If the current analysis contains more than two clips, select the clip to import key positions from

5. Select the key position label which best matches the current position in the clip being
analyzed

To edit key positions:

Importing key positions from another clip not only adds the key positions but also all comments
and drawings. You may need to edit these and also the position in the video of each keyposition.

See the topics Adding and modifying drawings and Editing key positions.

6.7.5 Adding key positions at a fixed interval

You can automatically create key positions at a fixed interval. To do this:

1. Position the playhead where the first key position will be added.
2. From the Key Positions Options, select Add Key Positions Automatically...

Add Key Positions Automatically. . bl
Delete all Key Positions =

3. Inthe Insert Key Positions dialog, select Add key positions at fixed intervals, and set the
interval (as a fraction of a second)
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Choogze a method to add key pogitions:

Add key pogitions at fiwed intervals [v]

Inzert a key position every |1 zeconds.

! The minimum interval is 0.1 sec.

6.8 Comparing performances

A performance can be analyzed by comparing it to another one, for example to see how an athlete
evolves over time, or to a "reference" to highlight how a movement should be performed. You can
also analyse a performance viewed from different angles at the same time.

Performances can be compared in Split-screen or in Blend mode (videos overlayed on top of
each other).

6.8.1 Loading multiple clips

You can analyze clips individually or in groups of up to 4 clips at a time. The clip selection buttons
- A, B, C and D - correspond to the multiple clips that you can load into the Analyzer. In other
words, you can compare a performance (loaded in A) with up to 3 other performances in the
following ways:

» separately - Avs. B, Avs. C or Avs. D (2-way split, or blend mode).

|8
T I

» simultaneously - A vs. B vs. C (3-way split) or A vs. B vs. C vs. D (4-way split).

E[=]
HE

To load a clip:

1. Click on one of the selection buttons (A, B, C or D). The button appears to be pushed in.

2. Drag & drop (or double-click) the clip from the Items List (or the Tray) onto the Analyzer's
video display. The clip's first frame is displayed, and its name appears in the timeline
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underneath the screen.

h

3. To load additional clips, repeat step 2 and 3 above

To change a clip (A, B, C or D)

Drag & drop the new clip from the Items List to the desired A, B, C or D video display.

! Double-clicking on a new clip from the library will not replace an existing clip but will create a new
Storyboard item. Use the drag & drop method to change a clip.

6.8.2 Display modes

The display mode of each Storyboard item can be changed to Split-Screen or Blend to compare
performances side-by-side or overlayed on top of each other. To change the display mode:

1. Select the storyboard item you wish to analyse in split-screen or in blend mode.
2. Activate the desired mode:

H Split-Screen mode, or

i Blend mode

3. The storyboard item display changes accordingly. In the illustration below, the second
Storyboard item has been selected and the split-screen mode activated.

Storyboard | Key Positions | Timeline | Data Grap

Iniaki(2) Iniki(3) - Iniaki
(4]

4. Select the clips to analyze by clicking the corresponding buttons - A, B, C or D. The buttons
appear as "pushed". To de-select a clip, click on the corresponding button.

To load or change a clip in split-screen or blend modes

» Split-Screen mode: drag & drop the new clip from the Items List onto the appropriate screen
area (A, B, C, or D). If needed, click on the A, B, C or D buttons first.

> Blend mode:

1. Click the corresponding clip button - A, B, C or D.
2. Drag & drop the new clip to the selected video display.

6.8.3 Synchronizing video clips

To make the images in the different clips comparable, you need to synchronize their action so that
you are comparing relatively similar action within the performances. You can synchronize video
clips by using the key positions (see next section) or by using the timeline(s).

Moving the position of one video's timeline relative to the other can be used to move one video
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without changing the position of the other, as described in the following methods:

Method A

1. Load two clips in split-screen (see sections Loading multiple clips and Display modes)

2. Click anywhere in the clip displayed on the left of the screen (most likely clip A). A blue timeline
shows underneath the screen. Note that timelines are color-coded according to the display
screen; blue corresponds to letter A.

3. Drag the Playhead to the position where the clip should be synchronized

4. Click the clip on the right of the screen (most likely clip B). A yellow timeline replaces the blue
one.

5. Click and drag the yellow timeline (NOT the playhead) until the two clips are synchronized (e.
g. when both clips are at the impact).

6. If more than two clips are being compared, repeat steps 2-5 for the Clip C and/or Clip D. These
clips will be color-coded red and green according to the colors displayed on the clip selection
buttons

7. To play the synchronized clips, click on the Stop button to move the Playhead to the
beginning of the play range and click the Play button.

@ Use the keyboard shortcuts SHIFT + LEFT or RIGHT to fine tune the synchronization. This
moves the timeline one frame backward or forward.

Method B

You can use the Timeline view to synchronize clips. Click on the corresponding tab to display this
view.

Storyboard | Key Positions  Timeline | Data Graph

£ Iniaki(1)
£ Iniaki(2)

The synchronization process is the same as described above except that you do not need to click
a clip to select the blue or yellow timeline. You can directly click on a timeline to select it. This view
also allows for quick re-synchronization. Simply move the playhead to a new position and adjust
the timelines to re-synchronize at the new position.

6.8.4 Synchronizing at key postions

If you have added key positions to the clips (see Adding key positions), you can synchronize
performances at every key position for which the labels match. For example, if you consistently
use the label "impact" when the club hits the ball and "top" for the position that corresponds to the
end of the back swing, it will be very simple to re-synchronize two clips at "impact" or at "top".

You can synchronize clips by matching key positions with the same label. To do this:

1. Load two clips in split-screen.
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2. Switch to the Key Positions page. Say that both clips contain a key position with the label
"impact" at the position where the club hits the ball. Labels must exactly match (see Editing key
positions to find out how to edit key position labels).
3. Double-click on the key postion "impact".
This method allows very fast re-synchronization at every matching key position.
@ If you add key positions to a clip by importing them from a reference clip (see Importing key
positions), it will be very easy to synchronize both clips because labels are imported from the
reference clip and so exactly match.
@ If the clips contain multiple key positions, you can synchronize them at a particular position by a
double click and navigate through the other key positions by a single-click and observe the relative
position of the performers. For example, if you have a key position at every gate of a giant slalom it
will be easy to see the distance gained or lost by a skier between each gate.
6.8.5 Setting default synchronization
In the previous topics in this section you have learned that it is possible to synchronize clips at
various positions. It is also possible to set a default synchronization position. This is a single Key
Position at which clips will automatically be synchronized when the clips are loaded into Analyzer's
split-screen mode.
This saves time resynchronizing clips that are repeatedly compared.
To set default synchronization
1. Add a key position at the chosen video position (see the topic Adding key positions)
2. Right-click while pointing at the key position and select Set as default synchronization from the
quick menu.
3. The default synchronization key position which shows the is marked with a yellow dot as shown
below.
6.8.6 Analyzing in split-screen mode
Analyzing in split-screen is very similar to analyzing in single-screen. However, there are minor
differences that you should know about.
Drawings
Select the appropriate drawing mode (in the drawing toolbar)
> .; Video Drawing - drawings will be applied to either clip A, B, C or D. Simply select a
drawing tool and apply it on A, B, C or D.
> .: Screen Drawing - drawings are applied onto the whole Analyzer screen.
This means that the drawings can go across the A, B, C or D boundaries. In the example
below, the Clone Rectangle drawing tool and the Screen Drawing mode have been used.
© Dartfish. All rights reserved. - Version 9 -
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Zoom in/out

You can apply the Zoom Tool (see the topic Enhancing images) in any of the A, B, C or D clips.
Simply click on the corresponding video first, before applying the Zoom

Flip horizontal or vertical

To use this function (see Enhancing images) as for Zoom, a video must first be selected before it
can be flipped

& In cases where it is not easy to click the video display to select a video (for example, in Blend
mode) the A,B,C,D clip buttons can be clicked instead

6.9 Key position mosaic

Analyzer's Mosaic view offers a method of displaying Key Position images on the video display
screen. This offers the following benefits:

» Have an at-a-glance view of a performance key moments

» Analyse a performance in between key positions. Key Positions can be displayed beside the
video image as it plays. In the example below the video is displayed in the middle of two key
positions. Playing the video shows how the performer reached the key position on the right
starting from the one on the left.

DARTEISH:=% - Version 9 - © Dartfish. All rights reserved.



125 Dartfish User Guide

» Analyzer's drawing tools can be used to annotate and illustrate the Mosaic.

6.9.1 Activating the mosaic

Activate the Mosaic by clicking on the Mosaic button towards the top left of the Analyzer module.

Once activated, there are several Mosaic layouts to choose from. Click the Next/previous
Mosaic Layout button to navigate between layouts.

® %

The Mosaic mode is used in conjunction with the other Analyzer display modes; Single/Split-
screen and Blend (see display modes in the Comparing performances topic). Different mosaic
content will be displayed depending on which one of these is selected.

! Not all Mosaic layouts include the video clip.

! If there are more key positions than can be displayed with the selected Mosaic layout, the key
positions will display dynamically, this means that as the Playhead moves along the Timeline, the
closest set of key positions to the current video position will be displayed.

6.9.2 Drawing on the mosaic

The Drawing tools can be used to annotate the Mosaic, however it is important to note that
although the Video Drawing tools may be used to draw on the video clip, only the Screen
Drawing tools may be used to draw on the Key Position images. Drawings extending from the
video to a key position or from one key position to another must also be made with the Screen
Drawing tools.

To learn more about using drawing tools see Drawing on the video and Analyzing in split-screen
mode.

Saving Mosaic Images

The Mosaic layout and any drawings that it contains can be saved as a still image using the
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Snapshot button found immediately below the video display E.

6.10 Next steps

The analysis contained in the Storyboard can be published in 3 formats:

1. The Mediabook - an interactive multimedia analysis that you can save to a CD-ROM, send via
e-mail, or publish on the Internet

2. A printed report - the collection of key position pictures which can be printed in different layout

3. A new movie

Read the chapter Publishing analysis to learn more about publishing.

StroMotion & Simulcam are Dartfish's special effects allowing you to view movement in unique
ways:

> Read the topic SimulCam to learn how to place two performers together in the same place and
time.

» Read the topic StroMotion to learn how to brake down motion of a performer in a panoramic still
image or a video clip.

InTheAction is a tool that is designed to make analysis possible during training. InTheAction
shares Analyzer features such as split-screen and blended comparison of video and the ability to
add drawings. Read the Chapter Live capture & instant replay during training to learn more about
InTheAction.
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7 Dartfish outputs - publishing & sharing

Analysis completed, it's now time to expand its value by passing it onto others who can continue to
learn from it. This chapter examines what can be produced from Dartfish, how it can be distributed
and by what methods or media.

Outputs from Dartfish

It is worth considering the full range of possible outputs in order that you can decide the medium
and method which best suit your needs

» The Player (Save Movie function) can create video clips trimmed from longer clips. It can also
create still images (snapshots) based on the current frame of video.

» The Analyzer can also create snapshots. Key positions too can be turned into still images
and printed or saved.
The Analyzer also has a Save Movie function which is more advanced that the Player's;
allowing you to render the contents of the storyboard as movie
Your entire analysis can be packaged up into a Mediabook.
The complete Storyboard project file can also be shared with other Dartfish users (the
associated videos must also be sent)
Users of the Pro edition also have an Analysis Recorder; this creates a movie showing screen
and voice recording of all the actions you go through to explain your analysis.

» The Mediabook output from the Analyzer can be used to print its key positions as still images
complete with notes and drawing annotations.

» Stromotion (Pro and TeamPro only) outputs a movie or a panoramic still image made from
each frame of the movie and cloned objects superimposed.

» SimulCam (Pro and TeamPro only) creates a movie by overlaying two videos and matching the
backgrounds.

» Tagging (TeamPro & ConnectPlus) users can output match video comprised of separate video
files. Video clips can also be created from events but events can also be exported to the
Analyzer Storyboard where the full range of Analyzer producing, publishing and sharing
options becomes available. The events list itself can be exported and published either
independently or with the video. The tagging player has the same snapshot tool as the Player.

=]

this chapter

Sharing and publishing destinations
Sharing analysis using dartfish.tv
Publish to dartfish.tv

Sharing video files

Producing MediaBooks

Saving movies from the Analyzer
Recording analysis

YV VYV VVYVY
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Publishing and sharing destinations

Dartfish's sharing and publishing processes are guided by a ‘wizard', the first step of which is to
choose how and/or where the output will be shared. The complete set of options are shown below
but will vary depending on the process and Dartfish edition used.

Share Video X
Destination ';‘
How do you want to share your video?

myDartfish Smart Cloud
Dartfish.tv Channel
My Computer

E-mail

)
&

Recordable CD or DVD

w

W

Enhanced Recordable CD or DVD

FTP

| &

MNext > Cancel

Smart Cloud - myDartfish subscribers can upload to their cloud service on dartfish.tv. From
here it can be shared with others (see Sharing analysis using dartfish.tv)

Dartfish.tv Channel - Organizations use Channels on Dartfish's video sharing website to
distribute Dartfish content both publicly and privately via the internet. (see Sharing analysis
using dartfish.tv)

My Computer - This allows you to copy videos from your library to other folders on your
computer or to other drives such as memory sticks, network folders, external hard drives etc.

Email - This option compresses video clips and attaches them to an email using your default
email software. Dartfish is able to attach to email software like Outlook and Outlook Express. If
you use web based email like Hotmail, GoogleMail etc then you should convert the videos you
want to send (see Converting video clips) and attach them using the email software or website.

To,. | [sthieks@darfish.com
|

Subject:  |Dartfish video attached

ttach... | |l pscus Bernbul e 150 KBY; & Discus Beenbuh ey, dactcio (3 KB

Dartfi=zh vwideo attached
heop://wew. darcfish, com

Recordable CD/DVD - This choice of destination "burns" video files to recordable optical discs
(CD-R, CD-RW or data DVD). Note that burning to DVD does not create DVDs that will play on
a DVD player, merely discs that contain data.

Enhanced CD/DVD - A second method of burning video clips to CD or DVD is to produce an
Enhanced CD/DVD. This has the following advantages over normal optical disk burning
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Elite Coaching Services
Mg irdgel

Mora soloanption, b carn Discus Technique Video Clips
Locactui

Clips Browser Dartlish Softwara

Clips list @r o s e o o e e e

Discus Bernhult Biscus Riedel 1 iscus Riedel 2

The first of ben dercus tachniques i This becheigue invabves
darnanstratad harg ... &f waight feam.,

f G
weang as shown here.

The resulting CD autoruns - the user simply has to insert it into their computer's CD drive.

User friendly interface which can be personalized with your own contact details (see image
above).

Comments can be included to describe the content of video clips.

» FTP - This sharing option is used to send files to an internet destination. To do so, you will need
to create an FTP profile using the connection information for your FTP server. This information
can be provided by your network administrator or the Internet service provider which hosts your
website.

7.2  Sharing analysis using dartfish.tv

Perhaps the best option for distributing your video and analysis is dartfish.tv - Dartfish's online
platform for sharing video clips, Mediabooks and Tagging games and highlights

Analysis features such as split screens and key positions are retained after upload
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Hitting 52 .9
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of dynamic balance. Notce that the racket face
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hand. The stroke path rather than use of the
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¥ Favorite ¥ Download «§ Share Delete Ti]

Tennis - backhand analysis of Tommy Haas by 575 views
Warren Pretorius »

Duration: 0023 =
In public collsction: Learming Materis L

Published on & December, 2013

This dnaily$:s, prowveded Dy Wisen Pretotus. ules the backhand of Tomry Hasd
to iustrate the technique of the sinoke Wamen gves us some useful gudance
and bps.
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the siow motion clip.

Your content is searchable and filterable using the video description and keywords

Filter videos # wutipe keyword seection

Arkaca X| Clear fitier

Comp
Country
Level

MediaPeople
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Poomsae Category
Toumament

Year
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and can be edited after upload.

00:00.01

A Info

Label ords Add from list
Catch

Description Insert link

Look at paddle angle
Actually | would like it to be steeper - the similarity to
TB is beca|

It is even possible to attach other files such as spreadsheets, images or documents to the video
content. There are many other features but as dartfish.tv is constantly improving, to try to list
everything here would be pointless!

myDartfish Smart Cloud or Dartfish.tv Channel?

There are two routes that you might take to publish on dartfish.tv - A dartfish.tv Channel or the
myDartfish Smart Cloud

Dartfish.tv channels are designed for the needs of organizations and offer:

» Sophisticated access control including public access and pay to view access
» Access rights which allow control over a team of contributors to the channel
» Look & feel customization: add backgrounds and hotspots

myDartfish is intended for individual use and offers a range of tools and online services for video
analysis. myDartfish Premium subscribers can upload to a Cloud on dartfish.tv, from where video
can be shared. Content in the Cloud will also synchronize with the Dartfish Express App on your
mobile devices.

Learn more about dartfish.tv
See www.dartfish.tv to learn more about the possibilities of dartfish.tv channels and myDartfish
See the tutorial to learn more about how to set up or administrate a premium channel.

See the knowledgebase for answers to frequently asked questions about myDartfish and Dartfsh
Express

7.3 Publish to dartfish.tv

Upload to dartfish.tv in the following ways:

» Upload videos by clicking the Share button next to the Tray

» Upload Storyboards by clicking the Mediabook button on the right side of the Analyzer's
Storyboard

» Upload tagged videos (editions with Tagging only) by clicking the Publish button at the top of
the events list > Publish game...

» Upload tagged events as a highlights movie, also by clicking the Publish button at the top of
the events list > Publish highlights...

A wizard launches which guides you through the publishing steps. These steps are described
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below:

Sharing Destination

Select either Cloud Collection or Dartfish.tv Channel (see Sharing analysis using dartfish.tv to
learn about these options)

Publish Mediabook X
Destination ';-
How do you want to publish your Mediabook?

F myDartfish Smart Cloud
!]a.nﬁs_h t\r -C‘h_a-n ngl

.L r_u'Iy-Campu!elr

-

%] E-mail

A4 Recordable CD or OVD
& x5te vyou '_'._ k r

it FTP

Bach MNext > Cancel

Sign in

The sign-in requested is for your myDartfish account. This gives you access to all the dartfish.tv
destinations - those provided by dartfish.tv channels subscriptions and your myDartfish Cloud.
This step is skipped if you are already signed-in to Dartfish Software.

If you don't have a myDartfish Account you may create one by clicking the Create Account link.
You must subscribe to myDartfish Premium to be able to upload to dartfish.tv
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Dartfish Sign in

Signin

Sign in with your myDartfish account

Your email | Email |

Pazsword | Pazzword |

Sign in

Can't access your account ?

Don't have an account? Create account

' To upload to a dartfish.tv channel, the channel admin must give upload rights. You can contact
the admin of a dartfish.tv channel using a link on the home page of the channel

Select upload destination (Cloud)
If uploading to a Cloud Collection, you will simply select the collection in this step.

Select collection
Select the collection where to add the video

Select collection Create collection

iMy Collection | Enter collection name

| <Back || MNext> || Cancel |

You may also create a new collection by typing a name for the collection then clicking the Add
button.

Select upload destination (channel)
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Upload Destination
Select the channel and collection where you want to publish your content.

Select channel:

|#1 TEAM 5 : LIVE!

#1 TEAM 5! : LIVE!

Expires on 10/14/13 (143 days left)
| 42 % of 5 GB
Manage channel

Publish to collection:
| coaches collection Create a new collection:
| Neil Melville Analysig]

() Public
Anyone can access. No sign in.

(®) Limited
Anyone who has the link can access. Mo sign in.

() Private
Only people you choose can access. Sign in required.

! <Back | Next > ! Cancel !

» Select the channel (if you have access to more than one)
» Select a collection. If it is not obvious which collection should be used, contact your channel's
administrator

» Channel administrators can create new collections. The different types are illustrated above. If
unsure which type of collection to use, consult the dartfish.tv tutorial.

! The lists here show the channels and collections to which you have upload rights. If you cannot
find what you are expecting it is most likely because you haven't been given upload rights or they
have been removed by the channel admin or they have expired. Contact the channel admin by
clicking the link on the home page of the channel.

Select items

Selecting which Storyboard items to be included in the Mediabook. "Check" those to be shared as
shown below or click the Select All button:

Iniaki_030S(... new clip(2)(1) Iniaki Iron 7

In this step it is also possible to add description to individual items:

1. Click the thumbnail (not the check box)
2. Click the edit button
3. Type a label and description
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@ Add a description to videos, events and storyboard items before upload by right-clicking the item
and selecting properties from the quick menu.

Dartfish.tv categorization

In this step information is added which helps the intended audience find and understand the
content.

» Name: Renames the item. The name assigned by Dartfish will be a combination of of the file
names of the videos. Enter something that will make more sense to your audience.

» Description: Adds a description to the video. The power of dartfish.tv lies in the possibilities to
enrich video with your expert viewpoint. The first thing that the audience sees is the name and
description so make sure it does a good job!

In the case of multiple items being published, this comment adds an overall description.

» Keywords: Keywords can be searched and filtered and fundamental to how video is
discovered by your audience.
In this step, any keywords that have been added using your Dartfish library will be listed here. It
is optional whether these are included with the upload. The admin of a premium channel can
also suggest keywords that you should include or even make the use of certain keywords

mandatory.
Publish Mediabook ﬂ
Dartfish.tv Content Categorization ——
Add information to categorize the content that will be published on dartfish.tv. "
Name: Tomeny Haas backhand analysis
Description This analysis, provided by Warren Pretorius, uses the backhand of Tommy Haas to illustrate the technique

of the stroke. Warren gives us some useful guidance and tips.

?m:d, [#] Season 2014 v
[1Team
[+] Video type Analysis W
Additional keywords:

(separated with a*})

< Back ext > Cancel

! When bulk publishing videos from the Tray to dartfish.tv, this step will be skipped. The only way
to describe these videos is to do so in the previous step. The only way to add keywords is using
the Library before upload or by using dartfish.tv's edit mode after publishing.

Select Publishing Options.
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Publish Mediabook n
Dartfish.tv Publishing Options -
Set the publkshing options for online viewing and downloadable contents "
#j Attachments
Attach File | 0 document{s)
< Back Mext = Cancel

» Trim video: Upload only the area of video between cue in/cue out points if they have been set
(see Trimming video clips ). If your video is trimmed to the relevant section, not only will it take
less time to upload but it will also be more useful for your audience.

» Attachments: Any other file can be attached to your video

Publishing
Video is first encoded according to your channel's encoding profile and then uploaded

After upload a link to the video is displayed and your video is ready to be viewed online.

! Upload times to Dartfish.tv may be significantly reduced if videos are already encoded with a
dartfish.tv encoding profile. Learn more about the dartfish.tv encoding profiles for your channel by
downloading yours: Tools menu > Options > Encoding Profiles then click the download button. The
encoding profile for your myDartfish.tv cloud is automatically downloaded when signing in to
Dartfish.

7.4  Sharing video files

To share video files:

1. Add the video file(s) to the Tray section of the Dartfish library
Whenever a video is created by Dartfish, it is added to the Tray. You can also load clips by
drag-and-drop from the Items List. Remember that multiple files can be selected for loading by
holding down the CTRL key while clicking on the files.

2. Once video clips are loaded, click the Tray's Share button.
3. This launches a wizard which guides you through the process of sharing the videos

Video Sharing Wizard - Destination

Choose a destination for the video files. The different possibilities are explained in the Publishing
and sharing destinations topic

Video Sharing Wizard - Video selection
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1. Selecting the sharing destination - Click on a destination then on the Next button (at the bottom
of the window) to proceed.

2. Selecting which videos you wish to share. "Check" those to be shared as shown below or click
the Select All button:

Iniaki_030S(... new clip(2)(1) Iniaki Iron 7

3. Choose the video settings (encoding profile) appropriate for the selected destination (see Video
settings in the Getting familiar chapter).

Specific additional information may be entered according to the selected destination. Read the
information displayed in the wizard to complete this information.

Sharing Dartfish Assets with video

Dartfish creates a small 'Dartclip’ file for each video clip.

Bks fiting(3)av  Bke feteg{d).av.dardo

This contains information about key positions, notes, cue in and out settings etc - all the value
added features that Dartfish brings to the video clip. The Sharing process also ensures that the
Dartclip file is shared with the video file. If the receiver of the video clip is a Dartfish user and
chooses to retain the Dartclip file they will benefit from all the additional information added to the
video clip.

7.5 Producing MediaBooks

A MediaBook offers an alternative way to share analysis which doesn't require dartfish.tv. It also
packages video, key positions, text and audio comments, and drawings together. Share
MediaBooks as stand alone files or by using CD, email or even by publishing them as pages on
your website. A Mediabook offers an electronic output (as shown below) or a paper printout of key
positions and keyposition annotations.
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The image above shows a MediaBook displayed as a web page in an Internet browser. It contains

the following features:

» Analysis Selection: More than one analysis can feature in a MediaBook. Each item in the
Storyboard is included (read the Analyze Performance chapter to learn more about the

Storyboard).

» Video Player: Video clips are saved in Macromedia Flash format which can be viewed on
most Windows computers. One video is generated for each Storyboard item. The player
controls allow clips to be played frame by frame and to play in a loop. For a larger image, it is
also possible to play the clip full-screen using your Windows Media Player.

» Key Positions Selection: Click on a Key positions thumbnail to display the corresponding

key position.

» The key positions of all the clips in the Analyzer at publish time are included in the MediaBook.
Select "A", "B", "C" etc. to display the corresponding list for each clip.

= Analysis O OB

The "Analysis" key positions choice, as in the illustration above, varies according to the display

mode selected at publish time:

1. Single-screen mode: image transformation (such as zoom or mirroring) and global

drawings are reflected in the key positions.

2. Split-screen (or Blend) mode: key positions are split-screen pictures of every key position
for which the labels match. Video clips are automatically re-synchronized at every key
position. If no labels match, no Analysis key positions are created.

» Comments: The Analyzer allows you to type or record comments for each item in the
Storyboard and to do the same for each key position. These are included in the MediaBook.
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» Slideshow View: The Slideshow View displays the key positions as larger images and includes

» Personalization: The MediaBook can be personalized with your organization's logo or perhaps
a photograph of yourself. This can also be a link to your website.

Start the creation of a MediaBook by clicking the button to the right of the Analyzer storyboard.

This displays the first step of the MediaBook wizard where the choice of publishing destinations is
made. The choice of destinations varies according the edition of software used but the full list of
choices is shown below. These are described in the Sharing video files topic.
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Publish Mediabook X
Destination ';‘
How do you want to publish your Mediabook?

i myDartfish Smart Cloud

F}anﬁsh_tv-c_h_a-nnel .

I 4

My Computer
%] E-mail

& 4 Recordable CD or DVD

"' ; FTP

MNext > Cancel

After making your choice of destination, click the Next button.

7.5.2 Step2 - Mediabook settings

Mediabook options

Medsbaok il name: ol medsbock

Mediasbook, tith [optional} Gok swirg analssis

Your boga location [optionall C\Documents and Selnge\Pioduct Marketing'My Dod| [ Browse |
“'our web ste addiess [optonal] A e Lswang com

Video options

[[] dd high qually hascreen video

File options

(1 8 e Medhabook for use with DarfViswer
(%) Save Medisbook: foo use with Inbemet brovesen

The MediaBook settings step is used to:

» Assign a File name: This will be used to name the MediaBook file(s).

» Personalize the MediaBook: The MediaBook can optionally be personalized with your logo and
website address. You will also want to include a title that will appear at the top of the
MediaBook.

» Add high quality fullscreen video: It is possible to include an Windows Media video with the
MediaBook; these will be played using Windows Media Player and not the MediaBook. This
function may not be desirable if the size of the MediaBook is important, for example if being
sent by email.

» Choose File Options: These choice of file option is only available if the MediaBook is being
published to the "My Computer" option, otherwise the most appropriate option will be used
according to the destination selected in the first step of the wizard.

If the MediaBook is saved for use with Dartviewer, all files are packaged together into a single
file which can be read and displayed by the Dartviewer freeware software. Dartviewer is
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automatically installed on all computers with Dartfish but for non-Dartfish users, Dartviewer can
be included with the MediaBook or downloaded from the Dartfish website. This option is
automatically used for CD/DVD and emailed MediaBooks.

] Golf mediabook
d DP4 File
2,128 KB

If the MediaBook is saved for use with an Internet browser, an HTML file is created with the
additional files required to create the page also added into a separate folder. This option is
automatically used with MediaBooks for the internet.

g

Galf Golf
mediabookz  mediabookz

7.5.3 Step3 - Video settings

Settings for Mediabook video:
Select the encoding profile:
Flazh high quality w
Dezcription: High. [uality Flazh farmat for Mediabook, publication.

Settings for high quality fullscreen video:
Select the encoding profile:

windowes bedia for CD w
Dezcription: High quality ‘wWindows Media format recommended for best playback from COor DYD.

Edit the profiles

Preview

This step allows you to select a Flash encoding profile for the MediaBook and, if the include high-
quality, fullscreen video option was selected in the previous step, you can also select a
Windows Media encoding profile for those videos.

@ Encoding profiles compress the original video files substantially from the original AVI video that
is captured from your video camera. The amount of compression depends on the profile chosen.
Click the Edit the profiles link to get information on the relative file sizes.

Preview

Step 3 of the wizard also allows you to preview the choices you have made in the previous steps,
including your personalization's and the quality of compressed video files.

To see a preview, click the Preview button. The preview will be displayed in your Browser or in
Dartviewer depending on the choices made.
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7.5.4 Step4 - Publishing

The publishing step will depend on the destination.

My Computer
Choose or browse for the file location where the MediaBook will be saved.

Destination fokder

[C\Dadfish\VideohGoneralbianng &Y
Email

There are no further choices. The files will be processed and a message displayed when this has
completed.

Files ane ready o be attached bo a new emal

[#] dilach Dadviewes Instalies

You may choose to attach the Dartviewer freeware to the email if it is being sent to recipients who
has not previously installed Dartviewer. They will receive instructions on how to install Dartviewer.

attach....| | ok dos 1 mE); T partviewer nstal 5 (597 181

The file accached to chiz e-mail i3 & mulcimedia presentation
known oz o Hedisbook and was crested wsing Dacrcfish sofcware.

*++ Tnseructions on how to view your Darcfish Mediabook **%

To view a Darcfish Hediabook presencation, you need co inscall

CD/DVD

Final information about the CD/DVD burner to be used and a disc label are provided. Clicking the
Next button will "burn" the CD or DVD.

FTP

An FTP profile is selected in this step and, if necessary, a password is entered. Clicking the Next
button will publish the MediaBook files to the selected FTP site so you should establish a
connection to the internet before doing so. Click the New button to create a new FTP profile. Your
network administrator or website host must provide you with this information.

7.6  Saving movies from the Analyzer

New movies can be produced featuring all the contents of the Analyzer Storyboard. The movie
saved will reflect the content of that analysis including:

» Drawings

» Split screen or blended comparisons

» Cue in/cue out positions

Click the Movie button to turn the storyboard into a movie.
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With this functionality, Dartfish is in effect video editing software in that it is being used to join
separate clips together, however while it does not include transition effects or allow inclusion of still
images, it is capable of creating movies with features that are not possible with other software
such as:

» Split screen or blended comparisons

» Specialist text captions such as timers

» Specialised drawings such as angles and data display and also including drawing effects such
as fade in/fade out and tracking
Stepl - Video settings

In this step an encoding profile is chosen. Find out more about encoding profiles in the topic
Converting video

Slow motion video may also be created by selecting a speed for exported video of 0.5 or 0.25

Publish Video ﬂ
Video Settings
Select an encoding profile. The selected setting determines the qualty and fie size of the new video. ,'
MPEG-4 H.264 HD w | Edit profiles

MPEG-4 profile recommended for users wishing to retain the quality of typical HD (high definition) video.
Resolution, frame rate and interlacing of the source video is retained.

Select the speed of the exported video: | 1.0x v

<Back || MNext> Cancel

Step 2 - File information
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Publish Video ﬂ

Destination
Select a destination for your video. .’

File information
File name: | Warld Champipnships 2015

Add keyword category

Destination folder
\Users\Neil\Videos] W Browse

<gack || Mext> | | cancel

In this step, a File name and Destination folder are assigned to the new video clip.

7.7  Creating still images

Key positions can be printed or saved as still images.

Click the Pictures button to the right hand side of the Analyzer Storyboard to publish Key
Positions as still images.

:'q;:l Pictures

You can publish pictures to the following destinations:

Publish Pictures ﬂ
Destination
How do you want to publish your pictures? "
Prirt

W o pictures
.* wt ofrp.- fer :

% Emai

Cancel
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> Printer. Dartfish offers a choice of layout templates to print images. Some include the notes
and title information.

» My Computer. Save images as image files to a location on your computer.
» Email. Images will be attached to a new email using your default email program.

Select a destination and click the Next button.

7.7.1 Printing Pictures

Two steps are required to print your pictures. In the first, the printer you wish to use will be
selected. select

which printer do vou want to use?

v Add Metwork Printer

Your prints will look best if you select the correct paper befare printing.
To zelect paper, click Frinting Preferences.

[ Printing Preferences ]

The printing preferences button opens the print settings button for the type of printer you use.
The choices available depend on your printer and you should refer to your printer's documentation
if further explanation is required. You will be able to use these preferences to choose a print
quality and a paper type; these are especially important choices if photo-quality paper is being
used.

Click the Next button to continue...

Available layouts 4 pictures to prink Print preview

Full page Al
Centered full size picture

Full page cropped e e
Centered cropped picturs
2 pictures per page .
Full zsize pictures
4 pictures per page R
Full zsize pictures
4 pictures per page with comment i
Full zsize pictures with comment i
Sli v comment and title |

L th comment and Fitle AT
B pictures per page with comment RIET
Full zsize pictures with comment

2 pictures per page
Full zsize pictures I

MHumber of pages ta print: 1 Copies: |1 : Fage 1

Before printing, choose from one of a number of layouts. The preview gives an indication of the
layout but not the quality of the printed page. Note that both the label and notes information for
each picture can be included on the page with some of these layouts.

Clicking the Print button will print the images according to the chosen layout.
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7.7.2 Snapshot images

The Snapshot tool is used to create a stillimage from the current video display.

In the Player and Tagging modules look for this button:

&

In the Analyzer a smaller button is located immediately below the video display:

[

Save to the Clipboard

The Snapshot button can be used to copy an image to the Windows Clipboard, from where it
can be pasted into any other application supporting copy/paste of images. For example, you could
use this to insert an image onto an MS PowerPoint slide.

» In the Player or Tagging Modules: CLICK the button
» In the Analyzer: CTRL + CLICK

Save an image file
» In the Player or Tagging Modules: CTRL + CLICK or RIGHT-CLICK
» In the Analyzer: CLICK

A Save dialog appears from where it is possible to choose the image file format:

t.'% | B23WGTMA File folder py 7
< >
Metwork
File name: Tennis backhand(1) PAL W
Save as type: | FNG Encoder (* png) v ! Cancel
BMP Encoder {* bmp;*.dib:* re) }

Pixel Format: GIF Encoder {~.gif) o
JPEG Encoder (" jpeg:”jpe:"jpa: i

TIFF Encoder (* 4iff;* if)
WMPhoto Encoder (" wdp;™ jxr)
DDS Encoder (*.dds)

7.8  Analysis recording

The other publish tools covered in this chapter provide various methods of sharing analysis with
others. Of course, the actual process of using the Analyzer can itself be an invaluable feedback
tool when its tools are used to illustrate and compare performance. This is the reasoning behind
the Analysis Recorder; it is a method of making a real time recording of your use of the Analyzer
and including your voice as a sound track to the resulting video.

To appreciate the value of analysis recording, imagine sitting with an athlete and using the
Analyzer's features to explain the latest skill he/she is attempting to master. If you imagine that
you could film your use of the Analyzer and include a commentary of your coaching then you would
be very close to the functionality of the Analysis Recorder.

The analysis recorder is only available in the Prosuite and Team Pro editions of Dartfish
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7.8.1 Enabling the Analysis Recorder

Start by selecting the Analysis Recorder tab and selecting the Enable Recorder option.

"B Storyboard | Key Positions | £ Timeline |58 Data Graph |[E Analysis Recorder
Enable Recorder
*  Clip Properties

b Andin Cantora Neica

This results in new controls, Record and Pause Recording appearing in the Analyzer's video
playback controls.

. L] |

7.8.2 Setting clip properties

Because, the Analysis Recorder creates a new video clip, a file name should be provided for it. If
left blank, the file will be given the name "Untitled(x)".

% Clip Properties Enter information about the nest captured cliplz)

File narme: Dizeus technigue

Add & category

Setting clip properties also allows you to create a form that will let you categorize the new video
using Dartfish's Keyword video management system. The use and creation of the Analysis
Recorder's Clip Properties form is identical to that used for all Dartfish's recording tools (see
Video recorder in the Video Library chapter). A form such as that shown below is used to "label"
the clip appropriately making it easy to find in the Items List by selecting any combination of the
values entered

% Clip Properties Enter information about the nest captured cliplz]

File narme: Dizeus technigue

Spart; [Discus w2

Athlete: | Reidler w2

Camera angle: Feal v| X
Add a categom .

7.8.3 Other clip properties

In addition to file name and category/keyword for each clip you will also want to define the quality
of the final video by choosing an appropriate encoding profile and the file location for the end
result.

Encoding profile

The encoding profile selected defines how much the video will be compressed. Selecting an
appropriate encoding profile is a trade off between the size of the resulting file and its image
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quality, for example, you are unlikely to want to send extremely large files by email.
¥ Encoding Profile Uzing "indows Media for Analysiz Recorder

Select the encoding profile:

dedia fjl’ An | ziz Recarder b .

Dezcription: High quality wWindows Media format suitable for sound recarding with
the Analyzis Recorder.

There are three profiles, high, medium and low quality, specifically created for the Analysis
Recorder. The principal difference between these is in the number of frames per second.

@ If you find that the Analysis recorder losing audio or drops frames in its recordings, choose a
lower quaity encoding profile.

Capture Location

The capture location defines where the Analysis recorder video will be saved in the Windows
folder system. Remember that this should be included Library's list of monitored folders if this file
is to be visible when using the Category/Value video management system.

The links provided allow you to select a new capture location and to open that location.

) Capture Location &vailable recording space: B0LE GE [E8% available)
C:\Documents and Settings\Product Marketing'by DocumentzMy Videos
Change capture location Open capture location

7.8.4 Setting recording device

In this case, the recording device is being used to record an audio commentary and NOT to
capture new video from a camera. Select a sound recording device from the list.

¥ | Recording Device Connected to Panasonic 0V Device

Select the audio device for recording:

If you select your computer's sound card from the list you will be offered a further choice of audio
inputs that connect to the sound card. The link to "Configure the device" allows you to set
recording levels for that device.

Select the audio device for recording:
Soundhai Digital Audio w
Select the audio input:

Microphone w

7.8.5 Using the Analysis Recorder

1. Start recording using the Record button.
(@)

2. Then, imagining that the athlete(s) you are analyzing are sitting next to you (perhaps they are),
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use the Analyzer's replay controls, comparison and drawing tools to explain and illustrate your
analysis while recording your comments and advice. Everything you do on the video screen
and everything you say will be recorded as a new video clip.

3. If you need to pause recording to exclude anything that you don't want to include on the final
recording, click the Pause button.

4. When your analysis is complete, remember to stop recording by clicking the Stop Recording
button.

5. The resulting video clip be saved on your computer and will appear in the Tray ready to be
played or shared.

Preparing to use the analysis recorder

You should remember that lengthy analyses will create large video files. Here are some
preparation ideas to help you make your presentation efficient and succinct:
» Open the video clips to be used in the analysis into the Storyboard or the Tray.

» Trim video clips to show the relevant part. You could also zoom and flip and synchronize
them in advance as appropriate.

> Create key positions complete with drawings.
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8 Unigue ways to view sport - SimulCam & StroMotion

With SimulCam and SrtoMotion, Dartfish offers uniquely creative ways of observing, analyzing
and understanding sport.

Each creates images that can never be seen in real life; StroMotion allowing the athlete to leave a
clone of him/herself behind as he moves; SimulCam allowing two athletes to virtually "compete”
against each other when in reality their performances took place at different times.

You may have already seen these techniques in use because Dartfish provides this technology to
television broadcast companies around the world. They use it to illustrate and give their audiences
a better understanding of sport and now you can benefit in the same way:

» Perhaps SimulCam or StroMotion will be the only way that you can compare the tiny differences
between competitors; the tenths of seconds separating competitive skiers for example, or
subtle differences in a tennis serve.

» Perhaps the images will help teach technique to your development squad in a way that they will
have never seen before.

» Or perhaps you will use the technology to inspire athletes by having them compete alongside
the great names of your sport!

More about this

> Compare with SimulCam
> Dissect motion with StroMotion

8.1 Compare with SimulCam

The SimulCam technology provides you with a unique analysis capability for comparing two
athletes' performances blended onto a single background. This enables you to view and analyze
often imperceptible differences between these performances, and discover precisely what made
one performance stronger than the other.

To compare performances, SimulCam matches the backgrounds of two video images so that,
even if the camcorder pans, zooms or tilts it continues to track the background features. Using this
information, the two backgrounds can be blended into a single one.

In essence, SimulCam has a similar purpose to using the Analyzer module's Basic blend view,
however the end result is vastly superior: Basic blend is unable to track the relative movements
of the background features, making comparison near impossible if the camera zooms or pans
during filming. Basic blend results in ghostly, semi-transparent figures whereas SimulCam
creates a more realistic picture.

Required to use SimulCam:
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» Camera on tripod
» Pan, tilt and zoom allowed during filming.

> Video clips can be recorded at different times but must be taken by a camera in exactly the
same position.

More about this

> Getting good SimulCam results

» Step 1 - clip selection and synchronization. Two video clips are loaded. To be comparable the
two clips should then be synchronized.

» Step 2 - camera movement calculation. Background features are matched and the amount of
camera pan and zoom is calculated.

» Step 3 - blending, preview and saving the clips. You can also save the SimulCam project if you
wish to make changes to any of these steps later.

» Publishing new video clips

8.1.1 Getting good SimulCam results

Remember, the SimulCam technology matches backgrounds of two video clips; it will have
difficulty doing this under the following conditions:

Insufficient number of background objects

For example; snow. Imagine trying to identify the same point on a white background from frame to
frame. Your brain is still better than a computer's so "what the eyes cannot see, the computer
cannot!".

Avoid this by not zooming too closely on the subject. Even on snow, shadows, rocks, slalom gates
etc can still be used but only if enough of these distinguishable objects appear in each frame of
video.

Background is blurred

Its the same problem, if background objects become blurred or out of focus, SimulCam is unable
to calculate where they have moved to.

» Use a tripod or another solid object to mount the camera.
» Zoom and pan smoothly and slowly.

Backgrounds are different

SimulCam can only compare if the content of the background is similar in each video clip.

» Always film from the same position. If it helps you remember, mark the spot!

> It does not matter if a different zoom has been used for each clip - the backgrounds only have
to contain similar objects filmed from the same direction. SimulCam will calculate the
difference in zoom.

8.1.2 Step 1-clip selection and synchronization

Step 1 of the SimulCam clip creation process consists of:

» Loading two video clips containing the performances to analyze.
» Synchronizing the clips for optimum comparison.
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» Trimming the video by selecting appropriate cue in & out points.

Loading video clips

SimulCam compares two clips. Drag & drop each clip you wish to compare from the items list on
to SimulCam'’s left and right video displays.

At this point, you can exchange either clip for another clip by simply dragging and dropping a
different clip from the Items list or Tray.

Synchronising video clips

SimulCam has a set of easy-to-use tools to help you synchronize the two video clips. These tools
are located at the bottom of the SimulCam window.

1. Click and drag the timeline cursor ¥ until you see an easily identifiable moment in the first
video clip. For example, find the instant where a long jumper's foot hits the board, when a skier
passes a gate, when a golfer hits the ball etc.

2. Click and drag the yellow timeline (this represents the second clip) left or right until you see the
same image in the second video clip.

% Fine-tune the video frame selected using the left and right cursor movement keys of your
keyboard - remember to click the timeline of the video that you wish to adjust first

itis important that you choose a starting frame with clear static elements that appear in both
backgrounds. This will help you align the backgrounds in the next step.

'a "perfect” synchronization does not always yield a perfect analysis. The overlap between both
performers may be too high, hiding important details. In this case, try to add one or two frame shift
between both video clips.

! If the video clips contain synchronization points, they are automatically synchronized when
loaded.
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Trimming the clips

This means selecting the portion of the video clips you want to analyze. This is done by setting cue
in and cue out points.

1. Position the red cursor at the beginning of the portion and click on the Set In button ( 1 ).

2. Position the cursor at the end of the portion and click on the Set Out button (™l ).

@ Itis worth taking time to trim the clip to the section of the video you wish to compare as this
considerably reduces the time taken to produce the final result clip. Also, experienced SimulCam
users will be able to avoid sections of video where SimulCam is not able to make comparisons.

8.1.3 Step 2 - camera movement calculation

In this step, calculation of the camera movements is initiated. This is required by SimulCam to
blend the two performances onto a single background. In this process, similar features in the
backgrounds of the two video clips are manually aligned by one of two methods:

1. Drag & zoom alighment - Backgrounds are aligned by blending the first frame of each clip
then zooming and dragging one frame above the other until backgrounds match.

2. Matched alignment points - Several matching static background features are marked with
alignment points on the first frame of each clip.

Which method is best?

We recommend that you try both methods to decide which one is most efficient for you. By default,
your software uses the Drag & zoom alignment method. Use the following notes as a guide.
> In general, manual alignment by the Drag & zoom alignment method is quicker.

» Drag & zoom alignment requires you to zoom using scroll function of your mouse or the [+] and
[-] keys of your numeric keypad (refer to your laptop documentation). If neither of these are
convenient for you then Matched alignment points might be a better choice.

» The Matched alignment points method is sometimes a better choice when the video images
do not match well.

To select the calculation method

The calculation method can be changed at any time before or during SimulCam.

1. Select Tools > Options from the menu bar (or press F3).
2. Select the SimulCam topic
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[ Options “
#tdH « T BRI @

General Library Encoding Profiles Analysis InTheActiog | SimulCam | StroMotion  Metwork Cameras  Add-ins  Advanced

Background alignment mode:

(@) Drag and zoom alignment
Backgrounds ane abgned by blending. dragging. and zooming until features
match

(7)) Phgrment. poirts
Backgrounds are aligned by setting matching alignment poirts on
background features.

& Padtially automated
Marwal

SetaDeind

Heo ok ][ coma | omy

3. Select the background alignment mode. Note that you can Set as default your choice of
calculation method.

8.1.3.1 Drag & zoom alignment method

The Drag & zoom alignhment method consists of dragging and resizing the image of the first
video clip on top of the other clip until the two backgrounds match perfectly. Step 2 using Drag &
zoom alignment looks like this:

Step 2 Camera movesent caloulation
Aign tha backgreund in sdch combbingd frame (3 me)

Images from both videos are blended but the backgrounds still have to be aligned for each of the
three pairs of images displayed on the left hand side of the module.

Adjusting Zoom
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If the camera used different zoom while filming the two video images this can be compensated for
by resizing the top video image.

1. Click the blended video images.
2. Adjust the size by using the mouse scroll function.

@ If your mouse has no scroll function or it does not operate zoom then use the [+] and [-] keys on
the numeric key pad of your keyboard. Different laptops use different methods of activating and
operating the numeric keypad; refer to your laptop's manual to find out.

Aligning backgrounds

When images are a similar size, they can be aligned - although you may have to align then zoom
again to get a perfect match.

1. Click & drag anywhere on the blended video images, the top image will move over the image
below it.

2. Focus on one or more objects in the background; the stands, objects on the field, posts,
equipment, etc. and align those objects.

Checking alignment

Check the alignment quality using the transparency cursor.
—— —

Drag the cursor to the left and to the right. If you feel that the background is moving, it means you
need to keep aligning the two backgrounds.

s you still cannot align the background, after repeated zooming and alignment, this could mean
that the camcorder tripod moved during your recording session. In this case, it is not possible to
create SimulCam video clips. You still can compare performances but you will need to use the split
screen functionality of the Analyzer module.

Repeat Alignment for the other pairs of images

The first pair of images show the background of the two different video clips. The alignment
process needs to be repeated for the two remaining pairs of images. These pairs are used to
calculate camera movement from one frame to the next in each clip so if movement is slight this
will be much quicker than aligning the different video clips.

Click the second pair of images listed on the left hand side of the SimulCam module.
Align them.

Click the third pair of images listed on the left hand side of the SimulCam module.
Align them.

a ~wbde

The end result of step two is illustrated below. Click the Next button to proceed.
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Step 2 Camera movesmsnt caloulation
Aign th background in each combingd frame (3 tme)

8.1.3.2 Matched alignment points method

The Matched alignment point method is a process of placing markers on similar features in the
background of both video clips. The alignment point window is illustrated below, note that each
video is shown on a separate video display accessed by the tabs at the top.

Step 2: Camera movement calculation
St ot least 2 maiching ponts in the backgrourd of each par of images [2 fimes)

Ski 1 [First] :.‘_:h.li [First)
s £
E R
J-f- = ey
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Selecting background alignment points.

In this method, at least two points are set on objects in the background of the first image and then
set on the same objects on the second background. This is repeated for all three pairs of images
listed on the left hand side of the SimulCam module. It is best to use obvious points of high
contrast as illustrated in the following pictures:

- Version 9 - © Dartfish. All rights reserved.

DARTFISH==



159 Dartfish User Guide
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Also it is essential that these background points are fixed objects: People or the top of the slalom
gate in the above clip would not be good choices because they move!

To define alignment points.

1. Click on the first clip's title above the video display. A frame of the first clip is displayed in the
video display. (Ski 1 in the illustration below)

Ski 1 [First) @ 5ki 2 [First) VYizual Check

2. Click the left mouse button on a static background feature. The feature is marked as shown
below.

N

velie

3. Now click a second and perhaps a third object. They will be labeled similarly; you must set a
minimum of two alignment points but defining more may improve the background alignment.

4. Click on the second clip's title above the video display. A frame of the second clip is displayed.

5. On the second clip, click the same background objects that you selected on the first clip in the
same order so that the numbers match; the thumbnail on the left displays the previous
selections and can act as a guide.

6. Click on Visual Check on the process bar. A combined image of both frames is displayed.
The backgrounds should appear aligned.

7. If you need to delete a numbered marker because the elements are not in the second image or
are not positioned correctly, right-click on the marker you wish to delete. Then left-click in the
correct position and a marker with the same number appears again.

8. If the backgrounds do not match in the Visual Check, make sure that the alignment points are

placed correctly and that point 1 matches point 1 in each image etc. If backgrounds still do not
match then adding further points will improve accuracy.

9. Select the second pair of images from the thumbnails on the left of the SimulCam module.
These images compare camera movement form one frame to the next in the same video clip.
This time feature points are already set but you need to check they are positioned correctly.
Use the techniques described in step 7 to remove and reposition feature points as required.

10.Repeat for the third pair of images.
11.When complete proceed to the next step by clicking on the Next button.

8.1.3.3 Adding new alighment frames (flags)

Both methods to complete step 2 require that you match the backgrounds in the starting frame of
your clips. However, if the backgrounds in this frame are too different, they do not include clear
common background elements or the objects are blurred you will need to set a different start
frame.

To set a new start frame.
1. Go back to step 1 by clicking the back button.
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2. Setanew cue in at a start frame that is more appropriate.
3. Repeat step 2.

Setting new alignment frames.

It is essential that the start frames match but additional frames can be set where backgrounds can
be realigned. This might be necessary for clips that "jump" because of a change of camera angle,
or because the images have become blurred during panning or the clip does not include part of the
action in a particular frame.

New alignment frames are represented by flags in the timeline. Once you add a flag, you will be
able to realign the backgrounds in that particular frame as described previously.To add a flag:

1. Go back to step 1 by clicking the back button.

2. Drag the current position indicator ¥ along the timeline to the new alignment frame.

3. Click on the Add flag button “# . A new flag is added to the timeline. A red flag indicates that
the background alignment still needs to be performed for this particular moment

I h. I

4. Other icons allow you to jump to the next or previous flag and to delete a flag.
P .
5. Repeat step 2 for each flag added.

8.1.4 Step 3 - blending, preview and saving

Step 3 enables you to:

» Select the blending mode
» Start the calculation of the SimulCam clip and watch a preview
» Save the SimulCam video clip

Blending mode

The SimulCam image quality may vary depending on the blending mode. You can choose from
three modes and use the preview to experiment with what works best for your sport.

» Motion-based: In most cases, this is the best mode to use for generating a blend. It is based
on the camera movement.

» Color-based: Use this mode when your clip features a lighter colored background than the
performer. For example, snow, sand, concrete. Light colors are "pushed" into the background.

» Constant: This is the fastest blend calculation mode, however, the resulting quality is poorer
than the other modes. Use this mode when you want to get a rapid result.

Use the drop-down list to select the blending mode

Blending mads: | Motior-based =]

Previewing your clip
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It is not necessary to use the preview function but it will help you decide the best blending mode
and whether additional alignment is needed.

To preview, click on the Start preview button. The SimulCam clip will be displayed in the video
display as the calculation progresses. At any moment, you can decide to stop the calculation by
pressing the Stop preview button. You can now experiment with different blend modes to
compare which gives the best result.

If the SimulCam can be improved, go Back to the previous steps and redo cue in, alignment,
blend mode etc.

This done, it may be that there is still a progressive misalignment of the backgrounds. If this
happens, stop the preview and try one of the following.

1. Add an alignment flag to the frame where the background misalignment begins (see Adding
new alignment frames).

2. Select a different first frame - as described in Step 1 - clip selection and synchronization

@ 1t is much quicker to preview using Constant Blending mode. When satisfied that alignment is
correct switch blending mode to Motion-based or color-based for a better quality result.

Saving Simulcam results

There are two potential end results of a SimulCam project:

> the creation of a new video clip using the Publish process
» the SimulCam project itself.

To Save the SimulCam project, select the File > Save... option from the menu bar. Saving the
project is not always necessary but may be useful if you wish to return to the project to make
changes in the future. SimulCam projects appear in the Items List represented by the following
icon:

Starting a new SimulCam project

To initiate a new project select File > New from the menu bar.

8.1.5 Publishing new video clips

The publish process uses a wizard to guide you through creating new video clips resulting from
SimulCam and Stromotion. It is used to:

» Save and name the video clip.
» Categorize the new clip using categories.

Initiate the Publish process by clicking the Publish button at the bottom right of each module.

Choosing video settings

The first step is to select which encoding profile you wish to use for the clip. A range of
encoding profiles exist to allow you to select an appropriate format for the eventual use and
location for the video. For example, if the video clip is lengthy or needs to be sent by email, you
may decide to use an encoding profile which compresses the result into a file of smaller size (see
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Converting video in the Getting Familiar chapter to learn more about video settings).

After selecting a profile, click the Next button to continue.

Assigning file name, destination and keywords

1. Type a File name for the video clip in the File Name text box. If this box is left blank the
generic file name of "Untitled" will be applied.

2. Categorize clips while saving - If you use Dartfish's Keyword video management system (see
Organizing your library in the Video Library chapter) then you can benefit from adding keywords
to new video clips as they are saved. The method for doing this is to create a form listing a box
for each category that you wish to use then selecting existing keywords from these categories
or entering new ones. Click Add a category link to build the form. An example is shown below.
The same method is used for categorizing captured video.

File information

File: name: SimnulCam result

Sport; skiing w| X
Lacation: Wwienger| w| X
4dd a category .

3. Choose a Destination folder - This is the physical location on the computer (drive and folder)
where the new clip will be stored. Type the location or click the Browse button to search and
select a folder

4., Click the Next button to continue

Video creation

The final step automatically initiates the creation of the new video file according to the settings
chosen in the wizard's previous steps. The time taken to render the new video will depend on the
power of the computer and the size of the new file; progress of creation is indicated.

You will be notified when the publishing process is complete and, by default, the new video clip will
be added to the Tray, allowing convenient access to replaying it in the Player or Analyzer
modules.

8.1.6 Next steps

SimulCam offer unique analysis capabilities for comparing two athletes' performances blended
onto a single background. You may also be interested in the following topics:

> Read the topic StroMotion for another Dartfish special effect enabling you to dissect motion of a
performer in a panoramic still image or a video clip.

» The Analyzer module offers another way of highlighting key frames and uses them to bookmark
these moments and turn them into still images (read the chapter about the Analyzer to learn
more).

» Having created these unique images, you may want to share them by CD, email or internet
(see Sharing video files in the Video Library chapter).

8.2 Dissect motion with StroMotion

Images produced by StroMotion give an athlete and coach unique insights to how an action
develops. It produces a panoramic still image or a video clip that contains collections of frozen
images, revealing how rapid technical changes are made.
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To imagine how this might help you, think of times when it might be useful to show your athlete
their position on one frame of video then show it's consequences in another frame. How about
educating your junior team about the correct sequence of actions to use? Sure you could print out
some still pictures but StroMotion offers a juxtaposition of images which truly reveals how one
action leads to the next.

The process of creating a StroMotion clip involves 4 steps:

» Step 1 - Load & trim the video clip

» Step 2 - Camera movement computation
» Step 3 - Panorama reconstruction

» Step 4 - Draw clones & save results

8.2.1 Step1-Load & trim the video clip

Loading the video clip

1. Open the clip of your choice from the items list or tray.
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8.2.2

2. The chosen clip may be changed by simply loading a different clip.

Trimming the clip (set cue in & out points)

The clip should be trimmed at the beginning and end of the movement that is to be turned into a
StroMotion image.

1. Setthe Cue in position by moving the Playhead (red triangle above the timeline) to a start
position with clear background features. This will help you match background features in step 2.

2. Click the Set Cue In button, shown on the left side of the image below

An-Nn-NE £ lol
hu'uu'u"'Euu[S" -
1 1

3. Repeat for the Cue out point by moving the playhead to the end of the clip then clicking the
Cue out button. The white section above the time line in the above image indictaes the
segment of video which will be used for the stromotion

Click the Next button at the bottom right of the StroMotion module to proceed to the next step.

Step 2 - Camera movement computation

In step 2 camera movement is calculated. This is initiated by matching at least two background
features in successive frames of the video clip by setting alignment points. StroMotion then
computes the movement of the camera throughout the clip.

@ The points set as alignment points should be static, people are not a good choice of alignment
point! They should also be obvious points in the background as StroMotion can't track the objects if
they are blurred or similar in colour to the surrounding background.

To set alignment points

» Click the left mouse button while pointing at an object (a flag, center line, pole, goal, etc.) that is
present on both frames

» The red alignment marker which appears is labeled with a number. The same marker will
appear on both images.

DARTFISH==
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To adjust alignment points

In the image above the feature point labelled "2" is not marking the same place in both images. To
correct this:

1. Right-click on the incorrectly positioned alignment point to delete it.

2. Then left-click the position where the alignment point should be.

3. Repeat this setting and adjusting operation until you have selected at least two alignment
points

! You can check how well the alignment points match by clicking the Visual Check button. A
window opens showing the athlete moving against a static background. If the background appears
to move or shift, you should check your alignment points or add further points until the background
is relatively stationary.

Calculate camera movement

1. Click the Start button. Shading inside the timeline shows how much of the process is
complete.

2. When the calculation is complete, you are ready to click the Next button to go to the next step.

© Dartfish. All rights reserved. - Version 9 - DARTFISH=%



Unique ways to view sport - SimulCam & StroMotion 166

! The Show warping button allows you to check the result while the clip is being processed. If the
background appears discontinuous as it is constructed , stop the computation and make further
adjustments to the alignment points. This may also be caused by the tripod moving during filming.

8.2.3 Step 3 - Panorama reconstruction

Usually no action is required in step 3 as the panorama reconstruction begins immediately.

1. If it doesn't start then click the Start button. As before, timeline shading will show progress.
2. Click the Next button to proceed to the next step.

8.2.4 Step 4 - Draw clones & save results

This step is where you select the parts of the image which will stay fixed on the subsequent frames
of video and will appear as "clones" on the panorama image. To do this you will:

1. ldentify key frames in the video clip where the performer or object is in a position of interest.

2. Draw around the "clone" object using a range of clone drawing tools.

3. Repeat the above for all key frames.

4. Save the project, result clip or panorama image

8.2.4.1 Identifying key frames

Your task here is to find frames of video showing the athlete (or another object) in a key position of
interest. This is the moment of action that you wish to freeze.

You should already be familiar with how to use the timeline to move through a video clip. Itis
worth remembering to use keyboard shortcuts [ctrl] + [left/right] cursor keys that will play one frame
at a time and fine-tune your selection (read the Getting Familiar chapter to learn more).

@ to insert clones at a fixed interval use the Jumpsize control illustrated below to define the size of
the "jump" and move backward and forward through the clip by this interval.

4 M

Jumpzize: 4

4

8.2.4.2 Drawing clone objects

Having found a key frame of video - one in which an athlete or object is in a position of interest,
that athlete or object now must be cloned. You are not restricted to cloning a single object, so
select all objects of interest in each key frame.

The objects or athletes that you want to clone are drawn, selected and manipulated using the tools
on the right of the StroMotion module.

+] Select tool - select clones or move selection.
Rectangular clone tool - clone creation tool.

Freehand clone tool - freehand clone creation.

€ Delete selection - deletes the performer/object selected by the select tool.
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Delete all - deletes all performers/objects on this frame.

7 Zoom in/out - zooms in on the point on the image that is clicked (right click to zoom out).

To create clones

Use the Rectangular clone tool or the Freehand clone tool tools to "draw" around the
performer/object to be cloned.

To use the Rectangular clone tool

1. Click the Rectangular clone tool button.
2. Then point the mouse above and to the left of the object to be cloned.

3. Click & drag downwards and to the right until the selection box encompass the object while
including as little background as possible.

To use the Freehand clone tool

1. Click the Freehand clone tool button
2. Click & drag around the object staying as close to the edge as possible.

Q@ if you miss part of an object during
selection, don't delete the clone and start
again, simply include the missed part as a
new selection. More than one tool can be
used and more than one selection can be
made to create a clone as shown in the
image below.

Which selection tool is best?

To answer that, remember that whichever tool you use, the selected area will stay fixed on the
video image. If there is overlap between clones, the later clones will obscure the earlier ones.

» Use the freehand tool when there will be a lot of overlap between the clones. For example in a
gymnastic rings routine or high jump.

» Use the rectangle tool when the clones will be spread out - the performer moves some distance
between the key frames. For example in long jump.

To edit clones

1. Select the clone to edit by using the Select tool +1 _Click the tool then click the outline of the
cloned area.

2. Selected clones can be deleted B, moved by click & drag, or reshaped by dragging the
"handles" at each edge or corner, see these illustrated below. All clones in a frame can be

deleted using the tool, it is not necessary to select clones first to use this.
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@ By zooming in on the image using the zoom tool # more careful selection is possible. Click
the left mouse button to zoom in and the right mouse button to zoom out.

8.2.4.3 Publishing StroMotion

Creating StroMotion results is done using a Publishing wizard almost identical tothat used by
SimulCam. Itis initiated by clicking the Publish button in the final step of StroMotion.

Publishing can produce a choice of two results described below. After selecting an output type and
clicking the Next button, the remaining steps are described fully in the SimulCam chapter (see
Publishing new video clips in the Simulcam chapter).

StroMotion still image

An image of all clones superimposed on the background. If a panning camera was used, clones
are superimposed on a panoramic background image composed from each frame of video. An
example of this is shown below.

Although images will appear in the Items List, no Dartfish modules are used to display them:; if
opened they will be opened using the default Windows image display/editing software on your
computer.

StroMotion video

The original video has each clone appear and remain on the video image as the movement
develops.

8.2.4.4 Saving StroMotion

It is possible to save a Stromotion project if you wish to return to it to make adjustments or
publish its results later. StroMotion projects are represented by the following icon in the Items List.

Save the settings used to create the project by selecting File > Save as... from the menu bar.
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8.2.5 Next steps

StroMotion is one of Dartfish's special effects allowing you to view movement in unique ways. You
may also be interested in the following topics:

» Read the topic SimulCam for another Dartfish special effect enabling you to place two
performers together in the same place and time.

» The spline drawing tool (see chapter on Analyzer) is another way of tracking and illustrating
movement.

» The Analyzer module offers another way of identifying key positions and uses them to
bookmark these moments and turn them into still images.

» Having created these unique images, you may want to share them by CD, email or internet
(see Sharing video files in the Video Library chapter).
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9 Tagging Video

Traditionally, reviewing sporting performance on video is a linear process — you play the video and
observe the action as it takes place. Of course the fast forward button saves time but finding and
replaying important moments in the game or competition essentially remains linear — and slow.

Imagine how useful it would be to be able to mark and label these events on the video as it is
recorded? You could later jump between these marks in any order you choose. You could review
only the events of interest and choose to see related events: "Let me look at all the times our
opposition scored" ceases to be a lengthy process of fast forward and play.

Dartfish's Tagging module doesn't physically mark a tape but instead brings digital video onto the
computer and allows you to create a searchable index of the video content. Each event is tagged
with not just one label but a set of keywords that really identify what is happening. This process not
only lets you search and review these events but compiles match statistics: "Which shot does my
opponent most often score with?" is not only a question that can be easily answered, but the
relevant shots can be replayed and analyzed.

A short history of tagging

If all this sounds familiar, that is because Dartfish Tagging is a combination of long-used tactical
analysis methods:

» Notational analysis - the coach or analyst sits on the sideline with pen & paper ticking off or
coding events as they take place in a game. Tagging does this using buttons which are clicked
to code events.

» Video indexing - even before digital video, coaches attempted to make it easier to find useful
moments in the video of the game by noting the time that they took place. This made it easier
to fast forward to that point on the tape but it's easier still with Tagging; the events you code are
listed in an index which can be searched and displayed non-sequentially.

Is Tagging just for Team sports?

No. While other Dartfish modules are used for technical analysis of isolated events. Tagging is
more about a tactical analysis of the game as a whole while being able to focus on specific
moments of choice. It is therefore useful for any sport where these qualities are of interest: Team
sports, racket sports, combat sports, skating/gymnastic routines etc.

In this chapter

» What is Tagging?

> The Tagging Workspace
> Creating Tagging panels
» Tagging video
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> Importing events

» Review & edit events

> Filtering and viewing statistics

» Producing & sharing tagging resources

9.1 Whatis Tagging?

Tagging is the action of creating a video index, a list of Events that occur in the video. Consider
for example a video that contains a soccer game; the video index could look like this:

Index Position Duration Event Type  Player Team
Event #1 23s 7s Pass Defender Team A
Event #2 1 min 13s 7s Free kick Striker Team B

» The Position corresponds to the time in the video when the event occurred.

» The Duration is a portion of the video when the events take place.

» Event type, Pass and Team are Categories. Pass, Defender and Team A are the keywords in
each category.

An event is fully defined by the Position, Duration and the categories' Keywords. It can be
illustrated as follows:

Event #1 Ewvent #2
Position 1 Position 2
Duration 1 Duration 2
Team A Team &
Midfielder Striker
Fault Free-kick

v

Wideo clip

Once you have created your index, you will be able to retrieve particular events. For example, you
may want to retrieve events that match the following criteria:

» Team =Team A, i.e. all events of Team A

» Event Type = Pass and Team = Team A, i.e. all the passes of Team A

It is important to be aware that the Tagging module doesn't just tag instantaneous events such as

these examples, lengthy sections of video such as a team's ball possession can be tagged at the
same time as the passes and free-kicks taking place during that possession.
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9.2 The Tagging Workspace

To launch the Tagging module, click on the Tagging button in the tool bar, or select Tools >

Tagging from the menu bar.

The module workspace is illustrated below:

It is composed of four different elements (clockwise from top left):

1. The Library (more precisely the Tray of the library), which opens a collection of video clips to

be tagged or reviewed.

2. The Video Panel, which contains the video display and the different video controls which let
you capture and replay video. This also has controls to display and hide the other panels and

select the video source.

3. The Tagging Panel, which contains a set of buttons and other tools; some of which create a
timestamp for each event and others which describe the event with values.

4. The Events List, which contains the list of events, i.e. your video index. It also has features
related to the management of events; editing, searching and import/export functions.

These elements are described in more detail in the remainder of this section.

! When you launch the Tagging module for the first time, the workspace may not look like the one
illustrated above. If any of the four elements are not visible they may be displayed by using the
Views Bar buttons at the top right corner of the video panel (see The Video Panel)
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9.2.1

9.2.2

The Library

It is likely that your tagging analysis will based on more than one file. Perhaps different periods of
the game were recorded as separate video files or perhaps you are reviewing the video of an
entire season. Dartfish offers you a simple way of working with as many video clips as you require.

Tray = > Clear Ci% Share = E

Fribourg v Atlanta(1) | Fribourg v Atlanta(2)

Loading all the clips you wish to analyze into the Tray section of the library allows you to:

» See events from of all clips contained in the Tray; allowing the events of many videos to
be analyzed together.

» Search for events from all video clips within the Tray.
» View or tag multiple video files as if they were a single clip.

When working with multiple clips, it is useful to know that the video clip highlighted with a green
triangle is the one currently being played or tagged and that the Player's repeat options can be
used to play each clip continuously as a single movie (See Video playback in the Getting Familiar
with Dartfish chapter)

The Video Panel

The Video panel is illustrated below.

4.80/26:18.38

k]
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|E3 Taglive [ TagVideo Clip | (] Play Events

The Mode Bar at the top left of the video display enables you to choose between two tagging
modes and a video player mode.

» Tag Live mode records a video stream, at the same time as allowing you to tag during capture.
The screen and the different settings are identical to the Video Recorder module (see Video
Recorder: capture a video stream in the Video Import chapter)

» Tag Video Clip mode allows you to play entire video files that exist on your hard disk. The clips
can be tagged during playback

» The Play Events mode allows you to play back the selected events from the Events list

These last two modes use the video playback controls illustrated above. Read the section Video
Playback of the Getting familiar with Dartfish chapter to learn about the different controls.

Views bar

The Views bar is found at the top right of the video display. Its buttons show and hide the different
parts of the Tagging module. The buttons' functionalities are:

= | showrhide the Tagging Panel

showr/hide the Events list
show/hide the Library
= showrhide the Table

¢ show/hide the Keyword filter

@ Use the maximized workspace view (keyboard shortcut = F9 to simplify the screen layout then
show or hide these features as you need them.

9.2.3 The Tagging Panel

The Tagging Panel contains the tools to tag (or create the events index) of a video. It is also used
to

» Access the tagging panels provided with Dartfish

» Open panels created by you or sent to you by others

» Create or edit new panels.
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* Panels ~ |4 Edit

Game tagging Team selection Game info Presentations

Actions
Aerial challenge lost  Aenial challenge won Foul  Goal

[ (L] € M
Shot ontarget Shot off target  Tackle lost  Tackle won
[E] ]| ] [
Other highlight
Posession

Mon attacking possession  Attacking possession ..with shot
a

Posession duration (fouches)
B2 S S e B O RO R

Home Players

Luke Mulholland William Mjamen Joseph Prince

Andrew Konopelsky  James Goodwin  Jake Wright Brian Ramsey
Joseph Prince-Wright Per Engebreth Faerden Mark Wiltse
Kareem Yearwood

Match info
Match description | Opposition/date 1st Half Znd half

The Panels button

The Panels button is used to open tagging panels which you have created or those which you
have been given. It also gives access to the built-in panels and to create new panels to meet your
specific needs (see Creating Tagging Panels).

@ Tagging panels are saved as files just like Word documents or Excel spreadsheets. In other
words, they exist independently of Dartfish software, they can be saved and organized using
Windows file management, and can be attached to emails to be shared with others.

The Edit button

Opens the tagging panel editor. A tagging panel must already be open before the edit button
can be used.

The tagging panel

Although Dartfish tagging panels allow great flexibility and creativity in how they can be used, the
tools on them principally have one of three functions:

1. Event tools - used to create events by time stamping the event and assigning it a descriptive
value

2. Keyword tools - used to add additional keywords to events

3. Grouping tools - used to organize other tools into groups; either to improve the layout visually or
ergonomically or to confer shared features on the group

Tagging panels can consist of one or more pages, accessed by tabs. Buttons and tools for use
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at different times in the tagging process are placed on different pages to improve the ergonomics
of the panel.

9.2.4 The Events List

The Events List contains the list of all events for all video clips in the current Tray:

Il impertExport 3R Publish ~ < Storyboard | €4 Show All | Filter events B @
# Mame ‘Posit':nn Duration  Action Player
1 Men-attacking possesion 17 sec 29 sec
2 Tackle Lost [ 36 sec Ssec  Tackle Lost Ben Taylor
3 Tackle Lost il 39 sec Ssec  Tackle Lost Guilherme Reis
4 Tackle Lost I 40 sec S5sec Tackle Lost Anteneh Lemm
5 Tackle Lost l 41 sec 5sec  Tackle Lost George Davis IV
& Foul I 43 sec 10sec  Foul Williarn Mjamer
7 Tackle Lost | 47 sec Ssec  Tackle Lost Williarm Mjamer
8 Aenal Challenge Lost E 1 min 11 sec 3sec  Aenal Challenge Lost Jean Tshimpak:
9 Aenal challenge won I 1 min 12 sec 3sec  Aenal challenge won Joseph Prince-%
1N Tarkla Wan W 1 ovin 15 ean Sear  Tarkls Wan Andreuw Kanani

Events are selected by clicking on the row containing them. The video playhead moves to the
start of the event. Double-clicking an event both plays it and places Dartfish tagging in its Play
Events mode.

Selected events may also be:

» Deleted using the Delete button G

Analyzed in Dartfish's Analyzer module (Storyboard button) 5 Storyboard

>
» Exported as .csv files using the Import/Export button el Import/Export ~
>

Published as new video clips that can be stored on your hard drive (e.g. to make a highlights
movie using video editing software) or directly burned onto a CD or data DVD (e.g. to give to
team players or coaches), or uploaded to your dartfish.tv channel using the Publish Events
button.

2R pusls ~
Upload Game
Upload Highlights Movie
Create Event Clips |

» Sorted by clicking on the column heading you wish to sort.
> Searched and filtered. See Search to retrieve specific events for more details.
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9.3 Creating Tagging panels

To create a new tagging panel, proceed as follows:

1. Click on the Panels button and choose New from the context menu.

| * Panels 'i

Mew

Open...
Manual Tagging

1 ChUsers\Meil\Videos\Tagging panels\Football\Team3 tagging.TaggingProject
2 ChUsers\Neil\Desktop' Untitled. TaggingProject

Show Keyboard Shortcuts
Show Tooltips

Flat Style

2. Click on the New Panel icon

j New Panel
L

3. Select from the list of new project types. Create a new Blank Panel if you wish to start with an
empty panel OR base a new panel on one of the built-in tagging panels. This displays the
Tagging Editor window as shown below

@ We recommend starting by using one of the Dartfish built-in tagging panels. Change labels and
add/delete buttons as necessary for your sport.

The Tagging Panel Editor

[} Untitled * - Tagging Pane! Editor . A . (= [ E] ]
File Help |
L:? Panel Editor |I§} Database Editor |

ToolBox Untitied Tab i Properties

4 ijj Event Creation Tools E Appearance

_J Event Button Ttem Id P g

[_J Continuous Event Button Label Untitled Tab
4 i Keyword Addition Tooks Visibility Visible

Keyword Button B Ewent
- Persistent Keyword Button Category

Aa Text Box

Ed] Score Panel

IX Zone Tool
4 | Panel Layout Tools

[™) Group Bax

9 Teb Group Box
i Team Manager Toolks
EE Team Manager
—) Team Group Box
== Player List Selector
il Video Filing Tools
¥ File Name Template Button

9

&

The tagging panel editor has 3 sections, (left to right as displayed above):

1. The ToolBox contains buttons and other tools used to create and describe events. They are
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added to your tagging panel by drag and drop.

2. The Tagging panel editor. This is where the content and layout of a tagging panel is defined.
A new blank tagging panel already contains a tab group box allowing you to create a multi-

page panel if required.

3. The Properties pane. Properties are used to define the appearance and actions of tagging

panel tools

9.3.1 Adding/deleting/moving/copying tools

To add a tool to a tagging panel

Items are placed onto the tagging panel editor by dragging and dropping them from from the

Toolbox.

! New panels always have a tabbed group box with a single page, as show below. In order to
place the tool on that page, it should be placed in the area denoted by the red line shown here:

Untitled Tab | F

Adding subsequent items also requires care, in the image below, new tools should be placed on
the gray shaded area if they are to appear on the same page as the other buttons.

General Details Game Actions Game Phases |l
Game phases

Offensive Play | Defensive play | Transition

System

System 1| | System 2 | Systern3 | System 4| | System 5

End of game phazes

Shot  Steal  Missed Pass Block

@ If placed below the page then that tool will be visible from all pages.
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To move an item

Drag and drop the item you want to move to the new position.

To move a panel layout tool (group boxes etc)

1. Click within the panel layout tool (but not on any button or other tool)

2. Ared outline surrounds your selection - use this to identify that you have the correct tool
selected

3. Click and drag the panel layout tool to a new location

! ltis not possible to move a group box to between other group boxes. Instead it should be moved
above or below the other group boxes which can then be shuffled further to achieve the desired
position.

To delete an item

Right-click on the item and select Delete from the context menu.

To copy an item

Drag and drop the item while holding down the CTRL key on the keyboard. Release the item
before releasing the CTRL key.

@ Many tools will have similar properties so creating one button, defining its properties and then
copying it can be a very efficient way of creating a tagging panel.

9.3.2 Modifying properties

Items which have been added to the Tagging Editor have their appearance and function modified
by changing properties in the Properties panel. There are two types of properties; properties which
can take any value and properties which must take one or more fixed values. The methods for
modifying these two types of property are described below:

A complete description of properties can be found in the topic Properties list

Modifying 'any' value properties.

1. Click on the tool. This will display the properties for that item.
2. Click and type in the second column of the properties list to add or modify values.

Modifying 'fixed' value properties.

1. Click on the tool. This will display the properties for that item.

2. Clicking in the second column of the properties list will allow you to select a value using the
buttons that appear. It is not possible to type values. One of two types of button are used:

-] - selects or creates property values from a dialog box e.g. shortcut key property
I - selects property values from a drop down list e.g. style property

In the example shown below these buttons are shown as they would appear in the properties
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panel. Properties such as Shortcut Key, Preroll and Trigger are selected using . Properties
such as Style are selected using =, and properties such as Category, Value and Label are typed.

Evert Properties
E Appearance
ltem Id EventButton5
Label Event
Tookip Create an event when the button is clicked.
Shortcut Key ||
Image
Style Red =
B Event
Category
Value
Preroll b sec
Duration 10 sec
E Interaction
Feset Category
Trigger

The shortcut key is the key that should be pressed on
the keyboard to trigger the action attached to the item.

@ Double clicking the property heading in the column on the left is a shortcut to editing properties.

9.3.3 Planning a tagging panel

Example of a basic Tagging Panel:

fTagging Panel x

¥ Select = | 4" Edit

Game Informaticn Game Acticn Game phase

Standoard Set Pieces

| Corner (| Throw inII Penaliﬂ (| Free Kicki

Game Set Pieces

Shot (| Cross || Tackle (| _Foul (|_Pass
| | | e | |erelie | | | | p—ss—
Shot Cutcome Cross Description Pass Descripticn

Goal || Blocked | | Missed | | Deflected | Cut
I S R N

Which events do you want to tag in your sport?

Creating tagging panels requires a clear idea of what you want to tag and how you want to define
the events' durations and the keywords which describe them.

One definition of an event could be "a segment of video". You need to decide what are the
different types of video segments that you want to denote. Those events are likely to be key
moments or highlights within the video.

Many events in your sport or activity are easy to define but perhaps others are less easy, consider
this example:
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In soccer, ball possession in the opponent's half is a key moment that might be tagged as an
"attacking possession”. That possession might end in an attempt to score. So do you want to tag
two events (attacking possession and attempt) or one (attacking possession; outcome = attempt)?

There is no right or wrong answer to this; your decision will be based on what you want to review;
tagging this as two events gives you the capacity to choose whether to review attempts separately
from attacking possessions.

From this example it should also be clear that Dartfish allows you to tag events which coincide or
overlap.

Which of these events have a fixed duration (e.g. actions) and which
are of variable duration (e.g. game phases)?
Dartfish can create 2 types of event.

1. Those where the duration can be predicted so only require a single button click to create an
event with fixed duration.

2. Those where the duration of is not predictable and is defined by clicking a button on and then
off.

! Regardless of how the event duration is defined, it is editable after creation.

How will your events be categorized?

The events list is a table made up of rows and columns. Each row contains the keywords which
describe the event and at the top of each column there is a heading which describes the category
of information displayed in that column.

When categorizing events you may choose to simply list all events under a single heading such as
‘Action’ in the example below:

= Position Duration Action
12 sec 29 sec  Mon-attacking pessesion
32 =sec S5sec  Tackle Lost
34 sec S5sec Tackle Lost
35 sec 5sec  Tackle Lost
37 sec S5sec Tackle Lost
43 zec 5sec  Tackle Lost
44 sec S5sec  Foul
1 min7 sec 3sec  Aerial Challenge Lost
1 min7 sec 3sec  Aerial challenge won
1 min1l =ec 5sec  Tackle Won

Or you may decide that your events fall into different categories such as 'Set piece plays', ‘Open
play', 'Phases’, 'Possessions' etc.

Placing all events into a single category keeps things simple, but using different categories offers
flexibility when it comes to filtering the events list and creating statistics.

! ltis not possible to simultaneously create multiple variable duration events (i.e. those created
using the continuous event tool) with the same category. If this is required, it is essential that
different categories are used. For example, Team A might have possession but if there are to be
different phases of play within that possession then these events should be categorized differently
e.g. 'Phase’ and 'Possession'.
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How will you describe these events? Events are described by
assigning keywords to them.

Creating an event automatically adds 3 keywords; the video position, the duration of the event
plus one user-defined keyword. Further keywords can be added to more completely describe the
event so you need to consider what additional categories of information are needed. For example:
'Player' and 'Outcome' might be categories of keywords need to fully describe an 'Attempt' event.

What Keywords are required for all events?

It is very common that you will be tagging or reviewing the tags from more than one video file as
described in the topic The Library. In this case the same keyword should be added to all the events
of each file to allow you to easily distinguish which events belong to which file.

For example, if you create 2 video files for the first and second half of the soccer game, it would be
a good idea to have a category in your events list headed 'Game period', containing the keywords
"1st Half' and '2nd Half' to allow you to distinguish between events which took place in the first
video file and the second.

Ready to start creating a tagging panel?

Having thought carefully about the questions above, you will have a list of events and a list of
keyword categories. No doubt you have also have some ideas about the keywords which should
go into each category. Now you are ready to turn those ideas into a tagging panel.

9.3.4 Panel layout tools

Group boxes

These tools organize the layout of a panel by grouping buttons together. So unless you have a
very simple tagging panel, group boxes are likely to be the first tools that you will add to a new
tagging panel. They have two functions:

1. To organize the layout of buttons on a tagging panel.

2. To setthe category property of many buttons simultaneously i.e. tools placed into a group box
inherit their category from it.

This is an efficient way of ensuring the category property of buttons is not omitted or
inconsistently applied. However it is possible to over-rule the inherited category simply by
setting the property of the individual tools.

@ if you have already read the topic Planning a tagging panel, you should have a good idea of
what categories your events list requires. Start your new tagging panel by adding a group box for
each category and set the category property of each to each one of your categories.

Nesting group boxes

It is possible to place group boxes inside another group box. In the example below, group boxes
have been used to organize the layout of players on a soccer pitch.
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Game Informaticn Game Action |l

| Players

|| Forwards

Midfield

Defence

. Keeper

In this image, 'Players' is the selected group box and the red line indicates that it contains the
other group boxes. Its category property is set to 'Players' therefore the other group boxes and
any buttons placed in them inherit this.

Tab group boxes

The pages of a tab group box each behave like a group box, the contents of which are only seen
when the tab of that page is selected.

Shot Qutcome Cross Detail Pass Detail Phaze end

I Goal IiBIockedii Missed”Deﬂectedil Ciut |
I P P |

The advantages of a tabbed group box are:

» They are a very space efficient way of including many buttons on a tagging panel.

» Panels can be created to only show buttons which are relevant to the current event; simplifying
the panel and guiding the user to appropriate tools.

@ Use the trigger property of a button to automatically select a tabbed group box page. Examples
of this method to display relevant buttons as they are required can be seen in most of the built-in
tagging panels.

Adding tabs to a tabbed group box

In the tagging panel editor, new pages are added to a tab group box by clicking the last tab
showing the new page icon. The new page displays the label [...] until an alternative label property
has been set.

Panel layout tool properties

Property Description
Label The text which is displayed on the tab.
Visibility The visibility property is a way of concealing tagging tools when the user is

not required to use them directly. Other tools can be used to trigger the
contents of a hidden group box even when not visible.

Orientation Defines whether the contents of a group box are stacked vertically or placed
horizontally within a group box.
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Image An image can be placed as a visual label for the group box. It will be resized
to fit next to any text label

Category The category of a layout tool sets the category of any other tool it contains.
Inheritance can be over-ruled by setting the category of individual tools

Event creation buttons

Event creation buttons are used to add events to the Events List. The action of these tools is to
create an event described by:

» Position - the timestamp of the start of the event in the video clip

» Duration - how long the event last for

» Keyword - the event is described by a single user-defined keyword. The event can be more
fully described using Keyword addition tools after the event is created

» Name - the filename that will be used if the event is exported as a video clip. This will be the
based on the event keyword but can be modified.

Event buttons

The difference between Event buttons and Continuous event buttons is how they define the
duration. Event buttons are used to create events with a fixed duration e.g. a tennis serve might
take around 5 seconds to prepare, deliver then witness the outcome. A single click on this type of
event button records the event.

| Event Button

Continuous event buttons

Continuous Event buttons are used to create events where the duration cannot be predicted, e.g. a
whole point in a tennis game or an attacking phase in soccer. This button is clicked "on" and "off"
as the event starts and ends.

| Continuous Event Button

Continuous events are also switched off by activating other continuous events with the same
category property. For example, this allows you to define the change in possession from one
team to another with a single click. This improves the ergonomics of tagging but it makes the
categorization of continuous event buttons important: if two continuous events are to run
concurrently then they must have different categories.

Important event creation tool properties
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9.3.6

Property Description

Label / keyword properties [These properties define the keyword to be recorded in the events list.
Where the keyword property is not set, the label on the button will be
used as the keyword. By setting these properties to different values, it
is possible to tag a different keyword to the text displayed on the

button.
Category property Defines the column of the events list where the keyword will be added.
Without a category property the button won't record its keyword.
Duration For event buttons only; this is the fixed duration of the event
Preroll Defines the number of seconds before the button click that will be

included in the event.

For example when a shot is made, the button is clicked but you want
to define the start of the event 10 seconds prior to this in order to see
the action leading up to the shot.

An event button with a 10 second preroll and a 15 second duration
would define an event starting 10 seconds before the button click and
ending 5 seconds after.

Offset start For continuous event buttons only; the equivalent of preroll.

A negative value defines the event start prior to the button click and a
positive value defines the event start after the button click.

Offset end For continuous event buttons only; defines the end of the event before
or after the button click.

These are the essential event button properties. Other properties are described in the Properties
list topic.

Other event creation tools

The team group box tool and the Zone tool can be used to create events by setting their Action
property = event. However, their default action is as keyword addition tools.

Keyword addition tools

Keyword addition tools are used to add keywords to an event. They do not create events. Keyword
addition tools can be one of two types:

» Keyword tools - are used after an event has been created to add a keyword to that event only

» Persistent keyword tools - are activated before an event and add their keyword as the event
is created. They remain active until deactivated and so can be used to add their keyword to
many events.

Keyword button

A Keyword button assigns an addition keyword value to the last tagged event (or to the selected
event in the Events List).

| ﬁword Butt.cu':i

Persistent keyword button

DARTEISH:=% - Version 9 - © Dartfish. All rights reserved.



187 Dartfish User Guide

The persistent keyword button applies its value to all events which are tagged while it is active
("pressed").

| Ferzistent KEﬁord Buitonl

For example, in tennis the name of the server could be assigned to a persistent value button. All
events created while that button is active will be tagged with the server's name.

@ Persistent keywords can be very useful when the analysis consists of more than one video file.
For example to allow you to differentiate between an event which takes place one minute into the
"first half" and another which takes place one minute into the "second half". First and second half
are the persistent value buttons in this example.

Text box

The text box tool is a persistent keyword tool that assigns a variable keyword based on text
typed into the box. For example you might use this to include the name and date of the competition
or information about the conditions, as illustrated below:

fTagging Panel x

* Select = |4 Edit

Game Informaticn Game Action

Lecation  Fribourg (away game.
Date 010611

Round - Semi-final

Score panel

The score panel is a persistent keyword tool that lets you record the current score of the game.

Seare Panel
Qe
gA = o=

Zone tool

The zone tool is used to record where an event takes place based on where an image is clicked.
The recorded keyword is the coordinates of the clicked position or a keyword for designated
zones. The zone tool is further described in the Zone tool topic

Important keyword addition tool properties
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Property Description

Label / keyword properties [These properties define the keyword to be recorded in the events list.
Where the keyword property is not set, the label on the button will be
used as the keyword. By setting these properties to different values, it
is possible to tag a different keyword to the text displayed on the
button.

In the case of the textbox tool, the keyword property can be used to
define a default text box entry.

Category property Defines the column of the events list where the keyword will be added.
Without a category property the tool won't record its keyword.

These are the essential properties. Other properties are described in the Properties list topic.

Other keyword addition tools

The Team Manager, Team Group Box and Player List Selector can also be used to add
keywords to events. Their use is described in the topics Team Manager tool and Team Group
Box and Player List Selector

9.3.7 The Zone Tool

The zone tool is used to record where an event takes place by clicking a position on an image
instead of clicking a button. The keyword it adds can be either numerical coordinates or a user
defined keyword or both. The default image is a soccer pitch but can be changed to any image.

Preparing the Zone tool to record coordinates

1. Setthe Image property: Any image can be used but it is not resized by Dartfish, so it should be
created and edited at appropriate dimensions with image editing software before addition to the
panel.

2. Define the grid: Field height and field width properties are used to define a grid e.g. a field
width value of 3 would split a soccer pitch into three vertical sections or a field width = 100
would split an American football field into 1 yard sections.

3. Define the center of the grid: Field center X and field center Y properties are used to define
the coordinates of the center of the grid. When the zone tool is clicked, zones to the left or
above the central zone record a negative coordinate, zones below and to the right record a
positive coordinate. If left at default settings, the origin will be at the top left corner of the image
and the grid area at the top left will record the coordinates (1,1)

The image below shows the coordinates which are recorded when a zone tool with field height
and width=3 and Field center X=2 and Y=2:

-1,-1 0,“1 1}'1
-1,0 0,0 1,0
1,1 0,1 1,1
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4. Set the category: as with all tagging tools, the zone tool requires a category in order to be able
to record its keyword in the events list. The default category is 'Field position'

! Each zone has equal dimensions. For sports with playing areas where the zones are not equal it
will be necessary to create a zone tool image which distorts the zones to equal sizes. The grid is
not shown. If it is required, it should be defined on the image itself using image editing software.

Preparing the Zone tool to record text keywords

1. Setthe Zones property; a new window appears

Click the Add Zone button

Position the new Zone using drag & drop with the mouse

Drag the sizing handles in each corner of the zone to define the area

Define a Keyword property for the zone - this is what will be recorded in the events list when
the zone is clicked

ok wbn

6. Define the Category property for the Zone. By default this will be the same as the category
property for the Zone tool. It is possible to override this if a different category is to be used
Zones X
Keyword: [-Bdse-'i"e R ' (I | AddZone | Delete Zone

|
Trigger lems [ I Edit

Category | Return to |

7. Repeat for other zones

! If zones overlap, the keyword of the topmost zone will be used

Recording both coordinates and text keywords
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¢ When no text keyword zones are defined coordinates are recorded in the Events List in the
column defined by the Category property.

¢ When text keyword zones are defined, coordinates are no longer recorded.

¢ To record both, set the Coordinates Category property. Doing so creates a new column in the
Events List where coordinates are recorded.

Event creation tool or keyword addition tool?

By default, the zone tool is a keyword addition tool. It can alternatively be used to create events.
To do this set the Action property to 'Event’ and define Preroll and Duration properties as for an
event button.

9.3.8 Team Manager tool

If you have many players or several different teams to tag, you can use the Team Manager to
manage a database of all teams and player names, then select only those players taking part in
the game. The selected players can be represented on the panel by linking the following tools to it,
using their Team Manager Link property:

» A Team Group Box tool - displays buttons representing each player selected in the Team
Manager. See Team Group Box topic

> A Player List Selector - ateam and up to ten players can be selected from lists produced by
the Team Manager's database. Selections can be used as persistent keywords or linked to the
keyword property of other tools. See Player List Selector topic.

Preparing the Team Manager tool

Very little needs to be done with the team manager during tagging panel creation. Simply add it to
your panel; teams and players will be added after closing the editor.

Setting the category property for the team manger is optional. If it is set then a keyword
representing the selected team will be recorded when a player button is clicked.

Team Manager databases

The teams and players that you add to a Team Manager tool are stored in a database file which is
created automatically in the same folder and with the same name as the tagging panel. However,
you may want to use a database previously created by you or another Dartfish user.

Use the Database Editor tab of the tagging panel editor to select the database file that you wish to
use.

Each tagging panel can have only one database but have many team managers enabling
selection from different teams and players.

Adding teams and players

Teams and players are added outside the editor as described in the topic Using the Team
Manager

Q@ To simplify the layout of a tagging panel it is usually best to put a team manager on a separate
page of your tagging panel from the team group box and other tagging buttons. During tagging,
most activities will not require frequent access to the team manager; perhaps only before the start
of the game.

DARTEISH:=% - Version 9 - © Dartfish. All rights reserved.



191 Dartfish User Guide

Important Team manager properties

Property Description

Label Using a label helps to identify a team manger. This is useful when
linking it to a team group box or when more than one team manger is
being used.

Category property The category property is not an essential property for a team
manager. If used then a keyword representing the selected team will
be added to the events list.

These are the main properties to consider. Other properties are described in the Properties list
topic.

9.3.9 Team Group Box

A Team Group Box is a group box to which buttons are added by selecting players from a linked
Team Manager as illustrated below. When there are many potential players which you may choose
from, it enables you to display only the buttons required .

Team Manager

HC Fribourg-Gotteron = 7

Cristobal Huet -
| Damiano Ciaccio
¥ Marc Abplanalp 3
SergeSenge Aubin
[¥] AlainAlain Birbaum
[T Cedric Botter
[ Andrej Bykov
#| Franco Collenberg
| Lukas Gerber

U WP

Team Group Box
Franco Collenﬁa

Team group box buttons can add keywords or create events

Team group box buttons are Keyword buttons by default. Set the Action property to define
whether the buttons function as keyword buttons, persistent keyword buttons, event
buttons or continuous event buttons.

For example, a persistent keyword button might be used to tag the 'Server' to all the events
created in a tennis game whereas event or continuous event buttons might be used to tag player
possession in soccer.

Linking to a Team Manager

A Team Manager tool must be linked to a Team Group Box or a Player List selector tool which
will display the selected player names. To do this, proceed as follows:

1. Select the team group box or Player List Selector.
2. Double click the Team Manager Link property to display the property editor window (as shown
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below).

3. Select the Team Manager to be linked; it is identified by its label and Id.
4. Click the Add button. The Team manager on the right is that linked to the team group box.

Team Group Box Properties
(] Appearance

Trern Id

Label

Style

Tooltip

et
| Team Manager Link

Preroll

Duration
B Interaction
Behawior

Team Manager Link &
Filter £ -
Inager
Label Id Id
Opposition pla...  TeamSelectorl imrn:::lu'rcrs TeamSelector)
1
[ asd- [ w
Remove Down
oK | cancel

! Buttons are not added to the Team Group Box in the tagging panel editor. They are added by
selecting players from the Team Manager on the completed tagging panel. This allows players to
be added or removed during the game.

Important team group box properties

Property

Description

Team manager link

Establishes a link to a team manager and its database of teams and
players.

Category property Defines the column of the events list where the keyword will be added.
Without a category property the tool won't record its keyword.

Action Defines the button type used in a team group box. The default setting
is keyword button but buttons can also be event buttons, continuous
event buttons or persistent keyword buttons.

Duration/Preroll If buttons are event buttons, duration and preroll properties should be

set to define these features of the event. See the topic Event creation
buttons to learn more about these button types.

These are the essential properties. Other properties are described in the Properties list topic.

9.3.10 Player List Selector

A Player List Selector may be used for several outcomes:

» To add a selected player's name as a persistent keyword to events
» To add multiple player's names as a persistent keyword to events

DARTFISH==
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» To add a player's name to the keyword recorded by another tool by referencing the Player List
Selector from the keyword property of a button (see Using variable keywords)

Preparing a Player List Selector to record a player's name as a
persistent keyword

Red contestant |GB Taekwondo v” Ruebyn Richards v]

Blue contestant ISwitzerIand v”Paco Cerletti v|

1. Setthe Category property for the Player List Selector e.g. in the example above, the category
"Red Contestant” might be used for the first Player List Selector.

2. Set the Team Manager Link property to link the Player List Selector to a Team Manager
tool

Preparing a Player List Selector to record multiple players' names as
a persistent keyword

Suisse v
Players | Johann BERNOULLI v | Max FRISCH v | H. R. GIGER L]
Daniel BERNOULLI v Gotffried KELLER | v

1. Setthe Number of Keywords property to the number of players required e.g. in the example
above, the number of keywords = 5

2. Set the Category property for the Player List Selector e.g. in the example above, the category
"Players" might be used

3. Set the Team Manager Link property to link the Player List Selector to a Team Manager tool
(see the topic Team Group Box for more information on how to do this)

When the Player List Selector is used in this way, a single keyword is recorded, listing each
player separated by a semicolon (;)

Player
Johann BERMOULLI;Max FRISCH;H. R. GIGER;Daniel BERNOULLI; Gottf...

Preparing a Player List Selector to be referenced by another tool

The Player List Selector can also contribute the selected player(s) nhames to the keyword
property of another tool, an Event button for example. In this case, the Player List Selector
would be prepared as in either of the examples above BUT setting the category property is not
required. To learn more about this, see the topic Using variable keywords.

Adding players to a Player List Selector

Players are added using the Team Manager tool

@ When you wish to define or describe the actions of a team of players, consider whether the
Team Group Box may be a better choice of tool. It uses buttons rather than lists.

Important Player List Selector properties
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Property Description

Team manager link Establishes a link to a team manager and its database of teams and
players.

Category Defines the column of the events list where the selected player will be
added as a keyword

Number of keywords Up to 10 players can be selected from one team

Sort Items Defines whether players are listed alphabetically or in the order in

which they appear in the Team manager

These are the essential properties. Other properties are described in the Properties list topic.

9.3.11 The Filename Template tool

The Filename template tool enables tagging panel creators to control the file name used to save
recordings made when using live tagging. When the user clicks the button it sets the file name for
the next video recording.

To use a filename template:

1. Add afilename template tool to the tagging panel
2. Set the label property to indicate the function of the button
3. Set the File Name Template property to the desired file name

@ The file name template property can be set to a variable value based on the selection from a
Player List Selector tool. See the topic Using variable keywords to learn more.

9.3.12 PTZ move button

This button is used by those who are using network cameras with pan-tilt-zoom (ptz) functionality.
The PTZ move button is used to to select preset camera positions.

To use a PTZ move button

1. Define position presets on your camera
2. Setthe PTZ preset name property of the button to the PTZ preset to be used, as shown in the

image below.
STIUTLLUL mEY
Group Bax Orientation Vertical
Defence| Midfield @ Attack  Goal mouth Image
Image Size Fixed Size
Style Default
B Action
PTZ Preset Name Defence

= Interaction
Trigger

Important team PTZ move button properties
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Property Description

Label Information for the user to identify the button

PTZ preset name Defines the camera preset which will be selected when the button is
clicked. The values entered must correspond with those created on
the camera

These are the essential properties. Other properties are described in the Properties list topic.

@ The trigger property can be used to activate other tools and vice versa e.g. when a ‘corner’

button is clicked on a soccer tagging panel it could trigger the 'goal mouth' PTZ move button.

9.3.13 Properties list

By clicking on any item on the tagging panel editor, its properties are displayed in the
Properties pane. The properties of each tagging panel element are used to alter their appearance

and behavior.

Most tools have three crucial properties which you should set:

1. Label — the text that identifies what this tool does.
2. Keyword — the keyword that will be assigned to the event (same as label by default)

3. Category — the category to which the keyword will be assigned. Think of the category as being
the column heading of the Events List in which keywords will appear. (see Planning a
tagging panel for help to plan the categories that you need).

Properties which alter appearance:

Property What it does... Applies to...

Label Sets the text that is displayed on the item All

Tooltip The tooltip is the explanatory text that appears when |All event creation and
the mouse cursor is pointed at a button. Use this to keyword addition tools
explain the function of each button.

Image An image can be displayed on a tool to help identify Buttons, group boxes,
the event or value that it represents. zone tool
As the Zone tool is based on clicking an image, this
property is essential.

Orientation |For a button this defines whether the image is Buttons, group boxes
displayed above or to the side of the label.
For a group box this controls whether buttons are laid
out vertically or horizontally.

Style Sets the color of a button Buttons

Label size Makes the text on the button bigger or smaller to All tools with a label
improve readability, reduce space or to make buttons |property
bigger for touch screen tagging

Label style Makes the text on the button bold to improve visual All tools with a label
ergonomics or to make buttons bigger for touch screen|property
tagging
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Show label

Defines whether the label is visible or not

Buttons

Margin

Defines whether additional space is added between
labels and the edge of buttons. Remove the margin to
make buttons require less space

Buttons

Image size

There are two possibilities: the image is a fixed size
limited by the size of the button or it is the size of the
original image

Buttons, group boxes

Button size

Used to define whether all buttons have variable width
based on the label size, or the same width, based on
the widest label

Group boxes

Visibility

Defines whether a group box and its content are
visible. This may be used to hide tools which will be
triggered automatically by other buttons. Or, simply to
suppress the display of buttons rather than deletion
when not required

Group boxes

Properties

which affect behavior:

Category

The category property defines the events list column
into which a tagging tool's keyword will be placed.

Each tool inherits its category property from the group
box in which it is placed. It is therefore an efficient
way to categorize buttons of the same category by
placing them in the same group box. Override the
inherited category by setting the category property for
individual tools.

All

Keyword

Defines the keyword which will be used to describe the
event in the events list. For buttons, the keyword will
automatically set to the same value as the label
property, however it is possible to record a different
keyword if desired. For example, the label might be an
abbreviation of the keyword.

All event creation and
keyword addition tools

Preroll

Defines the time before an event creation tool is
clicked that will be included in the event. Preroll
ensures that you don't miss the start of the action.

All event creation tools

Duration

Duration is the duration of the event that will be
tagged when this button is clicked. This time includes
any preroll that has been set. If the event is not of
fixed duration then a continuous event button should
be used to manually mark the beginning and end of an
event.

All fixed duration event
creation tools

Offset Start

Offset Start - the amount of video before or after a
continuous event button being clicked on that will be
included in the event. This ensures that you don't miss
the start of the action. If a negative number is used,
the start of the event is set before the tool is
triggered, if positive it will be afterwards

Continuous Event
Buttons

Offset End

Offset End - the amount of video before or after a
continuous event button being clicked off that will be
excluded at the end of an event. If a negative number
is used, the end of the event is set before the tool is

Continuous Event
Buttons
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triggered, if positive it will be afterwards
Target Defines where the keyword typed into a text box will [Text box
be applied:
Event category - the keyword is added to the events
list
Video clip category - the keyword is added to video
clips captured with live tagging and appears in the
Dartfish library
Event color |Color codes events. Color coding is used to help Event buttons
distinguish events from each other in the events list
and also on dartfish.tv after publishing games or
highlights movies
Action Defines the button type of a team group box. Team group box
The default is for a team group box to contain
keyword buttons but this property can be used to
select any button type.
Description |Used to automate the addition of a description to the |Buttons
description field of the events list. The description field
is used to annotate events with free text description
and is particularly intended to add information to
events being published to dartfish.tv
Team Used to link a Team Group Box to a Team Manager Team group box, Player
Manager Link |tool. list selector
Number of  |Used by the Player list selector to define how many Player list selector
keywords players can be selected
Field width, |Used by the zone tool to define the layout and Zone tool
field height, |coordinate map of the zone grid.
field center X,
field center Y See The Zone Tool
PTZ preset Used by the PTZ Move button to identify the IP camera|PTZ move button
name preset to activate
Properties used to automate tagging (see Automating tagging )
Item Id A unique identifier for each tool. It is used to identify |All
tools in macro scripts and when setting trigger
properties
Shortcut Key |Rather than clicking buttons on a tagging panel, using |All event and value tools
the keyboard Shortcut Key property for event or value
buttons can be much more efficient. Note that these
shortcuts are displayed in parentheses in each button
Reset Tools with a reset category property can be used to All buttons
Category deactivate other continuous event or persistent value
tools. When this tool is clicked, all other buttons using
the category specified are reset.
Trigger The trigger property is a list of one or more tools that |All buttons
can be activated when this button is clicked.
Visibility This property is used to hide a group box and all its Group boxes
© Dartfish. All rights reserved. - Version 9 -
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contents.

Used when the action of the hidden tools will be
defined by the tagging panel creator and shouldn't be
modified by the user or when it will be triggered by
other buttons.

Game Time |Used to control a Game Timer. All buttons

See Using the Game Timer

% Clicking on a property title in the properties panel displays a description of that property. Double
clicking on the property title allows you to change that property.

9.3.14 Automating tagging
Large tagging panels with many buttons present two problems to the user:
1. Many mouse clicks might be required to record an event, making it hard to keep up with a fast

moving game
2. It becomes more difficult to locate the buttons you want to use.

This topic explains properties and features which assist with these problems

Reset Category property

Tools with a reset category property can be used to deactivate other continuous event or
persistent keyword buttons. When the tool is clicked, all other buttons with the specified
category are reset.

This behavior is equivalent to that of continuous event buttons (see the topic Event creation
buttons) which automatically deactivate all other continuous event buttons sharing the same
category, except that the reset category property can deactivate buttons from any other
category that you specify.

! Be careful with spelling and use of spaces - the reset category you specify must match the
category of the tools that you wish to reset. However the case used is unimportant.

Trigger property

The trigger property is used to activate or deactivate other tools. This property specifically
identifies which tools will be triggered by selecting them from a list.

Examples of the use of the trigger property can be seen in some of Dartfish's built-in tagging
panels where clicking an event button triggers a page of a tab group box revealing keyword
buttons associated with that event.

For example, when a scoring event is tagged the trigger property could be used to activate the
tab group box which contains a score tool.

To set a trigger property:

1. Select the tool which will trigger other tools.
2. Inthe properties panel, double-click the property heading Trigger

3. Inthe trigger dialog (see below) select the tool(s) which will be triggered. Tools are identified by
both their label and Id; be careful to select the correct tool in the case where more than one tool
has the same label
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4. Click the Add button

5. Repeat as often as required to create a list of tools which will be triggered
6. Use the Up and Down buttons to specify the order in which tools will be triggered

Trigger

Filter

[ &

| Label Id

| Goal ValueButton(

| Gosd ValueButtong
Long ValueButton11

| Lost possassion  ValusButtons

| Missed ValueButton3

| Missed ValueButtond

| Offenshe ContinuousEy. ..

| out VahueButton2

| Pass EventButtond
Pass Detal PropertyPage5

| Penaity EventButions

| Persistent Key... ConbinuousVal...

| Phase end PropertyPages
| short ValusButton 10
| Shot EventButtond
Shot ValueButtons
| Tacke EventBution?
| Thrown EventButton3

m

Label
Shot Qutcome

1d
PrapertyPage3

]

Cancel |

Shortcut key property

Shortcut keys are used to trigger buttons without having to use a mouse. This can be useful
because once you know which keys to press tagging can be much quicker.

To set a shortcut key:

1. In the properties panel, double-click the property heading Shortcut key
2. Type a key, or combination of keys, on the keyboard
3. Click the Assign button. This must be done before clicking OK

Shortcut Key

| Current keys:

| [cti+
Ciri45

Press new shortout key:

Currently assigned to:

)

! As you can see here; more than one shortcut key can be assigned; and any combination of keys
can be used e.g. 'S' might be used for a home team shot and 'ctrl+S' might be used for an

opposition shot.
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9.3.15 Using variable keywords

A simple macro can be used to generate a variable keyword or category for a tagging tool.

Syntax

$(Item_Id.property[#])

Example: $(teamlistselector0.keyword1l)

> Item_lId is a unique identification which can be found in the first row of the properties list of

any tool. Here, it can only refer to a Player List selector

» Property can be either "keyword" or "category". When keyword is used, the player selected
from the Player list selector is the variable keyword generated. When category is used, the
team is the variable keyword generated

» #is a number from 1 to 10 which represents which of up to 10 keywords it is possible to select
from a Player List selector. This is optional, if omitted it is assumed to be 1 and refers to the
first keyword.

» Text and macros can be combined together to create the desired result, as shown in the
examples below

Limitations

» Only keyword and category properties can be set with a macro. The exception to this is the
Filename Template Button which can also have its Filename template property set.

» Only a Player List Selector can be the source and only its category or keyword can be
referenced.

Example 1 - Personalized event buttons
In the following example, a macro is used to personalize the keyword property of the event buttons:

Tagging buttons

Player octions

Team Dartfish player IPro players & ”Pascal Binggeli vJ

Cppositian player IPro players v”SergeA}rer v]

Winners and Errors

Team Dartfish Winner | | Team Dartfish Error | Opposition winner | Opposition errar

& Paosition Duration  Player actions
1 5 rmin 39 sec 10 sec  Winner Pascal Binggeli
2 v 10 min 55 sec 10 sec  Error Pascal Binggeli

The macro used to record these keywords in the above events list is, for example:
Keyword = Winner $(TeamListSelector0.Keyword)

Result = Winner Pascal Binggeli

Example 2 - Filename Template tool

Continuing the example above, if a filename template tool (see the topic The Filename Template
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tool) has the following macro for its Filename template property:
keyword = Semi-final $(TeamListSelectorl.Keyword) versus $(TeamListSelector0.Keyword)
result = Semi-final Serge Ayer versus Pascal Bingelli

9.3.16 Recording time of day

Events are time stamped with video position. You may also wish to record the time of day with an
event. This can be done by including a simple macro script in the Keyword property of a button

Syntax
$(WallClock)

For example, the Keyword property '‘Goal $(WallClock)' would record a keyword such as 'Goal
15:32:25'.

@ If, in the above example, you wished 'Goal' and '15:32:25' to be recorded as separate keywords,
two buttons would be required; perhaps an Event button with keyword 'Goal' and a Keyword button
with keyword $(WallClock). In order to reduce the number of clicks required, the Event button
should trigger the Keyword button.

9.3.17 Recording game time

Events are time stamped with video position. You may also wish to record the match or game time.
This is the time . This can be done by including a simple macro script in the Keyword property of
a button

Syntax
$(GameTime)

For example, the Keyword property 'Goal $(GameTime)' would record a keyword such as 'Goal
15:32:25'.

@ If, in the above example, you wished 'Goal' and '15:32:25' to be recorded as separate keywords,
two buttons would be required; perhaps an Event button with keyword 'Goal' and a Keyword button
with keyword $(GameTime). In order to reduce the number of clicks required, the Event button
should trigger the Keyword button.

Game Timer

To effectively use the $(GameTime) script you must also display and use the Game Timer to set
the current game time, allow for breaks in play etc (see the topic Using the Game Timer)

In addition to the Game Timer's controls, it may also be controlled using Event or keyword
buttons on the tagging panel by setting their Game Time property. Use the button to execute one
of the actions shown below:
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B Interaction
Reset Category

Trigger
Do nothing ﬂ
T
Start
Pause
Stop
Game time description Start/Pause

9.3.18 Saving Tagging Panels

To save your tagging panel:

Select File > Save (or File > Save As...) from the menu bar of the Tagging Panel Editor window.

! It can be seen from this process that tagging panels are saved as files, stored independently of
Dartfish software and the video file(s) being tagged. Therefore the important factor in choosing a
file name and location for a tagging panel is simply that the user knows where to locate it.

Distributing tagging panels

Because a panel is saved as a file it can be easily distributed to other tagging users, however the
following items should also be distributed if they have been used in a panel:

1. The tagging database - if a team manager tool has been used a database file will have been
created with the same name and in the same location as your tagging panel. It will have the
following icon:

—
| |

|
[

[_]
(’?A
2. Image files - any images included on your tagging panel are referenced as external files

9.4 Tagging video

In essence, the basic tagging process is simple; you see an event, you click an event button then
you click keyword buttons to add further details. The features that you might find on a tagging
panel are described in this section (see Using tagging panels)

Tagging can be applied in the following ways:

» Tag Live - use this mode if you want to tag the action directly from a video stream, either as it
happens or from a tape recording (play back mode). In either case you will be tagging and
capturing video to your hard drive simultaneously.

» Tag Video Clip - use this method if the video clip is already on your computer. In this case, your
task is to playback the video clip, locate an event and tag.

» Mixed tagging - you do not always have time to fully and accurately define events as they
happen, or you may miss events. In this case, you are able to combine Tag live and Tag Video
Clip by playing back the video clip and editing/adding events after the game.

The result is a list of Events (displayed in the Events List, see The Events List) which can be
played individually or in sequence.
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Events can also be created by importing them from "character separated value" (CSV) files
created by other applications, e.g. sport specific statistical tools or the Dartfish Note App for
smartphones and tablets (see Importing events ).

9.4.1 Using tagging panels

Opening panels

Access to tagging panels is described in the topic The Tagging Panel.

Tagging tool and feature summary

Below is a summary of tagging tools that may be found on a tagging panel. However, Dartfish
tagging panels are highly variable and versatile, if the use of the tagging panel you use is not
obvious it may be necessary to ask for instruction from its creator.

Event button - clicked once to create an event with a fixed duration. Default color red.

. Event Buttonl

Continuous event button - appearance identical to event buttons but when clicked, it remains
activated until clicked a second time. Used to tag events of unknown duration such as possession
or phases of play.

| Offensive phase |

Keyword button - keyword buttons add keywords to events. They are not used to create events.
Default color blue.

| K.eavord Button

Persistent keyword button - appearance identical to keyword buttons but when clicked, it
remains activated until clicked a second time. Used to add a keyword to many events. Must be
activated before events are created and remains active until clicked a second time.

Setl Set2 Set3

Text box - a persistent keyword tool which adds of a variable keyword to events as they are
created.

Match description  French open 2012 fin
Player . Andy Murray -

Opponent . Roger Federer

Score panels - a persistent keyword tool which adds the current score to events as they are
created.
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9.4.2

Seare Panel
Q.20
gA = o=

Team manager - Displays a variable set of tagging buttons in a Team Group Box or a set of
teams and players in a Player List Selector according to which team and players are selected.
Has buttons to enable addition of teams and players.

Team Manager

L
%

’HC Fribourg-Gotteron

[ Cristobal Huet
Damiane Ciaccio
Marc Abplanalp
[ SergeSerge Aubin
Alainflain Birbaum
[7] Cedric Botter
Andrej Bykov
Franco Collenberg
[7] Lukas Gerber o

TYEYEY!

Player List Selector - adds a persistent keyword based on the player selected.

| »

m

Red contestant ’GB Taekwondo v” Ruebyn Richards v]

Blue contestant ’.Swi'aerland - ” Paco Cerletti v]

Tab group box - used to simplify the layout of a panel by grouping related buttons together. Click
the tab to see the buttons; often selection of a tab is automated by the action of another button.

Zone tool - records the coordinates of where the image is clicked. Can be either used for event
creation or keyword addition.

File name template tool - used to set the filename of recordings made during live tagging.

Tag Video Clip mode

Use this mode to tag video files already existing in the library - it has been imported from the
camcorder or other storage media. Tag video clip mode is selected by clicking the button at the
top left of the video display.

B2 Taglive || Tag Video Clip |_p! Play Events
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Tagging a video clip principally consists of these steps:

1. Loading all the video clips to be tagged into the Tray (see the topic The Library in the Tagging
workspace section)

Selecting Tag Video Clip mode

Finding the relevant position on the video clip (see below).

Tagging an event in the video clip by clicking on an event button on the tagging panel.
Adding further keywords to that event by clicking on keyword buttons.

ok wDn

Finding the relevant position

Compared with Live tagging where events must be created in real time and in order, tagging a
video clip allows the user greater flexibility. There are many ways to quickly navigate the video
clip find the positions where events take place:

» Drag the playhead to quickly position the video clip. Watch the time information next to the
playhead as you drag it. It can help you position the video if you approximately know when an
event took place.

i 03:27.090

> Use the speed control to fast-forward and/or fast-rewind the video. To do this, set the speed to
values greater than 1 (or -1 for fast-rewind) and play the video. Whenever you see an event,
either click on an event button or pause the video first, and then select the appropriate buttons
to tag the event.

4 -2 -1 05 02 00025 05 1 2 4
> Position the playhead to a previously tagged event and continue tagging from there. The way
to do this depends on the tagging mode being used:

In Tag Video Clip mode, click the event once to move the playhead to the start of that event

In Play Events mode, double click the event then switch back to Tag Video Clip mode to
continue tagging. The playhead remains at the position of the selected tagged event.

@ When the action is too fast to tag as the video plays, the video can be quickly paused by tapping
the space bar on the keyboard. Now add tags before tapping the space bar a second time to
resume playback.

9.4.3 Tag Live mode

Tag live mode allows you to tag while recording video from a live video stream. This allows
tagging to take place during the game and be ready for analysis immediately afterward. Tag live
mode is selected by clicking the button at the top left of the video display (see The Video Panel).

| B® Tag Live | (i Tag Video Clip I Play Events

The Tag live interface

The interface is identical to the Video Recorder interface: Read the section Video Recorder:
capture a video stream in the Importing video files chapter to learn how to use it.
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Tag live process

1. a Click the Record button. The video clip starts being captured to your hard disk. The live
feed is displayed in the Video display. In tag live mode it is not possible to tag without first
starting to record.

2. Tag an event by clicking an event button on the tagging panel.
3. Add further keywords to that event by clicking on keyword buttons.

4. E Click Stop Recording at the end of the game. A new clip is saved on your hard drive and
a thumbnail appears in the Tray.

@ It takes practice before you are able to accurately tag all events as they happen. Start simply by
tagging "important" events without adding too many additional values. Read the section Review &
edit events to see how you can edit and/or add events after they have taken place.

9.4.4 Time shifted recording and Live Delay

Time shifted recording allows you to review earlier parts of the recording while continuing to
record. This is possible when the video source provides a DV, HDV, M2TS, MP4 or H.264 video
stream.

To use Time Shifted Recording
When recording in Tag Live mode, you may:

» Click the time line to move the playhead to that point of the recording
» Select an event from the events list to view it

> You may also use the replay controls to navigate the recording e.g. by using the jog wheel.

Ending Time Shifted Recording

To return to 'live' view of the video feed from the camera, click the Live button

Live Delay

Live delay is a special instance of Time Shifted Recording initiated by clicking the Live delay
button:

This moves the Playhead to a pre-defined position before the end of the recording. Tagging with
Live Delay allows you to watch the live action, make decisions on how best to tag it, then tag the
delayed video when it appears on your PC screen some seconds later.

Configure the required amount of delay by right-clicking the Live Delay button and choosing a
delay interval:
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9.4.5 Videoless tagging with Note Pro

The Note Pro module is available with the TeamPro editons of Dartfish and it provides an
alternative tagging method which does not require the presence of video. Instead of time-stamping
events by a position in a video, a timer is used.

Note Pro creates a Notebook file, the events from which can be imported into a video file using
the Tagging module OR can be opened in Note Pro to view content and create frequency tables.

In providing videoless tagging, Note Pro fulfills a similar role to the Dartfish Note mobile app but
with the benefit of the more sophisticated tagging panels of Dartfish.

Opening panels

Your first step is to create or open a tagging panel. Access to tagging panels is described in the
topic The Tagging Panel. Creation of a tagging panel is described in the topic Creating Tagging

panels

Defining Notebook properties

Properties such as file name and where the Notebook will be located are defined before recording
starts, using the Properties panel. See Setting file properties and Selecting a recording location.

Recording events:

Now you are ready to start recording using the following buttons

a Starts the timer. Choose when to start carefully. Particularly if intending to import the
Notebook into a video, you should start recording at a moment which will be easily identifiable on
the video recording

E Stops the timer
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. Resumes the timer

The timer must be running in order to use the tagging panel to create events. As you do so, events
will appear in the Events List. How to tag is described in the topic Using tagging panels

Saving the recording

The Notebook is automatically saved according to the file properties defined before recording is
started.

@ One Notebook should be made per video file. Otherwise synchronization of events and video is
difficult.

Distributing Notebooks

Notebooks are saved as files on your PC and these files can be distributed for use by other
Dartfish users.

A nice alternative to email or memory stick is to upload to dartfish.tv. To do this click the Share
Game button:

Clearing the events list/Starting a new recording
Click the New Game button:

]

9.4.6 Dual camerarecording

This feature is only available in the Video Replay edition of Dartfish. With this edition, it is
possible to record, and tag video from two cameras simultaneously.

To select and use two camera inputs

1. Select Tag Live mode
2. Select the two camera inputs from drop-down lists in the settings section below the video
display:
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* Clip Properties
* Recording Folder
* Camera A

Tﬁ' ‘ Select video capture device ~
b
_L;.

Select audio capture device

* Camera B

Tﬁ‘ ‘ Select video capture device ~

}.‘,- Select aqudio capture device

3. Click the record button | ¢ to simultaneously record both video streams (learn more in the
topics Tag Live mode and Video Recorder: capture a video stream)

To select which input is displayed
The video display will initially show the input from the first camera (Camera A)
» Click the button to show the input from camera B

» Click the Split screen button m to show the input from both cameras

@ Depending on the time taken by your computer to process the video from each camera, there
may be an observable lag between the video displays from each camera. Generally this will be too
short to be of concern for many tagging activities. However, if timing is more critical, we suggest
switching on both video sources simultaneously. Dual camera recording does not have a way to
synchronize the inputs.

! When live tagging, events are added to Video A's events list. When recording is stopped, events
are copied from Video A to Video B. Thereafter the events belong to each video independently so
editing the event in one video does not edit it in the other.

9.4.7 Using the Team Manager

Adding teams and players

Adding players and teams to the Team Manager is not completed in the tagging panel Editor but
after the tagging panel has been created and saved. Buttons at the bottom of the Team Manager
allow you to (left to right) add/remove teams and players from the team manager.

&% 8 de R

You may want to create more than one team if you tag several teams or squads but at least one
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team must be created before adding players. After adding teams and players, their properties
(such as team/player name) may be altered by clicking the # putton next to the item to be edited.

Selecting players

Players are selected/deselected by 'ticking' the box next to their name. If the box is ticked, a button
representing the player will appear in the team group box linked to this player manager control.

& ¥ Philippe Schroe...

Philippe has been ticked, so...

Suisse
Philippe | Meil | Sebastien |
Schroeter, Melville | Dubuis

... a button representing him appears in the team group box

Order of players

Buttons below the Team Manager control the order in which players are listed.

Team Manager
Suisse v &

Johann BERNOULLI
Daniel BERNOULLI
Henri DUNANT
Leonhard EULER
Max FRISCH

[¥] H. R. GIGER
Gottfried KELLER

- - (ET

Move Upi

The order that players are listed in the Team Manager also defines the order that they will appear
in the Team Group Box and is also the default order for player lists in the Player List Selector.

Using other Player Database files

When a tagging panel containing a Team Manager tool is first saved, a database with the same
name but the extension '.taggingdb' is created. You can find it in Windows File Explorer,
represented by the following icon:

B
[ ]
31

The database is then automatically updated as each team or player is added. Distributing your
database for others to use, it is easily done by distributing this file. Other users can then use the
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file are follows:

1. Open the tagging panel in the Tagging Panel Editor window
2. Select the tab Database Editor at the top of the editor window
3. Click the Open button and browse for the tagging database file

Using keyboard shortcuts

Using the keyboard to activate tagging tools can be much more efficient than using the mouse.
Buttons which have a keyboard shortcut display it below the label; it is used simply by pressing
the keys indicated.

| Attempt

Activating panels to use keyboard shortcuts

Keyboard shortcuts only work when the tagging panel is active. Look for a green line at the top of
the panel and if the line is red, click anywhere on the panel to activate it.

* Panels » |4 Edit

Game tags Match information

Serve | Winner Serve opponent | Winner Opponent | | Error Opponent |
ITI le IWI IWl Iﬁl
Serve details Shot details Error details

Serve type/direction

Shortl || Short2 || Short2 || Short4 | | Flickl || Flid? || Flid3 | | Altol
(e e e B —— —

|| JAlto2 || Alto3 |
| [ —

Serve outcome
Winner | Fault | Returned
|

L4

Be particularly careful when starting and stopping recording or using the Play/Pause controls -
clicking anywhere outside the panel will cause that line to turn red again and keyboard shortcuts
will not work. The restriction of use of keyboard shortcuts to when the tagging panel has focus
allows the use of keyboard shortcuts which might have other functionality in Windows or Dartfish
Software.

Score panels can also have keyboard shortcuts but they are not displayed - use the editor to
discover whether the score can be updated with a keyboard shortcut or seek advice from the
tagging panel's creator.

Hiding shortcut keys from buttons

After memorizing shortcut keys it may be advantageous to remove the display of the shortcut from
the buttons label. To do this:

1. Click the Panels button at the top of the tagging panel

2. Click the option Show Keyboard Shortcuts to deselect it

3. Repeat these steps to show shortcuts again
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I ‘ * Panels i l_.é‘l\. Edit

Mew

Open...
Manual Tagging

1 ChUsers\Neil\Videos\Tagging par
2 ChUsers\Meil\Desktop\Untitled. T:

| 7 Show Keyboard Shortcuts
v

Show Tooltips
Flat Style

9.4.9 Using the Game Timer

The game timer functions as a match clock. Start it at the beginning of the game, pause it during
breaks in play and stop at the end.

It is used in conjunction with a tagging tool where the Keyword property contains a $(GameTime)
macro string, For example, a "Shot" button might record the game time when the shot took place.

Displaying the Game Timer

1. Click the Panels button at the top of the tagging panel
2. Select Show game timer from the menu
3. The Game Timer is displayed in the tagging panel toolbar:

3 G 0000=1% &

Using the Game Timer
The game timer is a simple stop clock with Start, Pause and Stop capabilities.

However, it does have features whish allow adjustments to the time:

» Click the + and |~ buttons to increase or decrease the time by one second per click (for
example, if you are late to pause the timer during a stoppage in play)

» Set a specific time by clicking the Set button.
The Set Game Time dialog allows you to set the clock to a time of your choosing

Game time: [I:00:00 = Reset

[]countdown time

Using a countdown timer

You can also use the Game Timer to show the amount of time remaining in a game or period. To
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do this:

1. Click the Set button
2. Set the game time to the total duration of the game or period
3. Select the Countdown time check box (see above image)

Limitations

As the Game Timer is a simple stop clock it does have some imitations, particularly when used
with the Tag Video Clip mode when the optimal method of tagging may be non linear and not in
real time. Also be aware of the following:

» No adjustment for Preroll. Whatever is on the clock when a button is clicked is what gets
recorded.

> No link to video time. If the video position is edited, game time values are not adjusted. The
methods used to adjust position and duration cannot be used to edit game time.

9.4.10 Manual tagging

Manual tagging divides a video clip into a series of sequential segments where adding a new
segment defines the end of the previous one. Each segment is described by a label,
description and keywords which are manually entered as required.

Events can be added to segments. Their duration is defined by the point at which they are added
until the end of the segment. They inherit all of their segment's keywords as well as being further
described by their own keywords.

Typical uses
1. Manual tagging is a simplified form of tagging where it is not necessary to create a tagging
panel and keywords can simply be added as required.

2. Segments are useful for dividing a video into sections. Their label, description and keywords
are especially useful when they are exported as video clips or the tagged video is uploaded to
dartfish.tv.

3. Segments can also be considered as a way of tagging events in the same way that a text box
adds a persistent keyword to events on a button-based tagging panel.

To understand its intended use it may help to know its origins, it was created for The City of
Lausanne to distribute video of council meetings on dartfish.tv. The segments are of each session
and events are used to identify minuted details. Their dartfish.tv channel uses the keywords and
descriptions applied by manual tagging to enable citizens to search for discussions. However,
Manual Tagging has applications as a tagging tool for many other situations.

Creating Segments

1. Click the tagging panel's Panels button and choose Manual Tagging from the menu
2. Click the New Segment tab of the tagging panel

3. Enter alabel and a description. This information is used to describe the Segment when
published to dartfish.tv

4. Segments are defined by adding categories and keywords to the table. One segment can be
defined by many keywords.

5. When the segment is fully described, click the Add button to create an event in the Events list

6. Repeat steps 3-5 to add further segments. Each one added alters the previous segment's
duration so that each segment ends as the next begins.
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Creating Events

1. Click the New Event tab of the manual tagging panel

2. Enter alabel and a description. This information is used to describe the event when
published to dartfish.tv

3. Events are defined by adding categories and keywords.
4. When the Event is fully described, click the Add button to create it in the Events list.

5. When a new segment is added, the durations of all the events from the previous segment are
set.

9.5 Importing events

You can create events by importing them from files produced by other software provided that the
data contains a column of time-stamps representing the position of each event. This will be
useful to the following groups:

» Those using the Dartfish tagging Apps for Apple and Android mobile devices. These apps
allow you to create events using a tagging panel similar to a Dartfish panel, and then import the
results into a tagging events list.

» Those that already use data logging software which creates statistics but does not relate the
event to video or allow visual analysis. If this software can create a CSV file then the results can
be imported into Dartfish.

> ltis also possible to use data exported from certain other tagging software. At time of writing
these include products from Opta and Sportstec and in each case the exported data is either
not in a .csv format or the layout or data is not optimal for use with Dartfish. To use this data a
product specific add-in must be installed as described in the topic Importing events using add-
ins

9.5.1 Importing dartfish.tv Notebooks

This import method is used to import events from tagged videos and Notebooks on dartfish.tv.
Notebooks are produced by the Note Pro module or Dartfish Note mobile app, which is a hand
held tagging panel, very similar to the Dartfish tagging panel, but can be used without video and
therefore simplifies the equipment required for tagging live. Learn more about Dartfish Note in its

knowledgebase.

To import events
1. Pause the video or set the cue in to an easily distinguishable moment in the video. Doing so
will simplify the synchronization of data and video. This can be one of the following possibilities:

» The moment representing zero time on your imported data (when you started the Dartfish
Note timer). Pause the video or set the cue in at that point.

> An easily identifiable tagged event. If the event timestamp was added using a preroll,
position the playhead at the start of the event rather than when the button was clicked

2. Click the Import/Export button located in the Events list toolbar and select Import
Notebook... from the menu.

ﬂ Import/Export «

3. Sign in to dartfish.tv. Access to Notebooks and the ability to download them requires special
access rights. See the Dartfish.tv knowledgebase for more details on this
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4. Select the channel from which you wish to access the video or Notebook

5. Click on the thumbnail of the video or Notebook from which you wish to import events
(documents can be searched by filename or keyword). Then click the Select button

6. Choose which Period's events to import.
Dartfish Note has the ability to record multiple period's events for a game. For example, the first
and second half of a soccer game can be recorded in a single Notebook. If you video recorded
the game as one recording then you can import the events from all periods. If you stopped

recording at the end of each period, you must choose which period's events to import for the
videos files for each period.

L] Import Notebook

Sui v Por Select Notebook

1. Quarter (25/09/2014 13:24:52)

# Mame Position Duration Period Outcome
. 1 Offensi... 3sec 21sec 1. Quarter  Shot miss
B 2 Offensi... 27sec 19 sec 1. Quarter  Shot miss

This Notebook has one period therefore the selection is unavailable

7. Select how the imported data is to be synchronized with video. The method depends on the
choices made in step 1 and are described in the topic Synchronizing imported events.

5. Synchronize by matching a data time to a video position. Double-click an event in the list above to use its time instead of 0 sec.

Synchronize imported data time: | Timer start (0 sec) » | To playhead position w

9.5.2 Importing Notebook files

In addition to importing Notebooks from dartfish.tv, it is also possible to import events from
Notebook files in the Library or on disk.

One way to do this is to use the method described in the topic Importing events from files however
the more convenient way is to open the Notebook directly from the library as follows:

1. Position the video playhead at the position where the Note Pro timer was started
2. Find the Notebook in the Library
3. Double-click the file to open it. The synchronization dialog appears:

Import Notebook 4

Synchronize imported data time:

Timer start (0 sec) ~ | |To playhead position
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4. Click the OK button to confirm the default synchronization option
5. The Notebook's events are imported and displayed in the Events List

9.5.3 Importing events from files

This import method is used to import from a wide variety of software tools which can create a
character separated value (CSV) output. This includes the Dartfish Easytag app which has been
superseded by Dartfish Note but is still available from the App Store and Google Play. This method
is also used to import Notebooks created by the Note Pro module.

To import events
1. Pause the video or set the cue in to an easily distinguishable moment in the video. Doing so
will simplify the synchronization of data and video. This can be one of the following possibilities:

» The moment representing zero time on your imported data. For example, if you started your
Dartfish Easytag timer at the start of the game, pause the video or set the cue in at that
point.

> An easily identifiable tagged event. If the event timestamp was added using a preroll,
position the playhead at the start of the event rather than when the button was clicked

2. Click the Import/Export button located in the Events list toolbar and select Import Events...
from the menu.

|l Import/Export ~

3. Locate and open the .csv file. The Import Events wizard then opens.

4. Choose the delimiters which separate each column of data in the imported file. If unsure,
experiment with the various choices remembering that more than one delimiter might be used.
The data preview will reveal when your data is successfully separated into columns.

Select delimiters used to separate data:
@] 1ab [] semicolon

[¥] comma [ space

5. Select which column heading in your data corresponds to the event time stamp or Position.
Optionally, columns representing the duration and name categories can also be selected if the
data contains them.

Select columns with default data:

Position: | Position v
Duration: | Duration -
Name: Name -
Time Format: |Miliseconds -

6. Select the Time Format used in the imported data. The preview shows the original data in
brackets next to the time interpreted by Dartfish according to the selected time format: If the
format is not correct, the times shown in the position and duration columns will all be "0" or
appear very obviously wrong.

! EasyTag time format is hh:mm:ss.ms and is automatically selected
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7. Decide which categories and events to import by ticking or unticking the headings at the top of
each column and side of each event.

Select the columns to be imported as category for the events. I Select Al l I Unselect Al ]
M # Mame Position Duration 7l [¥] Direction S5l
1 MET 0 sec (440) 5 sec (5000)

&2 MET (1) 7 sec (6600) 5 sec (5000) Double fault
! LOMNG 32 sec (32000) 5 =ec (5000)

4 BACKHAND 39 =ec (38800) 7 =ec (7000)

# s Brychta 43 sec (43160) 6 sec (6000) Team 1 CROSS COURT  UMFORCEDE
6 BODY 1minl2sec (.. 7 sec(7000)

=7 Jayant Mistry 1min20sec{.  ©sec(6000) Team1l DOWN THE LL..  WINMER

8. Select how the imported data is to be synchronized with video. The method depends on the
choices made in step 1 and are described in the topic Synchronizing imported events.

5. Synchronize by matching a data time to a video position. Double-click an event in the list above to use its time instead of 0 sec.

Synchronize imported data time: | Timer start (0 sec) v | | To playhead position W

Quick Import

Quick Import is a tool allowing you to quickly repeat an import using exactly the same settings as
previous imports. To use Quick Import, proceed as follows:

1. Setthe Playhead or Cue-in marker as described in step 1 above.
2. Select Quick Import... from the Import/Export menu located in the Events list toolbar.

ﬂ Import/Export +

3. Locate and open the .csv file.
4. The data is imported.

Vit Quick Import is used when no previous imports have been made then the full Import Events
options will be displayed

9.5.4 Importing events using add-ins

Although Dartfish can import .csv data into its events list (see Importing events) the data exported
from some sources is not always optimal for use with Dartfish. For certain products, add-ins are
available which process the data during import.

Installing add-ins

1. From the menu bar, select Tools >Options
2. Select the Add-ins section
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[ Options “
o & T % 4# @ @ I E

General Library Encoding Profiles Analysis InTheAction SimulCam StroMotion Metwork Cameras | Add-Ins | Advanced

Ll
; naed . Prozone/Amisco Events Importer
Update
BStats Evenits [mporter

lf-baLllu'estd!.E\l-'_eﬂ‘S Ww SE L
b et i

: t:ﬂutalfoemal_E\"-fﬂF.[”"’“‘fter, o
:op.ra;.a@»,-.E.\-\en.r_r..El.'rwter_ .
i i

Install

3. Select the Get Add-ins option
4. Choose an add-in from the list of those available
5. Click the Install button

! Dartfish may add or remove add-ins. The list shown above is only representative

Importing events using an add-in

First you will export a data file from the third party software. Refer to its documentation to discover
how to do this. Some software may offer multiple outputs, in this case, refer to the Dartfish Options
to discover which file type is supported

.. Sportscode Events Importer
2.3 Import events direct from a [Sportscode XML file
Version 1.0.715.0

Now use Dartfish as follows:

1. Pause the video or set the cue in to an easily distinguishable moment in the video. Doing so
will simplify the synchronization of data and video. This can be one of the following possibilities:
» The moment representing zero time on your imported data.

» An easily identifiable tagged event. If the event timestamp was added using a preroll,
position the playhead at the start of the event rather than when the button was clicked

2. Click the Import/Export button located in the Events list toolbar and select Import [............. ]
Events
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CiEvents
i Import/Export »| 22 Publish ~
| Import Events... |

Quick Import..
Import Sportscode Events

Export Events...

3. Locate and open the data file. The Import Events wizard then opens.

4. The correct delimeters, default data and time format will be automatically selected, but you
may wish to choose which categories and events to import by ticking or unticking the headings
at the top of each column and side of each event.

Select the columns to be imported as category for the events. I Select Al l I Unselect Al ]
M # Mame Position Duration 7l [¥] Direction S5l
1 MET 0 sec (440) 5 sec (5000)

&2 MET (1) 7 sec (6600) 5 sec (5000) Double fault
! LOMNG 32 sec (32000) 5 =ec (5000)

4 BACKHAND 39 =ec (38800) 7 =ec (7000)

# s Brychta 43 sec (43160) 6 sec (6000) Team 1 CROSS COURT  UMFORCEDE
6 BODY 1minl2sec (.. 7 sec(7000)

=7 Jayant Mistry 1min20sec{.  ©sec(6000) Team1l DOWN THE LL..  WINMER

5. Select how the imported data is to be synchronized with video. The method depends on the
choices made in step 1 and are described in the topic Synchronizing imported events.

5. Synchronize by matching a data time to a video position. Double-click an event in the list above to use its time instead of 0 sec.

Synchronize imported data time: | Timer start (0 sec) v | | To playhead position W

9.5.5 Synchronizing imported events

Unless video recording was started at time 00:00:00 of the imported data, it will be necessary to
synchronize data with the video.

This is done by matching a time in the imported data to a position in the video denoted by one of
the following: the start of the video clip, the Playhead position or the Cue-in marker position.
Consider the following common examples:

Synchronizing using the data's zero time

The simplest case to synchronize is when the timer of data logging software is started at an easily
identifiable moment that will appear in the video. For example, the kick-off in a soccer game (as
illustrated below).

@ If you need to start the timer before kick-off or where there is no easily identifiable moment
before the first tag, you can raise a hand in front of the camcorder as the timer is started.
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kick-off
(timer started)
00:00:00
l, event event event event
> data
i i i i i timeline
! i i 1 1
! | | 1 1
start i i i i i end
recording i i ' H H recarding
00:00:00 ! ; ; ! ' 00:94:02
i i i i
1 1 1 1 1 1
1 1 1 1
1 1 1 1
i i i i video
timeline
playhead
[orcue-in)

00:04:25  data position 00:00:00is offset to video position playhead

To synchronize data in this case:

1. Before import set the Playhead (or Cue-in marker) to the video position where the timer
started.

2. During import leave the data position at 0 sec and select which video position that corresponds
to.

5. Synchronize by matching a data time to a video position. Double-click an event in the list above to use its time instead of 0 sec.
Synchronize imported data time: | Timer start (0 sec) v | | To playhead position W

Synchronizing using an event position

In the case that time zero for the imported data is unknown or otherwise not possible to identify on
the video, you can synchronize the position of an event with a video position as illustrated here:

event
event 00:42:16 event event
. ‘ . data

i \ > timeline

1

1

start i end

recording I recording

! 00:94:02

.
1
|
1
:
|

00:00:00 i
1
1
1
1
1
1

| | |
——————————————————

playhead

data position 00:42:16 is offset to video position playhead

To synchronize data in this case:

1. Before import set the Playhead to the start of the event that you will use for synchronization.
2. During import find the same event in the data preview and double-click it to select it
3. The data synchronisation position is set to the time of the selected event

5. Synchronize by matching a data time to a video position. Double-click an event in the list above to use its time instead of 0 sec.

Synchronize imported data time: | Foul (43 sec) v | | To playhead position W
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Synchronizing events after import

Synchronizing events, or adjusting synchronization, after import can offer more versatility than
synchronizing during import. For example, it is possible to give a different offset to different types
of event.

How to adjust position and duration of events is described in the topic Editing event timings

! Synchronizing modifies the time stamp for all events. It is therefore important that the time
coding on your data remains comparable throughout the video clip. This means that if you pause
the Easytag or data logger timer during time-outs you also have to simultaneously pause video
recording or vice versa. If you record the game as multiple video files you will have to import the
events of each file as separate imports. For convenience it is best to record both video and the
timing of events continuously and for as long as reasonably possible during the game.

9.6 Review & edit events

Play Events mode is used to review and edit tagged events. To use play events mode you click
the Play Events button on the mode bar above the video display.

‘ Eﬂ Tag Live [ Tag Video Clip [I] Play Events

If it is not already displayed you also need to open the Events List by clicking the Events List

button |~ on the views bar above the video display.

9.6.1 Selecting events from the Events List

Selecting and playing events

> Single click selects the clip - can be used in either Play Events or Tag Video Clip modes
» Double click selects and plays the clip and switches to Play Events mode

Sorting events

Events may be sorted by clicking any of the category headings at the top of each column of the
events list

List Overlapping
% List Crverlapping

Remember that events can overlap. For example, in soccer a shot at goal event will overlap
with a goalkeeping event. This button displays events that overlap with the currently selected
event.

Selecting multiple events
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By selecting more than one event you can indicate which events in your events list you want to
play, edit or delete. Selecting several events is possible by the following methods:

» Select several isolated events — hold down the control CTRL key on the keyboard and click
each event in turn.

» Select a group of sequential events — click the first event in the group then hold down the
SHIFT key and select the last event in the group.

» Select all events — click any event and then use the keyboard shortcut CTRL + A

9.6.2 Editing keywords

An event's keyword information can be added to or changed in 2 ways:

» Method 1: Use the tagging panel —when an event is selected in the events list, its keywords
may be changed using the tagging panel's keyword addition tools.

» Method 2: Click the right mouse button while pointing at the keyword to be changed and
choosing Edit from the quick menu. A new keyword may be typed or selected from a list.

Chxer

'\.'eri-iral

Wer Play Event |

Ot Edie |

Wer |
Delete ‘

@ Selections of multiple events can be edited simultaneously using either of these methods

9.6.3 Editing event timings

To edit position and duration using the time line

The following method allows you to make modifications by selecting a start and finish point for the
event in reference to the video.

1. Activate the Maximize play range function, found to the left of the Timeline to zoom in on the
event.

b
2. Click on an event in the Events list. The event corresponds to the play range; the pale blue
area between the Cue In and Cue Out point.

3. Drag the Cue In and Cue Out markers (the blue triangles in the image above) to modify the
event's position and duration.

! Maximize Play Range view immediately readjusts making it appear that nothing has changed but
note the new position or duration displayed in the Events list.

To edit position and duration using the events list

1. Select the events to be modified.
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2. Click the right mouse button while pointing at the duration of one of the selected events and
then choosing Edit from the quick menu.

3. Edit the existing time or type a new one.
4. Press the ENTER key to confirm the change

@ Itis not necessary to enter a new duration in the full time format displayed. Simply entering the
value '10" would set the duration to 10 seconds.

To adjust timings using the events list

The video position of a single event can be modified as described above but when timing of
position or duration require adjustment it is possible to add or subtract time in the following way:
1. Select and edit events as described previously

2. Key a + or - in front of the new value depending on whether time is to be added or subtracted

For example, entering +5 would add 5 seconds to the selected times; entering -1:30 would
remove 1 minute 30 seconds; and entering +1:25:00 would add one hour and twenty-five
minutes.

@ If unsure about how to apply the correct time format, simply edit the existing value and place a +
or - in front.

9.6.4 Hiding unused categories

The Events List continues to display categories used by previous tagging projects even if they
are not used by the current tagging session. The categories may be removed from the events list
as follows:

1. Right-click any column heading, and
2. Choosing Reset columns from the quick menu that appears.

Size Column to Fit

Size All Columns to Fit

Reset Columns

<

Position
v Duration

File Path

File Extension
v Set Actions

More...

9.6.5 Reviewing events and video during live tagging

When using Tag Live mode it is possible to replay video while continuing to record. This will allow
you to:

» Tag events that were missed and edit incorrectly tagged events
> Review the action to make informed coaching decisions during the game
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9.7

To review video

1. Click and drag the Playhead to the position on the time line you wish to review.

2. The recorded video plays from this point but the video display controls can be used to control
playback frame-by-frame etc

To review an event

1. Click the event in the Events List to select it
2. The Playhead jumps to the start position of the event on the Timeline

! Itis not possible to enter Play Events mode while continuing to record

Returning to viewing live

The Live tagging video display controls has a Live button which returns the playhead to the end of
the timeline i.e. the live view

@ v ow)m @ ® @ W
23 mh—n—t—-

itis only possible to use time shifted recording when the video source provides a DV, HDV,
M2TS, MP4 or H.264 video stream

Filtering and viewing statistics

Tagging will typically result in a long list of events. Locating particular events or analyzing their
frequency using the events list alone would be a difficult task. There are three methods for
searching for events:

Table filter

The table creates frequency and duration summaries by cross-referencing keyword categories.
This can be used both to filter and to generate statistics. The table is described in the

following topic.

Simple filter
Events
& import/Export ~ &;Publish ~ of Storyboard | % Show All || Filter events ol =
# MName Position Duration  Player Team
1 Tackle Lost l 36 sec Ssec  Ben Taylor Teamd
2 Tackle Lost l 39 sec 5sec  Guilherme Reis Tearmnd
2 Tarkle | nct | AN car Scer  Antench | emma Tearmd

The events list toolbar has a simple filtering tool which displays events based on an inputted
value.
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The results of the simple filter can be further refined using the Keyword filter.

Keyword filter
To execute a keyword filter

1. Click a keyword from the list. The events list inmediately displays events matching the
selection.

2. Select additional keywords by holding down the CTRL key as keywords are clicked. When
keywords within the same category are selected they behave as an AND search but when
selected from different categories an OR search is the result.

The following example would show shots off goal and shots on goal by player Lemma.

Search keywords o 8, T & =
4 Action 79 A

Tackle Won 20 w—75%

Aerial Challenge Los 16 memm 20%

Tackle Lost 16 m—m 20%

Aerial challengeweor 15 mmm 18%

Foul Tm 3%

1] Shots off goal I03%

4 Player 79

Jean Tshimpaka 12 mem 15%

William MNjamen Jmm 11%

Andrew Konopelsky T 3%

Luke Mullohand Tm 3%

Per Engebreth Faerd 6m 7%

Sean Flatley 6 m 7%

James Goodwin 5me%

Brian Ramsey 4m5%

George Davis IV 3ni%

Guilherme Reis 3ndk

Thomas Mclean 3n3%

Aly Hassan 212%

Ben Taylor 212% o

& Keywords i Table

Combined filter
The results of the simple filter and the keyword filter combine.

For example, the keyword search above could also be carried out in the following way:

Search keywords 2 2 H Import/Export = '-_235 Publish + '# Storyboard | ._/; Show All | njamen x
4 1 Action e Duration Action Player Team
Tackle Won 20 12sec  Shots off goal William Mjamen Team5
Aerial Challenge Lost 16 12sec  Shots on goal William Njamen Teamd
Tackle Lost 16
Aerial challenge won 15
Foul 7
L Shots off goal 3
L9 Shots on goal 2
4 Player 79
Jean Tshimpaka 12
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9.7.1 The table search

Tables derive statistics from events and also allow filtering for the events relating to those
statistics. The default location for the Tables panel is to the left side of the Events list, docked
with the Keywords panel.

Creating a table

Tables are constructed using the categories of keywords featured in the Events List. To create
a table:
1. Click the Edit button (Shown top right of the tables panel in the image below)

2. Drag and drop a category from the Categories list on the left into the Rows area: A list of
corresponding keywords and frequencies of events using them is displayed:

bl m [
7 Edit
 custom ~ ] | ) Si Ejv
Categories Rows Columns
[ Assist 1F5 Action I
L Half
I Player
I Possession
L Team
I Touches
Action L
Grand Total
Aerial Challenge Lost 16
Aenial challenge won 15
Foul 7
Shots off goal 3
Shaots on goal Fd
Tackle Lost 16 W

3. Drag another category from the Categories list into the Columns area: A cross-referenced
list of frequencies for each of the keywords in each category is displayed:
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P Edit|
Categories Rows Columns
- Assist > Action 5 Team
5 Half
3 Player
. Possession
"\>\‘Tnuchﬁ
Action ve. Team o
Teamd | Teams | Grand Total |
Aerial Challenge Lost 6 10 16
Aerial challenge won | 10 5 15 ;
Foul 4 3 T
Shots off goal | 2 1 3
Shots engeal [ 2 2
Tacklelost| & | 8 16| v

4. Additional categories can be added to either Rows or Columns areas to create groupings of

keywords
P Edit|
3 amom~ Gy | T G | B~
Categories Rows Columns
-5 Assist | Half > Team
% Player - Action
. Possession
@Touchﬂ.
Half-Action vs. Team o
Teamd | Teams | Grand Total |
Half1.| 6 10 16
Aenal Challenge Lost
Half1.| 10 5 15
Aerial challenge won
Half 1. 4 3 T
Foul I
| hafa| 2 1 3 E %

5. Click the Edit button to hide the editor and maximize the use of space to display the table

1% Large tables may not be easily viewed in the default tagging layout. For example, it may be
better to dock the table panel with the events list or even make it 'float' over the application. You
may wish to review the topic Repositioning panels in the Getting Familiar with Dartfish chapter.

Removing a category from a table
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Categories can be removed from the Rows and Columns areas by:

» Double-clicking them
» Drag & drop to the Categories area

Saving a table

Click the Save button to save a table layout

—

=

Previously saved tables can be recalled by clicking the Custom button

qustom' f;_.‘| :l j‘

Team vs. Half: Action

Team vs. Possession

Reset

Displaying multiple tables simultaneously
1. Click the New Table button

=2
2. Construct the new table as previously

Changing the displayed data and formatting the table

By default, tables display frequency statistics. However you can also represent data as a
percentage of frequency or of total duration. Data may also be represented visually in various
ways. All of these choices can be made using the Format Cells menu:

=
=
B =

-

Data Bars
Red
Green

Blue

Color Scales
Green To Red
Red To Green

Cell Content frean

IZ‘ Count Fai
% of Grand Total
% of Column Total
% of Row Total

Total Duration

= f' T

o

Filtering using a table search
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9.8

9.8.1
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Clicking any number or heading of the table filters the events list to match your selection

Using table data in other applications
Data can be easily reused in other applications e.g. a match report or presentation. To do this:

1. Right click a table
2. Choose your copy method of choice from the quick menu (as CSV data or as an image)
3. Paste the data or image into the other application

Undo searches

Searches reduce the event list to displaying only search results. To see all events, click the Show
all button above the events list.

Show &l

Producing & sharing tagging resources

Having tagged a video you may want to share that work with others. It is easily possible to share:

» Game video complete with tags

> Individual events - as separate video clips or as a compiled highlights video.
» The events list - can be exported as a .CSV file
>

The tagging panel - tagging panels are saved as files. To give others access to your tagging
panel, simply give them the file. They use the Create Events pane to open the tagging panel.

Dartfish offers the possibility to publish to a range of outputs including CD/data DVD and online to
your own FTP site or to Dartfish TV; our own media sharing platform (see www.dartfish.tv). To get
a more comprehensive view of publishing from Dartfish see the Dartfish outputs - publishing &
sharing chapter.

Sharing game video

There are two possibilities depending on whether you want to share video with or without its tagged
events or

1. Share video clips from the Tray. This method also shares the .dartclip file for each clip. The
dartclip contains events list data so this is the best method to share video with other Dartfish
users. Of course you can also Share match video with non-Dartfish users but if you want them
to see tagged events it would be better to use the method below. Learn more about sharing
video clips from the Tray and all the possible output destinations in the Publishing and Sharing
chapter.

2. Publish from the Events List - send video and events to your myDartfish Smart Cloud or
your organisation's dartfish.tv channel. This option is perhaps the more versatile as you can
choose whether or not to include events with the upload and, if the game was recorded as
multiple videos, the publish process will render all files as a single dartfish.tv document.
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‘ Favorite i Download ‘: Share Delete D

To publish game video to dartfish.tv

1. Load game video(s) into the Tray.
2. Filter for and/or select the events to be published with the game video (optional).
3. Click the Publish button on the Events List toolbar.

2% publish ~

Upload Game
Upload Highlights Movie
Create Event Clips

4. Select Upload game... The Publishing Wizard opens.

5. The subsequent steps of the Wizard are similar to those of other dartfish.tv publishing
processes (see Upload to dartfish.tv in the Dartfish outputs - publishing & sharing chapter). with
an additional step for event selection:

Event selection

The Publish Game wizard includes an Event selection step which controls which, if any events
are included with the published game.
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Upload Game

Event Selection
Select the events to publish

Mg

Select the range of events to publish:

®) All events (231)
) Selected events (11)
. None

< Back Next > Cancel

The options are:

> All events: all events currently displayed in the Events List. If a search or filter has been
applied, All Events refers to the contents of the filtered list.

» Selected events: Only events which have been selected by you. This allows you to be more
selective about which events are included in the upload

» None: You don't wish those who will view the game video to be able to see the tagged events

To use tagged video downloads from dartfish.tv (dartfish users)

Dartfish users can use tagged video from dartfish.tv. To do this see the topic Download from
dartfish.tv in the Importing Video Files chapter.

To use tagged video downloads from dartfish.tv (non-dartfish users)

Those who do not have Dartfish software can still benefit from tagged video offline using the
Dartfish Express App.

Simply tap the Download button when viewing a tagged video from a mobile device. The video will
automatically open in the App and events can be filtered and played.

Learn more about Dartfish Express in its knowledgebase

@ When Live tagging, choose to encode video using the dartfish.tv encoding profile (see Using an
encoding profile in the Importing video files chapter). Both the originally high quality recording and
the encoded one will be tagged and the publishing time for the game will be substantially reduced

9.8.2 Creating highlights movies

To publish a highlights movie on dartfish.tv

1. Load game video(s) into the Tray.
2. Filter for and/or select the events to be used to create the highlights movie (optional).
3. Click the Publish button on the Events List toolbar.
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22 publish ~
Upload Game
Upload Highlights Movie
Create Event Clips

4. Select Upload Highlights Movie... The Publishing Wizard opens.

5. The subsequent steps of the Wizard are similar to those of other dartfish.tv publishing
processes (see Upload to dartfish.tv in the Dartfish outputs - publishing & sharing chapter). with
an additional step for event selection:

Event selection

The Publish Highlights Movie wizard includes an Event selection step which controls which
events will be used to form the highlights movie

Select the range of events to publish:

(®) all events (4)
() 5elected events (1)

The options are:

> All events: all events currently displayed in the Events List. If a search or filter has been
applied, All Events refers to the contents of the filtered list.

> Selected events: Only events which have been selected by you. This allows you to be more
selective about which events are included in the highlights movie

Other ways to create highlights movies

Although publishing to dartfish.tv takes a lot of the hard work out of creating and distributing a
highlights movie, there are other possibilities

» The Analyzer's Storyboard: If you have sent selected events to the Storyboard you can save
that selection as a movie. The movie will include any of the video drawings and measurements
that you add to the video in the Analyzer (see Storyboard topic)

» The Analysis Recorder (Pro Editions only): Another way to use the Storyboard is to record
voiceover and drawings in an analysis recording (See Recording analysis in the Dartfish
outputs - publishing & sharing chapter)

> Video editing software: if you want fancy transition effects, motivational soundtracks and all the
bells and whistles of video editing software, you can turn events into video clips and then drag
those files straight on the storyboard of your preferred software (see Exporting events topic)

9.8.3 Turning events into video clips

Events in the events list continue to be a part of the original video. It is possible to extract these
video segments and turn them into video clips. You may wish to do this to be able to compare
events in the Analyzer; because you wish to create a highlights movie using third party software;
or because only the event clips, and not the game video, are of interest.

To publish events as new files

1. Load game video(s) into the Tray.
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2. Filter for and/or select the events to be exported
3. Click the Publish button on the Events List toolbar.

22 publish ~
Upload Game
Upload Highlights Movie
Create Event Clips

4. Select Create Event Clips. A Wizard opens.

5. Wizard step 1 - Destination: Choose where files will be created, on a drive/folder on yuor
computer or burned directly to an optical disk. Then click the Next button

6. Wizard step 2 - Event selection

Select the range of events to publish:

(@) All events (4)
() selected events (1)

7. The options are:
> All events: all events currently displayed in the Events List. If a search or filter has been
applied, All Events refers to the contents of the filtered list.
> Selected events: Only events which have been selected by you.
8. Wizard step 3 - Video settings: Choose an encoding profile for the new video clips. To learn
more about video encoding see in the Getting Familiar chapter
9.
10.Wizard step 3 - Destination
In this step the Destination folder for the clips is chosen. Click the Browse button to change

the folder
Create Event Clips ﬂ
Destination |
Select a destination for your video. I ,"
Destination folder
CAUsers\Neil\Videos w Browse

File naming options can also be chosen:
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File naming

Choose how video clips will be named by selecting details from the list below.
Click Move Up or Move Down to arrange the order.

[]Clip name Mave Up |

[ ]Event name

Player Move Down

[+] Action

Event position Add Keyword

[]Event duration L R
Reset

Separator: | - v

Preview:

Player-Action-00-00-15.000.avi

» The default setting uses only Event name. Clips will be named according to the value
appearing in the Name column of the Events List

» Tick other boxes to add other details such as the Event position (time in video)

> Click the Add Keyword button to add other categories of information from the Events List

» Click the Move Up and Move Down buttons to define the order of the information as it will
appear in the file name

In the example above an event featuring a 'Shot' by 'Pele’ would be named 'Pele-Shot-
54:32.000

Click the Next button to proceed to the next step where the event clips will be created.

9.8.4 Adding descriptions to events

The description property of events is a free text (rather than keyword) description of an event. It is
useful for several reasons, among which are:

» The information will be useful to viewers after events published to dartfish.tv or exported to
the Storyboard

» The information become part of the properties of video clips created from events and will
therefore be visible when these clips are added to the Storyboard, turned into Enhanced
Optical Disks or published to dartfish.tv

Adding description using event properties

1. Right-click an event in the Events List
2. Select Properties from the quick menu
3. Type or edit in the Description section of the General tab

Using The events list description field

1. Right-click any of the column headings of the Events List

2. Select the Description option from the quick menu

3. There will now be a new column of the Events List with the heading 'Description’

4. Edit the description by right clicking the Description field for an event and selecting the Edit...
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option from the quick menu

Using keyword buttons
Event and Keyword buttons can be used to automate the addition of a description to an event.

When building a tagging panel (see Creating Tagaging panels), set the Description property of
the button to the desired text:

Event Button Properties

B Event A
Category Tagged events
Keyword Serve
Preroll 2 sec
Duration 6 sec
It is particulary important to be aware of the opp...
Event Color MNo celor
B Interaction
Reset Category W

» The Description property may be set on a button which will also record a keyword - perhaps
in this case the description explains some technical jargon or some common errors?

» Keyword buttons may be added to a panel, specifically to add a description to an event. In
this case, setting the category property is optional:

Game tagging  Description tagging 3 Keyword Button Properties
B o
Deescription buttons o
B Event A
Category
Eeyword Forward pass

[T Fassing the ball forward is not allowed and will
v

0 Dk mr o Hlren.

9.8.5 Storyboard

Selected events can be viewed in the Analyzer module and analyzed as any other Storyboard
item. In many ways the Analyzer's Storyboard is the best presentation and publishing tool for the
following reasons:

» Analyzer zoom and drawing tools can be used to help illustrate and explain.

» The Storyboard can be presented using the remote control in the same way as the events list
. But with the advantage that a selection of many events from different searches can be
compiled in the storyboard.

» The Analyzer offers additional outputs such as the Mediabook and Analysis Recorder.

To add events to the Storyboard:

1. Select events in the Events list and click the Storyboard button.

gR Storyboard

2. Select the range of events to be exported.
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Add Events To Storyboard
Select the range of events to be added to the Storyboard:
() all Events
(®) Selected Events

[]clear Storyboard content before adding the events
[ ] Open Storyboard in Analyzer

Canc

Each selected event creates a new Storyboard item. The process of selection and adding events
can be repeated until the Storyboard contains all the events to be presented. See An analyzer
project - the Storyboard in the Analyze performance chapter to learn more.

@ Remember that a storyboard's contents can be saved to allow recall at a later date. You might
save one Storyboard presentation for the players and another for the coaches

9.8.6 Exporting events
The Import/Export tool allows you to export data from the Events List as a CSV file. To do this:

1. Select events in the Events list
2. Click the Import/Export button and select the Export Events... option

ﬂ Import/Export «

3. Select the range of events to be exported - all events or only those which have been selected:

Export Events

Select the range of events to be exported:

AII Events

Selected Events

Cancel

Your selection is exported to a CSV file which can be opened in spreadsheets and databases to
analyze statistics and create graphs. You can also use such files as backup copy of your tagging
work. Such a file can be imported later and re-synchronized to the video (see Importing events).

@A quicker way to get data from the Events List is to select the events you want then copy &
paste the data into spreadsheet, presentation or document

DARTEISH:=% - Version 9 - © Dartfish. All rights reserved.



Chapter

Displaying metadata
from external devices

DARTFISH==



Displaying metadata from external devices 238

10 Displaying metadata from external devices

Dartfish's Analyzer and InTheAction modules support the display of data from other software
applications. For example, timing devices, heartrate monitors or power measurement devices that
use sensors linked to software can use Dartfish's Metadata toolkit to send the processed data to
Dartfish Software. Such metadata adds to the interpretation of video images by relating them to the
effort of the performer.

Throughout this tutorial, the term "metadata” will refer to data (in a broad sense) generated by
entities external to Dartfish Software and captured by Dartfish Software while capturing a video
clip. Examples of such metadata are heart rate, speed, etc.

It is assumed here that you are already familiar with the use of InTheAction (see Live capture &
instant replay during training) and the Analyzer (see Analyzing Performance ).

To display metadata on Dartfish video images need to:

> Activate advanced options supporting metadata capture and display.

» Use the InTheAction module to capture metadata streams while capturing related video
images.

» Link drawings superimposed on video displays to metadata values.

» Use the Analyzer module to replay previously captured video with related metadata.

This topic covers how to do this and additionally how Overlay Templates can be used to make the

display of metadata. You will also learn how to display metadata values graphically next to video
images.

10.1 Support for metadata in Dartfish Software

Dartfish metadata toolkit

For data from external software and devices to be displayed in Dartfish it is obviously not as
straightforward as connecting the device - a software bridge is required to interpret and record data
in real time. With appropriate programming skills you may create your own bridge with the help of
the Dartfish Metadata Toolkit document. Contact Dartfish Customer Care to obtain a copy

Metadata support in Dartfish software
Metadata can be captured and displayed. These tasks are performed using 2 modules:

» InTheAction module, for capturing video clips and metadata synchronously.
» Analyzer module, for displaying metadata and performing some analysis.

Apart from these 2 modules, there is no support for metadata. For example, it is not possible to
display metadata with the Player. In these 2 modules, the metadata features are enabled by
advanced settings that are available in the Options dialog (Advanced Options).

Data manager

The Data manager is not a tool for recording metadata with video but rather can be used to link
data files from external applications to video. Lean more about it in the chapter Dartfish Readers
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10.2 Setting Advanced Options

To use (capture and display) metadata in Dartfish Software, advanced options can be enabled

1. Select Tools > Options from the menu bar
2. Select the Advanced section

The figure below depicts the different options as they are displayed in the "Options" dialog (they
have been highlighted in the picture):

[ Options “
e @« T B & » @ ] FE]

General Library Encoding Profiles Analysis InTheAction SimulCam StroMotion Metwork Cameras Add-ins | Advanced

| Save index file (.dfidx) next to the video clip file ~
< Display shortcuts in Tagging Panel (Enabled by default)
¥ Automatically check for update (Enabled by default)
| Importer
7| Playback the tape when recording is started
Pause the tape when recording is stopped
7 InTheAction
| Persist reference between different sessions
| Mirror Axes
¥| Honzental Flip
Vertical Flip
| Capture Options
| Immediate replay after capturing
Automatic switch to blank when capturing
7| Automatic keep when captured
| Metadata Support Options
Recerve, record and save metadata

/| Use overlay drawing repository.

V| Save embedded drawings
-| Analyzer
#| Reset video drawing when opening a new video

Start in split-screen mode when creating a new project
|#| Load embedded drawings|
| Add item to tray
#| Enable logo in Analyzer Recorder
7] Publishing
Extract metadata e

Help [ ok Cancel

Analyzer advanced options

» Load embedded drawings - this option allows the analyzer to load the drawings (if any) that
have been saved with a video clip during its capture. If this option is disabled, the Analyzer will
only load the video (and possibly the metadata if the "Display metadata viewer..." option is
enabled). In order to save drawings with a video clip, the advanced option "Save currently
selected overlay drawing with the video clip" must have been enabled in the InTheAction (ITA
Advanced Options) prior to saving the clip.

InTheAction advanced options

» Receive, record, and save metadata - this option enables the InTheAction module to receive,
record, and save metadata with the video clip.

» Save embedded drawings — when enabled, the drawing that is currently displayed in Live or
Replay mode is saved with the video clip at the end of the capture when the user saves the
video clip. The drawing can later be automatically loaded and displayed in the Analyzer (if the
"Load embedded drawings" option is enabled).

» Use overlay drawing repository — the Drawing repository stores up to nine different
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collections of clip drawings (see specific section later in this document). When this option is
enabled, the overlays are used for managing the drawings in the InTheAction module. This
option also displays additional tools on the InTheAction left toolbar.

10.3 Capturing & displaying Metadata with the InTheAction

The InTheAction module is used for recording Metadata (it is not possible to use the Importer
module to record Metadata). The Receive, record and save metadata advanced option must
be enabled (Tools menu > Options > Advanced section).

When receiving external data, the InTheAction module automatically creates a data source
stream for each received data stream. These data source streams are created automatically as
the data is received. This has the following important consequence: no data source streams are
available until Dartfish Software has received some data.

The current values of the metadata streams can be displayed in InTheAction's Live mode (see
Displaying Metadata in Live Mode). Even if the metadata is not displayed on the video in Live
mode, the metadata streams are nevertheless recorded with the captured video clip but only if the
advanced options for recording the metadata have been enabled for the InTheAction module (ITA
Advanced Options).

10.3.1 Checking that Metadata is received

The list of data source streams and their properties can be displayed in InTheAction.

1. Select Manage metadata repository from the Overlay menu found beneath the video display:

T— Manage Overlay Template Repository
IManage Metadata Repositur}rl

Overlay #9
Overlay #8
Overlay #7
Overlay #6
Overlay #5

Overlay #4
| Overlay #3
_ Overlay #2
— Overlay #1

2 E‘ Embedded overlay drawings

& Overlay ~|

! if this menu is not displayed it must be enabled in the advanced options (see InTheAction
Advanced Options).

2. The following data source list dialog is displayed showing the different data sources and their
metadata streams.
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DataSource List ll

Test Data Source

E Heart Rats
b bl
= Spin Amnount

Refresh |

» The content of this dialog content is not automatically refreshed. When this dialog is left
opened and new metadata streams are detected by Dartfish Software, you must click the
Refresh button to update the dialog list view (or close the dialog and reopen it).

> In this example, two data source streams have been received: "Heart Rate" and "Spin
Amount". The "Heart Rate" data stream has integer values (e.g. 123, 150). The "Spin
Amount" data stream has float values (e.g. 12.34, 0.34E-2).

> All data source streams that are displayed in the DataSource List dialog are recorded with
the video clip. Currently, it is not possible to select which data source stream will be
recorded with the video.

> If no data source streams are displayed this indicates that the Dartfish Software has not
received any data yet.

> The list of received metadata streams is not saved when quitting Dartfish Software.

10.3.2 Displaying Metadata in Live Mode

Metadata stream values in the InTheAction module are displayed with overlay drawings that are
drawn on the video image.

1. First check that data source streams have been detected (as explained in Checking that
Metadata are received).

2. Switch the InTheAction module to Live mode.

3. Select the Video drawing setting (usually this is the default setting):

LY
™ .
» 7
T &=
u .
o 9.
.

4. Depending on the type of data contained by the data source stream, you must select the
appropriate drawing tool. For integer values, select the Text drawing tool. For float values,
select the Text or Graph drawing tools. For vectors with origin (Vector6) data type, select the
Force Meter drawing tool:
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A S

4]

|

NLu
= @,
o0 oo fud
b Force Meter | ]

5. Draw on the video using one of the drawing shapes selected in the previous step.
6. Select the drawing and right-click on it to display a popup menu.
7. Select the menu item Metadata Properties... as below:

Fimish

Edit

Order k

Cuk
Copy
Paske
Delete

Tracking »
Discard tracking

Fade in k
Fade out

b lEFadata Properties

If this menu item is grayed, no data source streams are available or no compatible data source
streams are available.

8. The following dialog is then displayed:
B

% Mot linked to a Metadata Source
" Linked to the following Metadata Source:

[Vata Tope: IFIoatEditTextBehavior j

Sournce NamEZITest Data Source j

Stream Name:ISpin Amount j

9. To assign a data source stream to the current drawing, click on Linked to the following
Metadata source option and select the targeted data source stream using the 3 list boxes.
If the Linked to the following metadata source option is disabled (grayed) then it is not

possible to assign a data source stream to the drawing (there are no compatible data source
streams currently available).
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Metadata Properties 3 x|

= Mot linked to a Metadata Source
& Linked to the following Metadata Source:

Drata Tupe: IFIDatEditTthBehavinl j

EEERENER T est Data Source

Stream Mame: I Spin Amaunt ﬂ

ak I Cancel |

10.The drawing shape displays the value of the linked metadata stream. For example, a Text
drawing displays a value and a graph drawing displays a graph.

10.4 Using Metadata in the Analyzer

The Analyzer module is used for observing and comparing stored video clips and their recorded
metadata. When a clip is opened in the Analyzer, any recorded metadata can be displayed in the
Data graph panel at the bottom of the module

BE 28

Er
[}
o
. F
=k
T IR
B

B Ix»

When multiple clips containing metadata are opened, the metadata corresponding to each clip is
displayed in the graphic view. Each graph is color-coded with the corresponding color of each clip's
timeline. For example, the yellow graph corresponds to the yellow clip in the timeline.

A video's graph is synchronized with its timeline. For example, in the Data graph above, shifting
the yellow timeline to the left will also move the yellow graph.
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10.4.1 Using the Data graph

Metadata stream values can be displayed in the Analyzer module as a graph
synchronized with the timeline. To use the Data graph, simply open a video clip in the
analyzer. Any metadata previously captured with the InTheAction module is displayed.

BE 28
=T

H
m

The graph is fully synchronized with the timeline. So, if one of the clip is moved on the left by
dragging its timeline on the left (by click and dragging the yellow timeline), the corresponding graph
is also moved accordingly. The graph is also zoomed in and out as the timeline is zoomed in and
out.

The different buttons in the graph toolbar alter the way the graph is displayed.

» The [E3] button displays simple statistics such as min, max and average values. The Cue In and
Cue Out points act as delimiters for these calculations.

> The ¥ putton displays the data value corresponding to the value at the cursor position in the
timeline on the top right corner of the graph.

» The ] button displays the name of the currently displayed metadata stream in the top left
corner of the graph

» The El button toggles between single or multiple clip display. When multiple clips are
simultaneously opened in the Analyzer, the graph can display the metadata from a single clip or
from multiple clips. In this latter case, the each clip's metadata curve is the color of the
corresponding clip's timeline. . For example, the data curve corresponding to the clip that has
the yellow timeline is displayed in yellow. In single clip mode, the user can switch between the
different graphs for each clip by selecting the clip in the Analyzer (usually done by clicking
directly on the targeted clip video).

» The = button switches between "superimposed” or "separate” mode when multiple clip curves
are displayed. This feature is only useful when graphs from several clips are simultaneously
displayed. In the "superimposed" mode, the graphs of the different clips are superimposed on
each other.

DARTEISH:=% - Version 9 - © Dartfish. All rights reserved.



245 Dartfish User Guide

P 00:00:18.352 [¢] 00:00:22.022 <]
1 v 1

In the "separate" mode, the graphs are displayed as separate graphs, each in its own display
area.

F 00:00:13.352 =] 0000: 22 022 [5]
| v

» The E button toggles between the "all clip” and "single clip" data stream browse mode. These
2 modes alter the way data source streams are selected in the tree view to the left of the graph.

10.4.2 Displaying Metadata on the Video

Proceed as previously explained in the topic Displaying Metadata in Live Mode

10.5 Using the Overlay template repository

This feature is a source for different collections of drawings that can be displayed on video clips. In
the context of metadata capture it can be used to store and recall different sets of drawings,
removing the need to redraw for each recording. Strictly speaking, the library is not linked to any
metadata features but it can be used to memorize the position of drawings that can be later linked
to metadata streams.

The Overlay template reposititory has the following features:

» Define sets of drawings that are saved (persisted) between each session in Dartfish Software.
The next time the user launches Dartfish all the drawings in the library are immediately
available as soon as the InTheAction module is enabled.

» Switch between the different collections of drawings - an overlay can be directly selected from a
list. It is also possible to map a keyboard shortcut key for switching between the different
groups of drawings.

» Manage the different groups of drawings by creating or deleting them.
» Contains up to 9 different templates.

To learn more about using the Overlay template repository, see Using drawings in InTheAction
in the Live capture & instant replay during training chapter
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11 Dartfish Readers

Data Readers are used to link a video file to a data source file. Once linked, you'll be able to
synchronize the data streams and video in the Analyzer and to view both simultaneously using
the Data Graph. Drawing tools can be used to display data on the video image.

In earlier versions of Dartfish, the readers were available as add-in software to Dartfish Pro
editions. For version 6.1 and later readers will form part of the TeamPro Data edition of Dartfish.

There are two Data Readers available:

- CSV Reader

Used to link video to character separated value (CSV) files. CSV files are commonly produced
or can be exported from a wide range of devices.

This reader can read many text file formats provided the following conditions are met:

1. The data can be separated (parsed) into columns which are delimited by a text character
(tab, comma, semi colon, space etc)

2. The resulting table has no more than one row of column headers.

Where condition 2 is not met, it is usually possible to open, parse and edit a text file in a

spreadsheet program such as Microsoft Excel. By this method data can be rearranged and

extra headings removed. The edited data should be saved as a .csv file rather than a
spreadsheet file.

Source name: This Reader names the source by the file name of the CSV file. Optionally you
can input a source name of your choice.

Data streams: The CSV Reader parses character separated data into columns, each of which
represents a different data stream. You are able to select which of these columns you wish to
link to Dartfish.

See linking CSV data

- SRM Reader

Used to link video to .srm files created by SRM power cranks and training system. This includes
a Powermeter and a Powercontrol to record biodata held in SRM files (*.srm). Thanks to this
system, cyclists can record the power, the heart rate, the cadence, the speed and other data
deriving from them.

Source name: This Reader names the source by the initials of the person set in the
Powermeter and the date of the training.

Data streams: Five streams are fed:

Power developed on the crank in [watts] &
Cadence of the crank [rpm] &
Speed of the cycle [km/h] ="

Heart rate of the athlete [bppm]
Time of the day at which the training session happened [hh:mm:ss.xxxx]
See linking SRM data

VV V V V
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11.1 Linking CSV Data

You can create links between one video clip and more than one data source. To establish a link,
right-click a video file in the Tray or in the Items List and select Link External Data from the

context menu.

Name -~ Size
[BPM Indivig  Open fE
fBPM Indiviq  Add toTray B
ﬁ project ex Copy :B
B Test track - NE

Rename
Maove to Recycle Bin
Open Containing Folder
Select All
Conwert
| Link External Data
< —— | Manage External Data ’
ﬁ Properties
iradley

A Wizard first prompts you select a Reader from a list of installed readers.

™ External Data Link Wizard

Reader
Choose a Reader.

Readers to be activated

vate Activation Help

Available readers on the system

E—. Darifish C5V Reader

Links Data Streams defined by columns of C5V and other delimited text filas.

Dartfish SRM Reader

[

et
& | &
Help Check for Updstes Reguest Support  Begister online = Show detsils
[ MNext> | | Cancel

In the second step you will browse for the data file.
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¥ External Data Link Wizard

File
Chocse afile.

L% Active Reader: Dartfish CSV Reader

EAMDF C5V datamanagericarbon_team .csv | B

[ <Back || MNext> | [ Cancel |

A standard Open File... window pops up. Search for the Data Source file in your hard drive and
click Open.

In the next step you parse the Data Source and define how the Data Streams are linked.

® External Data Link Wizard

Configuration
Diefine the layout of data source and set stream properties.

CSV Document Properties

Data Source name |carbon_team v | Separator
Use First row as headers [] Hide comments starting 'M'I]'EI
[] Set manually the file enceding Unicode (UTF-8)

Time Stamp

Select the time stamp source Data Source “
Select the time column [xime [ sec] v | Time format

Select the columnis) you want to link as stream to Dartfish.
Right click on the column header to set the stream properties.

dime [ [ xdist [ m] [¥] speed [km] [¥]
0.000 00 00

0.020 0.0 0.0
0.040 0.0 0.0
0.060 0.0 0.0
0.080 0.0 0.0
0,100 0.0 0.0
0,120 0.0 0.0
0.140 0.0 0.0

[ <Back | MNext> | [ Cancel |
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1111

The information required here is explained in the following topics:
» CSV document properties

» Time Stamp
» Selecting columns as Data Streams

After completing this step, the data source is linked and either additional data sources can be
linked or you can proceed to viewing and displaying the data with the video.

CSV document properties

In the configuration step of the wizard you will define the parameters of the Data Source and set
which columns are to be linked as Data streams. The first part of the configuration step defines
the properties of the Data Source

CSY Document Properties
Data Source name | carbon_team w Separator | Tab w
Use First row as headers [] Hide comments starting with

] Set manually the file encoding

Data Source name

This is the name used to identify the Data Source when using linked data in Dartfish or managing
Data Sources etc. By default the file name of the Data Source File is used but you can enter your
own name or select a name which combines the file name with the current date.

Separator

It is essential that your data is successfully parsed before continuing. To do this, select the
character used to delimit the columns of your Data Source. A range of commonly used separator
characters is offered but it is also possible to type any character or combinations of multiple
characters. If you are not sure which character has been used, experiment by selecting different
characters; when successful you will see your data divided into separate columns as shown below:

stime [ [] =dist [ m] ] speed [emh] []
0.0Z20 T1] 0o
0.040 00 00
0.060 11] 00
0.080 1] 0o
0.100 T1] 0o

Use first row as headers

Where data has a header row you must tick this option to prevent the headers being treated as
data. If your Data Source has more than one row of headers you must delete or merge the extra
rows. You can do this by editing the file with text editor software or a spreadsheet such as
Microsoft Excel.

Hide comments starting with
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The Data Source may contain text comments. Often these are marked by a specific delimiter.
Exclude such comments by typing the delimiter character used.

Manually set the file encoding

Dartfish automatically selects the file encoding used but if necessary you can manually choose
from a selection of text encoding types.

11.1.2 Time Stamp

The CSV reader must be able to relate each piece of data in a Data Stream to a position in the
video. There may be a column of time stamp data in the Data Source but where this is not the
case, a time stamp can be added at a fixed interval.

Using data from the Data Source as the time stamp

Time Stamp
Select the time stamp source Data Source ~
Select the time column |xtime [ sec] s | Time format | Seconds “

1. Select the option "Data Source" from the Select the time stamp source list box.

2. From the Select the time column list box, select the column from the Data Source that contains
time values.

3. Select the Time Format or units used. It is essential that the reader understands how to
interpret time stamp data. For example, if the time stamp is "100" does this represent 100
seconds or 100 milliseconds?

Using Interval or Frequency as the time stamp

Time Stamp
Select the time stamp source Interval w

Enter the interval in seconds |5

The reader can create a time stamp at a fixed interval (seconds or fractions of a second) or at a
fixed frequency (Hertz). This is useful if time stamps do not exist in the data source or are not in
a time format recognisable by the reader. To use Interval or Frequency time stamp sources, Data
Stream samples must be at regular, fixed intervals.

11.1.3 Selecting columns as Data Streams

The Data Source may contain many columns of data that you will not wish to link to video. You
must indicate those that you want to link by selecting them as shown below:

aime [ [] Distance speed  [km/h]
I"_.." ED
00
00

(=

==
o | oo

Distance and speed are the selected streams

Stream attributes
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11.2

When you select a column, you will be prompted to set attributes for the data stream.

aime [ [ xdigt [ m] speed  [km/h] 2
0.0 Stream Attributes ;
0.020 00 Name® |Distance _

0.040 0.0 Type” | Number v |

0.050 0.0 LInit name | Meters [ e.g. Meters

paci i [ Cancel |[ OK |

0.100 0.0

D.120 0.0 0.0

D.140 0.0 0.0 v

» Name - This is the name used to identify the Data Stream when using linked data in Dartfish.
By default the column heading from the data source is used but it can be changed to a value of
your choice. In the example above "xdist [ m]" will be replaced by "Distance". It is particularly
important to set a name property for the Data Stream when no meaningful header is present in
the Data Source

» Type - Select either Number or Text. By selecting "Text", numbers will be treated as text and
Dartfish will not attempt to plot them on the Data Graph.

» Unit name - This is a descriptor of the values of data in this data stream. It is displayed in the
video clip Properties or in the External Data Manager.

! After setting these attributes they can be changed by right-clicking the column heading.

Linking SRM Data

You can create links between one video clip and more than one data source. To establish a link,
right-click a video file in the Tray or in the Items List and select Link External Data from the
context menu.

|E|pM Indivie  Open 1E

HPM Individ  Add to Tray B

‘E'I project ex Copy B

B Test track "E
Rename

Maove to Recycle Bin
Open Containing Folder

Select All

Conwert

Link External Data

Manage External Data

w Properties
=

iradley

3

4

A Wizard first prompts you select the SRM Reader from a list of installed readers.
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® External Data Link Wizard

Reader Dy

Choose a Reader. -:%3‘;3
Readers to be activated
fetivation H

Ayzilable readers on the system

=) Dafish CSV Reader

==

Help Check for Updates Reguest Support Register online % Show details

[ Met> | [ Canca |

In the second step you will browse for the data file.

File
Choose a file. %

;.31 Active Reader:  Dartfish SRM Reader

E:\DartfishAD atamanager contenthgesszion Bradley Effort1-007-000148 2502

=

[ < Back ” Mext > ][ Cancel ]

A standard Open File... window pops up. Search for the data file in your hard drive and click
Open.

Before completing the Wizard you have the option to link other files to act as Data Sources for
this video.

Displaying data

After completing this step, the data source is linked and either additional data sources can be
linked or you can proceed to viewing and displaying the data with the video.
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11.3 Managing links

To manage links between video files and Data Sources, right click the video file in the Library.
Select Manage the data streams... from the context menu.

Removing the link

You can remove the link between the data source(s) and the video file. To do this, select the data
source and click on the Unlink button.

It is not possible to remove a single stream of a data source.

Broken links

A link can be broken when the external data source file has changed location on the disk or has
been renamed. It also happens when the video clip is shared and opened on a different computer.
As a result, the data cannot be displayed in the Analyzer any longer. To check for broken links:

1. Right-click the video file.

2. Select Manage the data streams from the context menu.

3. Select the data source and its properties are visible on the right hand panel. If the link is
broken the Availability property will read 'Data Source Missing'.

™ External Data Manager EJ
Streams | Readers
Library ltem: Bradley Effort1-001-0001(sho Properties of the selected Data Source:
=3 BW 5/25/2006 Name Value
Cadence Properties
Heartrate i
Power Name | BW 5/25/2008
Speed Avaizhilty Dafz Source missing
Time
_ Sreams
Data Stream 1 Cadence
Dizta Stream 2 Heartrate
Diata Stream 3 Power
Data Stream 4 Speed
Data Siream 5 Time
Link | [ Unlink | [ Relink

4. To correct a broken link, click the Relink button then browse for the new location of the data
source. Synchronization of data and video is retained provided that the Dartclip metadata file
has also been moved to the new location of the video file (see Sharing Data for further
information about Dartclip files).

11.4 Viewing data

Dartfish's Analyzer Module is capable of displaying Data Stream data in 2 ways:

The data graph
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The Data Graph panel is found in the lower part of the Analyzer by selecting the Data Graph tab.
Each numerical data stream is represented as a different curve.

The data graph is also used to synchronize linked data with video.

Storyboard | Key Positions | Timeline  Data Graph | Analysis Recorder 4 b
=l 3z e T
[v] Cadence :00.0 01:00.0 02:00.0 i 03:00.0
[¥]Heartrate
Power min 0,00 ma
[¥] Speed
&l
P

@ The Data Graph and Graph drawings can only display integer and floating point numbers. For
example, times in the format hh:mm:ss etc will be treated as text and cannot be displayed. If you
wish to graph times (e.g. split times) then you must first edit the Data Source to represent times as

numbers.

Drawing on video

Text drawings, graph drawings and other specialist data drawings can be linked to data streams
such that values can be displayed on the video image. Numerical data can be displayed with the
Text and the Graph drawing tools, while text can only be displayed with the Text drawing tool.
Below is an example of what it might look like.
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11.4.1 Synchronization

You can quickly synchronize the data streams and the video in the Data Graph pane of the
Analyzer, as illustrated below:

Storyboard | Key Posik Timeline  Data Graph | Analysis Recorder
e &M@ 7\
[] Cadence 000 Plooooo’ " lorooo ' Jozono ' /Y [dzoen T

Heartrate
Pawer C ] rnin 0,00 max 11800
Speed

To synchronize, proceed as follows:

1. Move to an appropriate position in the video clip.

2. Activate the synchronization mode by clicking on the Resynch button [**

3. Align the streams to the playhead (green arrow in the illustration) by click & drag of the streams
to the left or to right.

4. Click a second time on the Resynch button once done.

@ To synchronize precisely, you should position the video to a distinct instant where you might
expect to see an obvious change in the data graph e.g. when the athlete starts pedaling. This can
be easily matched, for example, to the cadence stream (see illustration above).

11.4.2 Drawings

The data can be directly overlayed on the video image in the Analyzer. This is done by linking
drawings to data from a Data Stream. The following is a representative but not comprehensive list
of drawing tools that can be linked to data. Different devices will produce data which can be best
represented by different types of drawing:

» Text tool: Use to display any value from a Data Stream. Using the Dartfish symbol font, the
text tool can also be used to display data specific icons to label values (see below).
» Graph tool: Use to represent numerical data as a graph.

> Force Meter: Use to represent the magnitude and direction of a force (typically for devices
producing this type of data).

To link a drawing to a data stream (example using Text drawing):

1. Use the Text drawing tool to create a small text drawing. The text you type to create the
drawing is not important e.g. "xxx". Be sure to finish editing the text before proceeding to the
next step; to do this click on the video display outside the drawing.

2. Right-click on the drawing to display the context menu.
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Edit
Order

Cut
Copy

Delete

Tracking

Fade in
Fade out

3. Select the External Data Display... option.
4. Select the Data Source and Data Stream then click the OK button.
External Data Properties |X|

"y Mot linked to a External Data Source
{#) Linked to the following Extemnal Data Source:

Saurce Mare: |B\A-" 25/05/2008 V|

[rata Streamn Mame: | Cadence b |

L Ok J[ Cancel ]

5. The text box now displays the value of the selected data stream.

! Don't forget to synchronise to make sure the displayed values have proper meaning.

Displaying Dartfish explanatory symbols

The Dartfish Readers provide the Dartfish Symbol font which you can use with the Text tool of
the Analyzer or In the Action modules. Using this you can substitute long names with self-
descriptive symbols. See the Table 1 for the key mapping.

Key Symbol Description
(character)
Sors Speed
Porp 0 Power
Corc & Cadence (pedals)
Horh ™ Heart rate
© Dartfish. All rights reserved. - Version 9 -
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! The Dartfish Symbol font is automatically installed with Dartfish software.

11.5 Sharing linked data

In order for others to see linked data you have two options:
» You can publish a movie from the Analyzer. This will include drawings that have been added to
the video clip - including those displaying Data Streams.

» You can share the video file and the Data Source with other Dartfish users. Although the
recipient will need to re-establish the link using their own reader, synchronization is retained.

11.5.1 Publishing video

You can publish the video with overlayed data from the Analyzer (see Saving movies from the
Analyzer to learn how to do this) as illustrated below:

In this case, the result is a video that can be shared in your team. It does not require Dartfish to
play it.

11.5.2 Sharing data

The Dartfish Readers do not embed data in the video file (i.e. in the .dartclip file associated with
the video clip). They create a "live" link between the data and video files. Therefore if you wish to
share video and linked data with other Dartfish users the following are required:

» The recipient must have a Dartfish Software edition which includes the reader

» You must provide the video clip, the Data Source file and (optionally) the Dartclip file as shown
below.
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& session Bradley Effort1-001-0001
File Edit Wiew Favorites Tools Help

£ Bach o - ¥ O search [Py Folders | G-
i Address |[E[| E:iDartfishiDatamanager content|session Bradley Effort1-001-0001 b |
-~ -~

~l & Iy Bzs0508.sm
SRM File
16 KB
a Make a new Falder

&3 Fublish this Falder to —- B Bradiey
the Web Q Effort1-001-0001(short), avi

e Share this Folder Widen Clip

b= 9 Bradiey

[ '.' Effort1-001-0001{short), avi.d. ..
Dartclip Files

The recipient establishes a link using the Relink function described in Managing links.

File and Folder Tasks

-

Other Places

< |

! Dartclip files store all additions made to video by Dartfish. These include details of external data
links and synchronisation. If the Dartclip file has not been shared then the recipient must create a
new link between the video clip and Data Source.
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synchronization of data with video
text drawing 254
text tool 256
time stamp 251
viewing data 254
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Drawing overlays 86

Drawing tools 102
angles 99
automatic tracking 103
clone rectangle 98
data table 105
distances 100
manual tracking 102

picture 99
spline 102
time 101
Drawings 96
adding 96
editing 96

fading infout 104
properties 97
toolbar 96

_E -

Easytag
importing events from 214
quick import 216
synchronising imported events 219
Embedded drawings 86
Encoding profile
background task manager 68
encoding during capture 66
Encoding profiles 18
Export list 38

-F -

File 15
new 15
open... 15
save 15
save as... 15
save movie... 16

Filename template tool 194
Flip horizontally 94
Flip vertically 94

-G -

Getting familiar with Dartfish 5
Group box 183

Import
Channel 69

Cloud 69
Collection 69
Dartfish.tv 69
Smart Cloud 69
Importing events
Opta 217
organising data 214
quick import 216
Sportscode 217
synchronising 219
Synchronizing with video 214

Interlacing
correcting errors 45

InTheAction 73
capturing 81
drawing overlays 86
drawings 86
embedded drawings 86
instant visual feedback 81
Live delay 88
recording 81
remote controlling 82
replaying 81
self coaching 88
sound trigger 83

InTheAction comparing clips 84
InTheAction Settings 73
capture device 74
clip properties 76
Pre-record buffer 79
pre-record duration 76
recording duration 76
recording folder 76
replay sequence 78
two cameras 75

Introduction 2

IP camera 58
configuration 59
configure video 59
disable audio 59
PTZ control 63
select camera 59

K -

Key Positions 116

adding 116
analyzing 117
editing 117

fixed interval 119
importing 118
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Key Positions 116
Mosaic 124

Keyword buttons 186
Keywords 34

classifying video clips 36

defining keywords and keyword categories

35
editing categories 35
exporting data as CSV

importing/exporting keyword sets

removing keywords 37
understanding keywords

L -

Library 6, 27
adding folders 27
importing video 49
Use for tagging 174
Library workspace 28
items list 30
items properties 31
toolbar 29
tray 33
Live delay 88
Live tagging
naming files 194
Locating files 39
by keyword 40
in folders 41
search 41

M -

Manual tagging 213

Mediabook 138
destination 140

publishing 143
settings 141
video settings 142

Modules 6

Mosaic 124, 125
activating 125

Drawing 125
Snapshot 125

-N -

Network camera 58

38

34

38

-0 -
Openvideo 9
-P -

Pictures 145
printing 146
snapshot 147
Player List 200
Player list selector 191, 192
variable keywords 200
Playlist 42
Pre-Record
Video Recorder settings 65
Pre-record buffer 79
PTZ move button 194

Publishing 128
analysis recorder 147

game video 229
highlights movies 232
mediabook 138
pictures 145

save movie 143
tagging video 229

R -

Recording Duration
Video Recorder settings 65

Recording location
choosing 66

Remote control 20
Jumi 21
Streamzap 22
WiFi remote 21
Windows media 24

Rotation
correcting errors 45

-S-

Saving files 14
Dartfish projects 15
new video 16
Score panel 186
Sharing video 16, 43, 137
SimulCam 152
conditions 153
SimulCam Fixed 152
SimulCam publishing 161
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SimulCam step 1 153

SimulCam step 2 155
adding alignement frames 159
drag & zoom 156
matched alignement points 158

SimulCam step 3 160
Software registration 3
Split-screen mode 121
SRM Reader
Display data on drawings 256
linking data 252
managing links 254
publishing 258
save movie 258
sharing data 258
sharing linked data 258
synchronization of data with video
viewing data 254
Statistics matrix 226
Storyboard 92
analyzing tagging events 235
loading clips 93
playing clips 94
saving project 94
StroMotion 162
StroMotion Fixed 162
StroMotion step 1 163
loading clip 163
trimming clip 163
StroMotion step 2 164
alignment points 164
computing camera movement 164

StroMotion step 3
panorama reconstruction 166

StroMotion step 4 166
clones - creating 166
clones - editing 166
identifying key frames 166
publishing 168
saving 168

Support 3

Synchronizing 121
default synchronization 123
key positions 122

-T-

Tab group box
adding pages 183

Tagging

256

additional analysis 235
automating tagging 198

Definition of tagging

171, 172

export to storyboard 235

importing events

214, 216, 217, 219

manual tagging 213
play events mode 221

process of
publishing
publishing
publishing

202

229
game video 229
highlights movies 232

reviewing video during live tagging 223
sharing panels 229
sharing video 229

tag live

202

tag live mode 205

tag video clip 202

tag video clip mode 204
team presentation 235

using keyboard shortcuts 211
using tagging panels 203

Tagging database

distribution 202

Tagging editor

adding tools 179

copying tools 179
deleting tools 179
Event buttons 185

group box

183

keyword buttons 186
keyword macros 200
modifying properties 180
moving tools 179

player list selector 191

properties

195

PTZ move button 194

reset category property 198
score panel 186

tab group box 183

team group box

190, 191

team manager 190
team manager database 190

text box

186

trigger property 198
variable keywords 200

zone tool

186, 188

Tagging events list

adding notes to events 234
analyzing events in a spreadsheet 236
editing keywords 222
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Tagging events list
editing position and duration 222
export events 236
features 177
introduction 177
reset columns 223
selecting events 221
sorting events 221
Tagging multiple files 174
Tagging panels
creating 178
editing 178
feature summary 203
introduction 175
introductionto 178
manual tagging panel 213
opening 175
planning layout 181

saving 202
selecting 175
use of 203

Tagging search events 224
show all 229

table search 226
Tagging video in real time 205

Tagging workspace 173
Using Tray to load video 174

video panel features 174
Team group box 190, 191

Team manager 190
database editor 209

player order 209
use of 209
Text box 186
Time shifted recording 205
Tracking
automatic 103
manual 102
Tray 33
Trimming video clips 13

_V -

Video Conversion Wizard 18
Video error correction 45

Video file importer
DVD import 50
file destination 52
indexing 50
joining video clips 50

naming files 52
notes 50
Selecting files 51
Video playback 9, 10
controls 10
speed 10

Video properties
source info 45

Video Recorder 53, 65
clip properties 64
Pre-record 65
recording options 65
recording video 69
setting up capture 55
webcam 56

Video settings 18

Video Sharing Wizard 16

Video types
usable by Dartfish 44

W -

Webcam
Lifecam Studio 56

recording from 56

Workspace 5
resizing 7

-7 -

Zone tool 186, 188

Zoom
options 94
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